
xx

DPOJET
Jitter and Eye Diagram Analysis Tools

ZZZ

Online Help

*P077004813*

077-0048-13





DPOJET
Jitter and Eye Diagram Analysis Tools

ZZZ

Online Help

www.tektronix.com
077-0048-13



Copyright © Tektronix. All rights reserved. Licensed software products are owned by Tektronix or its
subsidiaries or suppliers, and are protected by national copyright laws and international treaty provisions.

Tektronix products are covered by U.S. and foreign patents, issued and pending. Information in this
publication supersedes that in all previously published material. Specifications and price change privileges
reserved.

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.

DPOJET Jitter and Eye Diagram Analysis Tools Online Help Part Number, 076-0114-13, September 27,
2012.

Contacting Tektronix
Tektronix, Inc.
14150 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

For product information, sales, service, and technical support:
In North America, call 1-800-833-9200.
Worldwide, visit www.tektronix.com to find contacts in your area.

http://www.tektronix.com/contact


Table of Contents

Table of Contents

General safety summary .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xvii

Introduction to the Application
Welcome .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Free Trials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Related Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Customer Feedback . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Getting Started
Product Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
DPOJET Option Levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Compatibility. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Requirements and Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Supported Probes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Installing the Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
About DPOJET .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Operating Basics
About Basic Operations

Starting the Application .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Application Interface Menu Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
Virtual Keypad .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Tips on DPOJET User Interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Basic Oscilloscope Functions
Application Directories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
File Name Extensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Application Menu Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Returning to the Application .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

Saving and Recalling Setups
Saving a Setup .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Recalling a Saved Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Recalling the Default Setup.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Setting Up DPOJET to Take Measurements
Setting Up the Application for Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Table of Measurements-Period/Freq.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Table of Measurements-Jitter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Table of Measurements-Time .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

DPOJET Jitter and Eye Diagram Analysis Tools i



Table of Contents

Table of Measurements-Eye . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Table of Measurements-Amplitude . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Table of Measurements-Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Test Point Selection in the Standard Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Breakdown of Jitter (Jitter Map) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Wizard
One Touch Jitter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Serial Data/Jitter Guide

About Serial Data/Jitter Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Select Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Configure Measurement

About Configuring Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Configure Measurement-Skew .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Configure Measurement-Jitter Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Select Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Configure Autoset Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Select Plots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Jitter and Eye Analysis
About Jitter and Eye Diagram Analysis Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Deskew.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Deskew Summary .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Export Data Snapshot-Statistics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Export Data Snapshot-Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Export Measurement Summary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Data Logging

Data Logging-Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Data Logging-Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Data Logging-Worst Case. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Measurement Summary
Measurement Configuration Summary-Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Measurement Summary-Ref Levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Measurement Summary-Misc .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Preferences Setup
About Preferences Setup .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
Preferences-General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Preferences-Measurement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Preferences-Jitter Decomp .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Preferences-Path defaults . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Limits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Taking Measurements

About Taking a New Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
Selecting a Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

ii DPOJET Jitter and Eye Diagram Analysis Tools



Table of Contents

Warning Log Notifiers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Navigation Panel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Control Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Sources Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Bus as a Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85
Digital as a source .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
Custom Source Name .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90
Source Autoset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94
Ref Levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96
Base Top Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102
Configuring Measurements

About Configuring a Measurement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Global

About Global . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
Gating .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
Qualify . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
Configuring Qualify with Logic . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114
Population.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
Configuring Population Limit. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118
Filters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
Brick Wall Filter Configuration .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
Advanced Filter Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
Clock Recovery

About Clock Recovery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
About Constant Clock Recovery .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Constant Clock - Mean . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Constant Clock - Median . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Constant Clock - Fixed . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Clock Recovery Advanced Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
About PLL Clock Recovery Setup .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
About PLL Loop BW versus JTF BW... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
PLL Standard BW... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
PLL Custom BW... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132
About Explicit Clock Recovery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134
Explicit Clock-Edge .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134
Advanced Explicit Clock-Edge.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136
Explicit Clock-PLL .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
Advanced Explicit Clock-PLL.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
Effect of Nominal Clock Offset on Eye Diagrams .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

Bit Config for Eye Height Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140
Bit Config for Eye High, Eye Low, and Q-Factor Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

DPOJET Jitter and Eye Diagram Analysis Tools iii



Table of Contents

Bit Config for Height@BER Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142
Bit Config for Mask Hits Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Bit Config for Amplitude Measurements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 144
Bit Config for PCI Express Measurements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
BER for PCI Express Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
RJDJ

About RJ/DJ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
RJ/DJ Analysis of Repeating Pattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 147
RJ/DJ Analysis of Arbitrary Pattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148

Bus State
Configuring Bus States . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Edges
Configuring Edges . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
Configuring Edges for Skew Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153
Configuring Edges for Differential CrossOver Voltage Measurements . . . . . . . . . . . . . . . . . . . . . 154
Configuring Edges for Phase Noise Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155
Configuring Edges for N-Period Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
Configuring Edges for Two Source Measurements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
Configuring Edges for CC-Period/Duty Cycle Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158
Configuring Edges for DCD Measurement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159
Configuring Edges for Overshoot/Undershoot Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160
Configuring Edges for Rise Slew Rate. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161
Configuring Edges for Fall Slew Rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162
Configuring Edges for DDR tCH(avg) and DDR tCL(avg) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Configuring Edges for DDR tERR(m-n) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 164
Configuring Edges for DDR tERR(n). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 165
Configuring Edges for DDR tHZDQ and DDR tLZDQ .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166
Configuring Edges for DDRtJIT(per), DDRtCK(avg) and DDRtJIT(duty) . . . . . . . . . . . . . . . . 166
Configuring Edges for Time Outside Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167

SSC
Spread Spectrum Clocking (SSC) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167

Sequencing.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168
Results as Statistics

Viewing Statistical Results. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
Export Results to Ref Waveform.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175

Plots
Results as Plots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176
Plot Usage .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
Selecting Plots. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
Configuring Plots

About Configuring Plots. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182
Configuring a Bathtub Plot. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 183

iv DPOJET Jitter and Eye Diagram Analysis Tools



Table of Contents

Configuring a Spectrum Plot. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
Configuring a Time Trend.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186
Configuring a Histogram Plot. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 186
Configuring a Transfer Plot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188
Configuring a Phase Noise Plot. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
Configuring an Eye Diagram Plot for Eye Height . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
Configuring an Eye Diagram for Mask Hits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191

Viewing Plots
About Viewing Plots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 192
Using a Second Monitor to View Plots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193
Toolbar Functions in Plot Windows. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193
Moving and Resizing plots. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194
Using Zoom in a Plot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194
Using Cursors in a Plot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196
Exporting Plot Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
Printing Plots . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

Reports
About Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

Tutorial
Introduction to the Tutorial . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
Setting Up the Oscilloscope .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
Starting the Application. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
Waveform Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
Recalling a Waveform File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204
Taking a Period Measurement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204
Taking a TIE Measurement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 206
Taking an Eye Height and Width Measurement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207
Summary Tutorial . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 209
Stopping the Tutorial . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210
Returning to the Tutorial. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210

Parameters
About Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211
Measurement Select Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211
Autoset Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212
Ref Level Menu Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213
Preferences Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214
Deskew Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215
Data Logging Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
Control Panel Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 217
Configure Measurement Parameters

DPOJET Jitter and Eye Diagram Analysis Tools v



Table of Contents

Bit Config Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 218
Edges Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 218
Clock Recovery Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 221
SSC Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 223
RJDJ Analysis Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 223
Filters Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 224
Bus State . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225
General Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225
Global Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226

Plots
Histogram Plot Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
Eye Diagram Plot Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
Spectrum Plot Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
Time Trend Plot Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Phase Noise Plot Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Bathtub Plot Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Transfer Function Plot Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228

Reports. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 229

Reference
Progress Bar Status Messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231
Error Codes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 232
Measurement Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
Measurement Units . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241

Algorithms
About Algorithms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 243
Period/Freq Measurements

Period .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 243
Positive and Negative Width .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 244
Frequency.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
N-Period . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246
Positive and Negative Duty Cycle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
CC-Period . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
Positive and Negative CC Duty . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 248

Jitter Measurements
TIE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 248
RJ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249
Dual Dirac Random Jitter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249
Jitter Summary .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250
TJ@BER... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250
DJ. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250

vi DPOJET Jitter and Eye Diagram Analysis Tools



Table of Contents

Dual Dirac Deterministic Jitter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251
Phase Noise. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251
PJ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251
NPJ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252
DDJ.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252
DCD.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252

Timing Measurements
Rise Time .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253
Fall Time.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253
Skew.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 254
High Time .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 254
Low Time .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255
Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255
Rise Slew Rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 256
Fall Slew Rate. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 257
Hold .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258
SSC PROFILE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258
SSC MOD Rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259
SSC FREQ DEV MIN ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259
SSC FREQ DEV MAX .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260
SSC FREQ DEV.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260
tCMD-CMD... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 261
Time Outside Level. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 262

Eye
Eye Width.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263
Width@BER .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263
Eye Height. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 264
Height@BER.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265
Eye High . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265
Eye Low ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266
Q-factor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266
Mask Hits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267

Amplitude Measurements
High .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 268
Low... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 268
DC Common Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 269
AC Common Mode. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 269
T/nT Ratio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 269
High-Low.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 271
V-Diff-Xovr . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 272
Overshoot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 272
Undershoot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273

DPOJET Jitter and Eye Diagram Analysis Tools vii



Table of Contents

Cycle Max .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273
Cycle Min.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
Cycle Pk-Pk . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274

Standard-Specific Measurements
DDR Setup and Hold Measurements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
DDR Setup-SE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 279
DDR Setup-Diff. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
DDR Hold-SE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281
DDR Hold-Diff . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 282
DDR tCL(avg)) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 282
DDR tCK(avg) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283
DDR2 tDQSCK... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283
DDR tDQSQ-Diff. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 285
DDR tDQSS.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 286
DDR tERR(n) and DDR tERR(m-n) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 287
DDR tHZDQ .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 287
DDR tJIT(duty) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288
DDR tJIT(per). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288
DDR tLZDQ .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
DDR tCH(avg) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
DDR tRPRE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 290
DDR tWPRE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291
DDR tPST .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
DDR Over Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293
DDR Under Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 294
DDR VID(ac) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 294
DDR3 Vix(ac) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 295
PCIe T-Tx-Diff-PP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 296
PCIe T-TX... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 297
PCIe T-Tx-Fall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 297
PCIe Tmin-Pulse. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 298
PCIe DeEmph .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 298
PCIe T-Tx-Rise . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 299
PCIe UI .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 299
PCIe Med-Mx-Jitter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 300
PCIe T-RF-Mismch .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 300
PCIe MAX-MIN Ratio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301
PCIe SSC PROFILE.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
PCIe SSC FREQ DEV ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
PCIe AC Common Mode .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
GDDR5 tBurst-CMD... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 303
GDDR5 tCKSRE ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 303

viii DPOJET Jitter and Eye Diagram Analysis Tools



Table of Contents

GDDR5 tCKSRX ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 304
T-TX-DDJ .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 304
T-TX-UTJ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 305
T-TX-UDJDD... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 306
T-TX-UPW-TJ .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 307
T-TX-UPW-DJDD ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 308
V-TX-EQ-NO ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 308
V-TX-EIEOS.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 309
ps21TX... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 309
USB VTx-Diff-PP .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310
USB TCdr-Slew-Max .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311
USB Tmin-Pulse-Tj . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311
USB Tmin-Pulse-Dj . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311
USB SSC MOD RATE... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 312
USB SSC FREQ-DEV-MAX ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 312
USB SSC FREQ-DEV-MIN .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 312
USB SSC PROFILE.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313
USB UI. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313
USB AC Common Mode .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313

Jitter Separation
Jitter Analysis Through RJ/DJ Separation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313
RJ/DJ Separation via Spectrum Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 314
RJ/DJ Separation for Arbitrary Patterns. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 315
Separation of Non-Periodic Jitter (NPJ). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 316
Estimation of TJ@BER and Eye Width@BER ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 316
Jitter Estimation Using Dual-Dirac Models. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 317

Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 317

GPIB Commands
About the GPIB Program .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 321
GPIB Reference Materials. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 321
Argument Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 322
DPOJET: ADDMeas .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 323
Bursts

DPOJET:BURSTConfig:BUS.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 324
DPOJET:BURSTConfig:CSACTIve . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 324
DPOJET:BURSTConfig:CSSource. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325
DPOJET:BURSTConfig:CUSTOMRate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325
DPOJET:BURSTConfig:DATA ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 326
DPOJET:BURSTConfig:DATARate. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 326
DPOJET:BURSTConfig:DETECTMethod .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327
DPOJET:BURSTConfig:GENERation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327

DPOJET Jitter and Eye Diagram Analysis Tools ix



Table of Contents

DPOJET:BURSTConfig:LATEncy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 328
DPOJET:BURSTConfig:LENGth .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 328
DPOJET:BURSTConfig:SEARch .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329
DPOJET:BURSTConfig:STRObe .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329
DPOJET:BURSTConfig:TOLERance.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330

DPOJET:CLEARALLMeas .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 330
DPOJET:DESKEW ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 331
DPOJET:DESKEW:DESKEWchannel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 331
DPOJET:DESKEW:DESKEWHysteresis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332
DPOJET:DESKEW:DESKEWMidlevel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332
DPOJET:DESKEW:EDGE... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333
DPOJET:DESKEW:MAXimum ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333
DPOJET:DESKEW:MINimum .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334
DPOJET:DESKEW:REFChannel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334
DPOJET:DESKEW:REFHysteresis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 335
DPOJET:DESKEW:REFMidlevel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 335
DPOJET:DIRacmodel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 336
DPOJET:EXPORT .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 336
DPOJET:GATING... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 337
DPOJET:HALTFreerunonlimfail . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 337
DPOJET:HIGHPerfrendering .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 338
DPOJET:INTERp .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 338
DPOJET:LASTError?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 339
DPOJET:LIMITRise . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 339
DPOJET:MINBUJUI.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 340
LIMits

DPOJET:LIMits:FILEName.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 341
DPOJET:LIMits:STATE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 341

LOGging
DPOJET:LOGging:MEASurements:FOLDer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 342
DPOJET:LOGging:MEASurements:STATE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 342
DPOJET:LOGging:SNAPshot . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 343
DPOJET:LOGging:STATistics:FILEName .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 343
DPOJET:LOGging:STATistics:STATE.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 344
DPOJET:LOGging:WORSTcase:FOLDer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 344
DPOJET:LOGging:WORSTcase:STATE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 345

DPOJET:MEAS<x>.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 345
DPOJET:MEAS<x>:BER:TARGETBER .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346
DPOJET:MEAS<x>:BITCfgmethod .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346
DPOJET:MEAS<x>:BITPcnt . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 347
DPOJET:MEAS<x>:BITConfig:STARTPercent. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 347
DPOJET:MEAS<x>:BITConfig:ENDPercent. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 348

x DPOJET Jitter and Eye Diagram Analysis Tools



Table of Contents

DPOJET:MEAS<x>:BITConfig:NUMBins .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 348
DPOJET:MEAS<x>:BITType . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 349
DPOJET:MEAS<x>:BUSState:CLOCKPolarity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 349
DPOJET:MEAS<x>:BUSState:FROMPattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 350
DPOJET:MEAS<x>:BUSState:FROMSymbol . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 350
DPOJET:MEAS<x>:BUSState:MEASUREType.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 351
DPOJET:MEAS<x>:BUSState:MEASUREFrom ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 351
DPOJET:MEAS<x>:BUSState:MEASURETO.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352
DPOJET:MEAS<x>:BUSState:TOPattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 352
DPOJET:MEAS<x>:BUSState:TOSymbol . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 353
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKBitrate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 353
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354
DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355
DPOJET:MEAS<x>:CLOCKRecovery:DAMPing.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355
DPOJET:MEAS<x>:CLOCKRecovery:DATARate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 356
DPOJET:MEAS<x>:CLOCKRecovery:BWType . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 356
DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357
DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357
DPOJET:MEAS<x>:CLOCKRecovery:METHod.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 358
DPOJET:MEAS<x>:CLOCKRecovery:MODel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 358
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 359
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:AUTO? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 359
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:MANual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:Recalctype.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360
DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:SELECTIONtype.. . . . . . . . . . . . . . . . . . . . . . . . . 361
DPOJET:MEAS<x>:CLOCKRecovery:PATTern.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 361
DPOJET:MEAS<x>:CLOCKRecovery:STAndard .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 362
DPOJET:MEAS<x>:COMMONMode:FILTers:STATE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 362
DPOJET:MEAS<x>:CUSTomname .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 363
DPOJET:MEAS<x>:DATA? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 363
DPOJET:MEAS<x>:DDR:MPERCycle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 364
DPOJET:MEAS<x>:DDR:NPERCycle. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 364
DPOJET:MEAS<x>:DDR:WINDowsize. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 365
DPOJET:MEAS<x>:EDGE1.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 365
DPOJET:MEAS<x>:EDGE2.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 366
DPOJET:MEAS<x>:EDGEIncre . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 366
DPOJET:MEAS<x>:EDGES:FROMLevel. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 367
DPOJET:MEAS<x>:EDGES:LEVel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 367
DPOJET:MEAS<x>:EDGES:SLEWRATETechnique .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368
DPOJET:MEAS<x>:EDGES:TOLevel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368
DPOJET:MEAS<x>:FILTers:BLANKingtime . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 369

DPOJET Jitter and Eye Diagram Analysis Tools xi



Table of Contents

MEAS<x>:FILTers:HIGHPass?
DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 370
DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 370

MEAS<x>:FILTers:LOWPass?
DPOJET:MEAS<x>:FILTers:LOWPass:FREQ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 371
DPOJET:MEAS<x>:FILTers:LOWPass:SPEC .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 371
DPOJET:MEAS<x>:REFVoltage. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 372

DPOJET:MEAS<x>:FILTers:RAMPtime .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 372
DPOJET:MEAS<x>:FILTers:STATE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 373
DPOJET:MEAS<x>:FROMedge .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 373
DPOJET:MEAS<x>:HIGHREFVoltage .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 374
DPOJET:MEAS<x>:LOWREFVoltage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 374
MEAS<x>:LOGging

DPOJET:MEAS<x>:LOGging:MEASurements:FILEname? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 375
DPOJET:MEAS<x>:LOGging:MEASurements:SELect. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 375
DPOJET:MEAS<x>:LOGging:STATistics:SELect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 376
DPOJET:MEAS<x>:LOGging:WORSTcase:SELect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 376

DPOJET:MEAS<x>:MASKfile. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 377
MEAS<x>:MEASRange

DPOJET:MEAS<x>:MEASRange:MAX.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 378
DPOJET:MEAS<x>:MEASRange:MIN .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 378
DPOJET:MEAS<x>:MEASRange:STATE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 379

DPOJET:MEAS<x>:MEASStart . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 379
DPOJET:MEAS<x>:N.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 380
DPOJET:MEAS<x>:NAME? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 380
DPOJET:MEAS<x>:PHASENoise:HIGHLimit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381
DPOJET:MEAS<x>:PHASENoise:LOWLimit. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381
DPOJET:MEAS<x>:REFVoltage.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 382
MEAS<x>:Results

DPOJET:MEAS<x>:RESULts? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 383
DPOJET:MEAS<x>:RESULts:ALLAcqs? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 383
DPOJET:MEAS<x>:RESULts:ALLAcqs:HITPopulation?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 383
DPOJET:MEAS<x>:RESULts:ALLAcqs:HITS?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 384
DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:STATus?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 384
DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:HIgh:STATus? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 384
DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:LOw:STATus? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 385
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 385
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 385
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC:STATus? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 386
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 386
DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX:STATus? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 386
DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 387

xii DPOJET Jitter and Eye Diagram Analysis Tools



Table of Contents

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN:STATus? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 387
DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 387
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 388
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC:STATus? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 388
DPOJET:MEAS<x>:RESULts:ALLAcqs:MINHits?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 388
DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN:STATus? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389
DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389
DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK:STATus? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 389
DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 390
DPOJET:MEAS<x>:RESULts:ALLacqs:POPUlation:STATus?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 390
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:Hits? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 390
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MAXHits? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 391
DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MINHits? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 391
DPOJET:MEAS<x>:RESULts:ALLAcqs:STDDev?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 391
DPOJET:MEAS<x>:RESULts:ALLacqs:STDDEV:STATus? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
DPOJET:MEAS<x>:RESULts:CURRentacq:MAX? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 393
DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 393
DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 393
DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 394
DPOJET:MEAS<x>:RESULts:CURRentacq:MIN?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 394
DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 394
DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 395
DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 395
DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 395
DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396
DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396
DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396
DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397
DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev:STATus?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397
DPOJET:MEAS<x>:RESULTS:STATus? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397
DPOJET:MEAS<x>:RESULts:VIew? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 398

DPOJET:MEAS<x>:RJDJ:BER .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 398
DPOJET:MEAS<x>:RJDJ:PATLen .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399
DPOJET:MEAS<x>:RJDJ:POPUlation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 399
DPOJET:MEAS<x>:RJDJ:TYPe .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 400
DPOJET:MEAS<x>:RJDJ:WINDOwlength . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 400
DPOJET:MEAS<x>:SIGNALType.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401
DPOJET:MEAS<x>:SOUrce1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401
DPOJET:MEAS<x>:SOUrce2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 402
DPOJET:MEAS<x>:SSC:NOMinalfreq:AUTO?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 402

DPOJET Jitter and Eye Diagram Analysis Tools xiii



Table of Contents

DPOJET:MEAS<x>:SSC:NOMinalfreq:MANual. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 403
DPOJET:MEAS<x>:SSC:NOMinalfreq:SELECTIONtype .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 403
DPOJET:MEAS<x>:TIMEDATa?. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 404
DPOJET:MEAS<x>:TOEdge .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 404
DPOJET:NUMMeas? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 405
Plots

DPOJET:ADDPlot. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 405
DPOJET:CLEARALLPlots. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 405
DPOJET:PLOT<x>:DATA:XDATa? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 406
DPOJET:PLOT<x>:DATA:YDATa? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 407
DPOJET:PLOT<x>:XUnits? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 407
DPOJET:PLOT<x>:YUnits? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 408
DPOJET:PLOT<x>:SOUrce? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 408
DPOJET:PLOT<x>:TREND:TYPe .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 409
DPOJET:PLOT<x>:TYPe?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 409
DPOJET:PLOT<x>:BATHtub:BER .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 410
DPOJET:PLOT<x>:BATHtub:VERTical:SCALE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 410
DPOJET:PLOT<x>:EYE:ALIGNment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 411
DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 411
DPOJET:PLOT<x>:EYE:HORizontal:RESolution. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 412
DPOJET:PLOT<x>:EYE:MASKfile . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 412
DPOJET:PLOT<x>:EYE:STATE... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 413
DPOJET:PLOT<x>:EYE:SUPERImpose.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 413
DPOJET:PLOT<x>:HISTOgram:AUTOset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 414
DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 414
DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 415
DPOJET:PLOT<x>:HISTOgram:HORizontal:RESolution.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 415
DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 416
DPOJET:PLOT<x>:HISTOgram:NUMBins .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 416
DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 417
DPOJET:PLOT<x>:PHASEnoise:BASEline.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 417
DPOJET:PLOT<x>:SPECtrum:BASE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 418
DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 418
DPOJET:PLOT<x>:SPECtrum:MODE.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 419
DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 419
DPOJET:PLOT<x>:TRANSfer:DENominator. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 420
DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 420
DPOJET:PLOT<x>:TRANSfer:MODE.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 421
DPOJET:PLOT<x>:TRANSfer:NUMerator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 421
DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 422

DPOJET:POPULATION:CONDition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 422
DPOJET:POPULATION:LIMIT.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 423

xiv DPOJET Jitter and Eye Diagram Analysis Tools



Table of Contents

DPOJET:POPULATION:LIMITBY .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 423
DPOJET:POPULATION:STATE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 424
QUALify

DPOJET:QUALify:ACTIVE.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 425
DPOJET:QUALify:SOUrce . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 425
DPOJET:QUALify:STATE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 426

DPOJET:REFLevel:CH<x>:MIDZero .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 426
DPOJET:REFLevels:AUTOSet. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 427
DPOJET:REFLevels:CH<x>:AUTOSet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 427
DPOJET:REFLevels:CH<x>:ABsolute . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 428
DPOJET:REFLevels:CH<x>:ABsolute:RISEHigh.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 428
DPOJET:REFLevels:CH<x>:ABsolute:RISELow .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 428
DPOJET:REFLevels:CH<x>:ABsolute:RISEMid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 429
DPOJET:REFLevels:CH<x>:ABsolute:FALLHigh . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 429
DPOJET:REFLevels:CH<x>:ABsolute:FALLLow.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 430
DPOJET:REFLevels:CH<x>:ABsolute:FALLMid .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 430
DPOJET:REFLevels:CH<x>:ABsolute:HYSTeresis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 431
DPOJET:REFLevels:CH<x>:BASETop .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 431
DPOJET:REFLevels:CH<x>:PERcent. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 432
DPOJET:REFLevels:CH<x>:PERcent:FALLHigh .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 432
DPOJET:REFLevels:CH<x>:PERcent:FALLLow .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 432
DPOJET:REFLevels:CH<x>:PERcent:FALLMid. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 433
DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 433
DPOJET:REFLevels:CH<x>:PERcent:RISEHigh. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 434
DPOJET:REFLevels:CH<x>:PERcent:RISELow ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 434
DPOJET:REFLevels:CH<x>:PERcent:RISEMid.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 435
Reports

DPOJET:REPORT.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 436
DPOJET:REPORT:APPlicationconfig.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 436
DPOJET:REPORT:AUTOincrement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 437
DPOJET:REPORT:COMments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 437
DPOJET:REPORT:DETailedresults . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 438
DPOJET:REPORT:ENABlecomments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 438
DPOJET:REPORT:PASSFailresults . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 439
DPOJET:REPORT:PLOTimages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 439
DPOJET:REPORT:REPORTName .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 440
DPOJET:REPORT:SETupconfig.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 440
DPOJET:REPORT:SAVEWaveforms .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 441
DPOJET:REPORT:STATE? .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 441
DPOJET:REPORT:VIEWreport . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 442

DPOJET:RESULts:STATus? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 442
DPOJET:RESULts:VIew .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 443

DPOJET Jitter and Eye Diagram Analysis Tools xv



Table of Contents

DPOJET:SAVE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 443

DPOJET:SOURCEAutoset . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 444

DPOJET:SOURCEAutoset:HORizontal:UICount . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 444

DPOJET:SOURCEAutoset:HORizontal:UIValue . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 445

DPOJET:STATE .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 445

DPOJET:UNITType. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 446

DPOJET:VERsion?.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 446

Index

xvi DPOJET Jitter and Eye Diagram Analysis Tools



General safety summary

General safety summary
Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections
of the other component manuals for warnings and cautions related to operating the system.

To avoid fire or personal injury

Use proper power cord. Use only the power cord specified for this product and certified for the country
of use.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are
connected to a voltage source.

Connect and disconnect properly. Connect the probe output to the measurement instrument before
connecting the probe to the circuit under test. Connect the probe reference lead to the circuit under test
before connecting the probe input. Disconnect the probe input and the probe reference lead from the circuit
under test before disconnecting the probe from the measurement instrument.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product.
Consult the product manual for further ratings information before making connections to the product.

Do not operate without covers. Do not operate this product with covers or panels removed.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected
by qualified service personnel.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.
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General safety summary

Terms in this manual

These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product
or other property.
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Introduction to the Application Welcome

Welcome

DPOJET is a jitter, timing, and eye analysis tool for Tektronix Performance Digital Oscilloscopes
(DPO7000/C, DSA/DPO70000/B/C, DSA/DPO72504D, DSA/DPO73304D, MSO70000/C, DPO5000,
and MSO5000 series). DPOJET enables you to achieve new levels of productivity, efficiency, and
measurement reliability on complex clock, digital, and serial data signals.

Some of the features of DPOJET are:

Advanced Jitter and Timing Analysis for clocks and data signals, with up to 99 simultaneous
measurements on 12 sources.

Jitter Guide/Serial Data wizard for easy configuration of popular measurement sets.

One Touch Jitter wizard for quick jitter summaries.

Accurate jitter decomposition and TJ (BER) estimation using industry-accepted methods.

Comprehensive measurement statistics.

Flexible measurement/statistic logging and export capabilities.

Sophisticated graphical analysis tools such as Histograms, Time Trends, Eye Diagrams, Spectrums,
Bathtub Plots and Real-Time Eye® diagrams with transition and non-transition bit separation.

Tektronix patented Programmable PLL software clock recovery.

Standards-specific support for clock recovery and jitter separation methods.

Capture and storage of worst-case waveforms for subsequent analysis.

Thorough remote programmability using oscilloscope-like syntax.

Free Trials

Refer to the Optional Applications Software on a Windows-Based Oscilloscope Installation Manual for
details on free trails which are available for all applications. The manual is available on the Optional
Applications Software on Windows-Based Oscilloscopes DVD, in the documents directory.

NOTE. Before evaluating an application, first check that your DSA/DPO/MSO series oscilloscope firmware
version is consistent with the version requirements mentioned in the application’s readme file. You can
check the firmware version number from the oscilloscope Help drop-down list (About TekScope). To check
the application's firmware compatibility, refer to the System Requirements section of the readme.txt file.

If an application is introduced after you receive your oscilloscope, you can download the application
as described in the installation manual (Tektronix part number 071-1888-XX) to obtain the free trial.
Download the manuals from www.tektronix.com/manuals and www.tektronix.com/software.
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Introduction to the Application Related Documentation

Related Documentation

Tektronix manuals are available at: www.tektronix.com/manuals and www.tektronix.com/software. Use
the following table to determine the document that you need:

Table 1: List of reference documents

For information on: Refer to:

Operating the Oscilloscope Oscilloscope user manual.

Oscilloscope user online help.

Software warranty

List of available applications

Compatible oscilloscopes

Relevant software and firmware version numbers

Applying a new option key label

Installing an application

Enabling an application

Downloading updates from the Tektronix Web site

Optional Applications Software on Windows-Based
Oscilloscopes Installation Manual, which is provided on
the Optional Applications Software on Windows-Based
Oscilloscopes CD-ROM, in the Documents directory.

xxx
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Introduction to the Application Conventions

Conventions

Online Help uses the following conventions:

When steps require sequence of selections using the application interface, the “>” delimiter marks
each transition between a menu and an option. For example, Analyze > Wizard > One Touch Jitter.

The terms “DPOJET application” and “application” refer to DPOJET.

The term “oscilloscope” refers to any product on which this application runs.

The term “DUT” is an abbreviation for Device Under Test.

The term “select” is a generic term that applies to the methods of choosing an option: with a mouse or
with the touch screen.

User interface screen graphics are taken from a DPO7000 series oscilloscope.

You can find a PDF (portable document format) file for this document in the Documents directory on the
Optional Applications Software on Windows-Based Oscilloscopes DVD. The DVD booklet only contains
information on installing the application from the DVD and on how to apply a new label. You can also find
the PDF and the Online Help at Start > All Programs > TekApplications > DPOJET.

Table 2: Icon descriptions

Icon Meaning

This icon identifies important information.

This icon identifies conditions or practices that could result
in loss of data.

This icon identifies additional information that will help you
use the application more efficiently.

xxx

Technical Support

Tektronix welcomes your comments about products and services. Contact Tektronix through mail,
telephone, or the Web site. Click Contacting Tektronix ) for more information.

Tektronix also welcomes your feedback. Click Customer feedback (see page 4) for suggestions for
providing feedback to Tektronix.
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Introduction to the Application Customer Feedback

Customer Feedback

Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or other comments you may have regarding the application or oscilloscope.

Direct your feedback via email to

techsupport@tektronix.com

Or FAX at (503) 627-5695, and include the following information:

General Information

Oscilloscope model number (for example, DPO7000/C or DSA/DPO70000/B/C, DSA/DPO72504D,
DSA/DPO73304D, MSO70000/C, DPO5000, or MSO5000 series) and hardware options, if any.

Software version number.

Probes used.

Application-specific Information

Description of the problem such that technical support can duplicate the problem.

If possible, save the oscilloscope and application setup files as .set and associated .xml files.

If possible, save the waveform on which you are performing the measurement as a .wfm file.

Once you have gathered this information, contact technical support by phone or through e-mail. In the
subject field, please indicate “DPOJET Problem” and attach the .set, .xml and .wfm files to your
e-mail. If there is any query related to the actual measurement results, then you can generate a .mht
report and send it.

The following items are important, but optional:

Your name

Your company

Your mailing address

Your phone number

Your FAX number

Enter your suggestion. Please be as specific as possible.

Please indicate if you would like to be contacted by Tektronix regarding your suggestion or comments.

To include screen shots of the oscilloscope waveform and DPOJET user interface, from your oscilloscope
menu bar, click File > Save As > Screen Capture. To include screenshots of the DPOJET plots, select the
floppy-disk icon from the plots toolbar. In either case, enter a file name in the Save As dialog box, select
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an image file format (For example:.bmp or .png or .jpeg), choose a save location and select Save. You can
then attach the file(s) to your e-mail (depending on the capabilities of your e-mail editor).
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Getting Started Product Description

Product Description

DPOJET is a jitter (see page 7), timing (see page 7), and eye diagram analysis (see page 7) tool for
Tektronix Performance Digital Oscilloscopes (DPO7000/C, DSA/DPO70000/B/C, DSA/DPO72504D,
DSA/DPO73304D, MSO70000/C, DPO5000, and MSO5000 series). DPOJET enables you to achieve
new levels of productivity, efficiency, and measurement reliability on complex clock, digital, and serial
data signals.

The application provides the following features:

One Touch Jitter Summary.

Measurement Setup Wizard.

Auto-detection of signal type (clock or data).

RJ/DJ decomposition on repeating and arbitrary data patterns.

Spectral plot with Normal, Averaging, and Peak Hold.

Eye diagrams with transition and non-transition bits separation.

High pass and low pass measurement filters.

Selectable PLL, linear and explicit clock edge detection and clock recovery methods.

Automatic reference level autoset for eye diagrams, jitter and timing measurements.

Preferences shortcut to set up options available at the Select panel.

Timing Analysis

Timing analysis is the measurement of period, setup, hold, skew, and other edge-to-edge data
timing relationships.

Eye Diagram Analysis

Eye diagram analysis is the plotting and measurement of eye diagrams and masks.

Jitter Analysis

Jitter Analysis is the measurement of Time Interval Error (TIE), advanced RJ/DJ decomposition, and
other clock to data edge relationships.
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Getting Started DPOJET Option Levels

DPOJET Option Levels

The DPOJET application offers two different levels of features, depending on how it is configured. The
configurations are determined by the following order codes:

DJE – Jitter and Eye Diagram Analysis Tools - Essentials

DJA – Jitter and Eye Diagram Analysis Tools - Advanced

NOTE. The application name “Jitter and Eye Diagram Analysis Tools” is the same for DJE and DJA.
However, Help > About DPOJET indicates the configured option level. Save/Recall is compatible between
the option levels. If a setup file saved in DJA is recalled in DJE, only the capabilities available in DJE
will be recalled.

Jitter and Eye Diagram Analysis Tools - Essentials

Use Essentials for basic timing and jitter analysis. Essentials offers:

Period, Frequency and Time Interval Error analysis.

Timing parametrics such as rise/fall times, pulse width and duty cycle.

Many graphical tools such as histograms, time trends, and spectrums.

Configurable HTML report generation.

Logging features for recording individual measurements, statistics, or worst-case waveforms.

Comprehensive remote control using oscilloscope-like GPIB syntax.

A wizard interface to ease common setup tasks.

NOTE. Summary View and Overall Test Result are not available for DJE.

Jitter and Eye Diagram Analysis Tools-Advanced

The Advanced configuration offers all the features of Essentials, and adds the following:

Jitter separation (RJ/DJ analysis).

Eye measurements.

Amplitude measurements.

Measurement filters.

Eye diagrams, bathtub plots or Mask Hits waveform plots.

Pass/Fail limits capability.
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Getting Started Compatibility

NOTE. Option DJA is required for PCI Express Gen1/Gen2/Gen3 measurements and for DDRA
measurements.

Compatibility

For information on oscilloscope compatibility, refer to the Optional Application Software on Microsoft
Windows Based Oscilloscopes Installation Manual, Tektronix part number 077-0067-XX. The manual is
available as a PDF file.

Requirements and Restrictions

DPOJET requires Matlab MCR (Matlab Compiler Runtime) 7.5 for 32-bit oscilloscopes and Matlab MCR
7.14 for 64-bit oscilloscopes. The required MCR will automatically be installed, if not present, by the
DPOJET InstallShield wizard.

DPOJET requires .Net Framework v3.5 or higher for 32-bit oscilloscopes and .Net framework v4 or
higher for 64-bit oscilloscopes.
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Getting Started Supported Probes

Supported Probes

The application supports the following probes:

TAP1500

TAP2500

TAP3500

P5100

P6015

P6101A

P6139A

P6241

P6243

P6245

P6249

P6150

P6158

P7240

P7260

P7330

P7340A

P7350

P7350SMA

P7360A

P7380A

P7380SMA

P7313A

P7313SMA

All P75XX probes
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Getting Started Installing the Application

Installing the Application

Refer to the Optional Applications Software on Windows-Based Oscilloscopes Installation Manual for the
following information:

Software warranty.

List of available applications, compatible oscilloscopes, and relevant software and firmware version
numbers.

Applying a new option installation key label.

Installing an application.

Enabling an application.

Downloading updates from the Tektronix Web site.

You can find a PDF (portable document format) file for this document in the Documents directory on the
Optional Applications Software on Windows-Based Oscilloscopes DVD. The DVD booklet contains
information on how to install the application from the DVD and on how to apply a new option installation
key label.
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Getting Started About DPOJET

About DPOJET

Click Help > About DPOJET to view application details such as the release software version number,
application name, and copyright.
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Operating Basics Starting the Application

Starting the Application

On the oscilloscope menu bar, click Analyze > Jitter and Eye Analysis (DPOJET) > Select to open
the application.

Application Interface Menu Controls
Table 3: Application menu controls descriptions

Item Description

Tab Shortcut to a menu in the menu bar or a category of menu
options; most tabs are short cuts.

Area Visual frame with a set of related options.

Option button Button that defines a particular command or task.

Field A box to type in text, or to enter a value with the Keypad or
a Multipurpose knob.

Check Boxes Use to select or clear preferences.

Scroll bar Vertical or horizontal bar at the side or bottom of a display
area that can be used for moving around in that area.

Browse Displays a window where to look through a list of directories
and files.

Command button Button that initiates an immediate action such as Run
command button in the control panel.

Virtual Keypad icon
Click to use on-screen keypad to enter alphanumeric values.

MP knob references (a or b) Identifiers that show which Multi Purpose Knob (MPK) may
be used as an alternate means to control a parameter;
turn the knob on the oscilloscope front panel to adjust the
corresponding parameter Also, the value can be entered
directly on the MPK display component.

xxx
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Operating Basics Virtual Keypad

Virtual Keypad

Select the icon and use the virtual keypad to enter alphanumeric values, such as reference voltage
levels.
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Operating Basics Tips on DPOJET User Interface

Tips on DPOJET User Interface

Here are some tips to help you with the application user interface:

Use the Serial Data/Jitter Guide to rapidly set up and initiate sets of commonly used measurements.
After running the Serial Data/Jitter Guide, you may modify the configuration parameters to meet
specific needs.

Select a measurement to create a measurement and add it to the current measurement table. New
measurements initially use the same source as the earlier measurement, or the most recently used

source. Click to change the measurement source or adjust other source parameters such as
the reference levels.

Select any measurement multiple times to create multiple copies. This may be useful if you wish to
run the same measurement with different configuration options.

Use the Single button to obtain a single set of measurements from a single new waveform
acquisition. Pushing the button again before processing has completed will interrupt the processing
cycle.

Use the Run button to continuously acquire and accumulate measurements. Push the button
again to interrupt the current acquisition.

Use the Recalc button to perform measurements on the waveform currently displayed on the
oscilloscope, that is without performing a new acquisition. This is useful if you wish to modify a
configuration parameter and re-run the measurements on the current waveform.

Application Directories

The installation directory for DPOJET is C:\Program Files\TekApplications\DPOJET. During
installation, the application sets up directories for various functions such as to save setup files. The file
name extension is used to identify the file type.

Table 4: Application directories

Default directory Used for

C:\%USERPROFILE%\Tektronix\TekApplica-

tions\DPOJET\Images 1
Exported plot files.

C:\Users\Public\Tektronix\TekApplica-

tions\DPOJET\Limits
Pass/fail limits files.

C:\Users\Public\Tektronix\TekApplica-

tions\DPOJET\Patterns

Bit patterns.
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Table 4: Application directories (cont.)

Default directory Used for

C:\%USERPROFILE%\Tektronix\TekApplica-

tions\DPOJET\Logs 1
Log files. Consists of three subfolders:

Statistics for statistics log files (.csv)

Measurements for measurement log files (.csv) and

Waveforms for worst case waveforms (.wfm)

C:\Users\Public\Tektronix\TekApplica-

tions\DPOJET\Masks
Mask files for various serial data standards. For Example -
PCIE, FBDIMM, SATA.

C:\%USERPROFILE%\Tektronix\TekApplica-

tions\DPOJET\Reports 1
Report files (.mht ).

C:\%USERPROFILE%\Tektronix\TekApplica-

tions\DPOJET\Data 1
Error log file, DPOJETErrors.log.

C:\Users\Public\Tektronix\TekApplica-

tions\DPOJET\Examples
Various tutorial and support files.

xxx

1 %USERPROFILE% represents your user location.

File Name Extensions
Table 5: File name extensions

File Extension Description

.csv Ascii file containing Comma Separated Values. This file
format may be read by any ascii text editor (such as
Notepad) or may be imported into spreadsheets such as
Excel.

.xml Ascii file containing measurement setup information, limits
or other data in Extensible Markup Language.

.set Binary file containing oscilloscope setup information in a
proprietary format.

.mht An HTML archive file, compatible with common Windows
applications; and contain the full report, including text and
graphics.

.wfm Binary file containing an oscilloscope waveform record in a
recallable, proprietary format.

xxx
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Application Menu Shortcuts

The DPOJET application provides shortcuts for navigating the user interface. Use Alt+ A for the Analyze
menu and Alt+A+J for Jitter and Eye Analysis (DPOJET). Use Alt+A+E for PCI Express and Alt+A+U
for USB 3.0 Essentials.

NOTE. Alt+A+J is common for all submenus except the Help menu.

Table 6: Application shortcuts

Menu Items SubMenu Shortcut

One Touch Jitter Alt +A+J+JWizard

Serial Data/Jitter Wizard Alt +A+J+W

Select Alt +A+J+S

Configure Alt +A+J+C

Results Alt +A+J+R

Plots Alt +A+J+P

Reports Alt +A+J+O

Data Snapshot Alt +A+J+E+DExport

Measurement Summary Alt +A+J+E+S

Data Logging Alt +A+J+L

Preferences Alt +A+J+F

Limits Alt +A+J+I

Global Configuration Alt +A+J+G

Measurement Summary Alt +A+J+M

Deskew Alt +A+J+K

Help

About DPOJET Alt +H+J

Help on Jitter and Eye Analysis Alt +H+T

Help on PCI Express MOI Alt+H+M

Help on USB 3.0 MOI Alt+H+U

xxx
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Returning to the Application

When you access oscilloscope functions, the DPOJET control windows may be replaced by the
oscilloscope control windows or by the oscilloscope graticule. Access oscilloscope functions in the
following ways:

From the menu bar on the oscilloscope, choose Analyze > Jitter and Eye Analysis (DPOJET) >
Select.

Alternatively, switch between recently used control panels using the forward or backward arrows on
the right corner of the control panel.

Saving a Setup

The DPOJET application state is automatically saved with the oscilloscope state. To save the oscilloscope
settings and application state, follow these steps:

1. Click File > Save As > Setup.

2. In the file browser, select the directory to save the setup file.

3. Select or enter a file name. The application appends *_DPOJET.xml to store DPOJET setup, and
*.set to store oscilloscope settings.

4. Click Save.

NOTE. After the oscilloscope application is started, DPOJET needs to be launched at least once before
any saved DPOJET configuration can be recalled.

Recalling a Saved Setup

To recall the default application setup and oscilloscope settings, do the following steps:

1. Click File > Recall.

2. Select the directory in the file browser to recall the setup file.

3. Select a .set file and click Recall.

NOTE. Only .set files can be selected for recall; any corresponding _DPOJET.xml file in the same directory
will be recalled as well, if DPOJET has been launched at least once since the oscilloscope application
was started. If DPOJET has not been launched at least once, the oscilloscope settings will be recalled
but the DPOJET configuration will be ignored.
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Recalling the Default Setup

To recall the default application and oscilloscope settings, click File > Recall Default Setup.

Setting Up the Application for Analysis

In general, setting up the application for analysis consists of these steps:

1. Selecting one or more measurements

2. Configuring parameters for the selected measurements

3. Configuring any global parameters

4. Adding plots to visual measurement results

Steps 2-4 are optional, and step 4 can be done either before or after measurement results have been
calculated. In addition to this manual process, several wizard interfaces (One Touch Jitter, Serial Data/Jitter
Guide) are available that can streamline the process.

Selecting measurements is accomplished by first selecting a measurement category (Period and
Frequency, Jitter, Time, Eye, Amplitude, or Standard-Specific Measurements) and then choosing specific
measurements. A measurement may be selected multiple times, for example to run on different waveform
sources or to run on the same waveform source with different parameters.

Refer to the following sections for more details on various measurements:

Period and Frequency measurements (see page 19)

Jitter measurements (see page 21)

Time measurements (see page 22)

Eye measurements (see page 24)

Amplitude measurements (see page 24)

Standard-Specific Measurements (see page 26)

Table of Measurements-Period/Freq

Definitions of the period and frequency-related measurements are given in the following table:
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Table 7: Period/Frequency measurements definitions

Measurement Description

Period For clock signals, the elapsed time between consecutive
crossings of the mid reference voltage level in the direction
specified; one measurement is recorded per crossing pair.
For data signals, the elapsed time between consecutive
crossings of the mid reference voltage in opposite directions
divided by the estimated number of unit intervals for that
pair of crossings; one measurement is recorded per unit
interval so N consecutive bits of the same polarity result in
N identical period measurements.

Frequency The inverse of the period for each cycle or unit interval.

CC–Period The cycle-to-cycle period; the difference in period
measurements from one cycle to the next, that is the first
difference of the Period measurement.

N–Period The duration of N periods.

Pos Width Amount of time the waveform remains above the mid
reference voltage level.

Neg Width Amount of time the waveform remains below the mid
reference voltage level.

+Duty Cycle The ratio of positive width to period, expressed in %.

–Duty Cycle The ratio of negative width to period, expressed in %.

+CC–Duty The difference between two consecutive positive widths.

–CC–Duty The difference between two consecutive negative widths.

xxx
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Table of Measurements-Jitter

By default, the application enables analysis of all jitter components except Non-Periodic Jitter (NPJ).
This is because NPJ (a form of Bounded Uncorrelated Jitter (BUJ) that isn’t periodic) is less frequently
encountered and its analysis typically requires longer waveforms, multiple waveforms, or both. The default
processing mode is called Spectral Only. To enable analysis of NPJ, you must set the processing mode to
Spectral + BUJ. This is done either from the Preferences-Jitter Decomp panel or from the Jitter Map.

Related Topics

Breakdown of Jitter (Jitter Map (see page 31)

Preferences Jitter Decomp (see page 73)

Definitions of the jitter-related measurements are given in the following table.

NOTE. All jitter measurements except TIE are statistical measurements that require sufficient record length
so that all deterministic effects can be observed and the random jitter can be modeled.

Table 8: Jitter measurements definitions

Measurement Description

TIE Time Interval Error is the difference in time between an
edge in the source waveform and the corresponding edge in
a reference clock or explicitly by another source signal. The
reference clock is determined by a clock recovery process.

RJ Random Jitter is the statistics for all timing errors not
exhibiting deterministic behavior, based on the assumption
that they follow a Gaussian distribution. If the Jitter
Separation Model is set to Spectral + BUJ, the Gaussian
assumption is further validated and jitter appearing to be
non-Gaussian is excluded. Random Jitter is characterized
by its standard deviation.

RJ–δδ Dual-Dirac Random Jitter is Random Jitter as defined
above, but calculated based on a simplified assumption that
the histogram of all deterministic jitter can modeled as a
pair of equal-magnitude Dirac functions (impulses known as
delta-functions).

DJ Deterministic Jitter is the statistics for all timing errors
that follow deterministic behavior. Deterministic Jitter is
characterized by its peak-to-peak value.

DJ–δδ Dual-Dirac Deterministic Jitter as defined above, but
calculated on the same simplified model as described under
RJ–δδ.
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Table 8: Jitter measurements definitions (cont.)

Measurement Description

PJ Periodic Jitter is the statistics for that portion of the
deterministic jitter which is periodic, but for which the period
is not correlated with any data in the waveform.

DDJ Data-Dependent Jitter is the statistics for that portion of the
deterministic jitter directly correlated with the data pattern
in the waveform.

DCD Duty Cycle Distortion is the statistics for that portion of the
deterministic jitter directly correlated with signal polarity, that
is the difference in the mean timing error on positive edges
versus that on negative edges.

TJ@BER Total Jitter at a specified Bit Error Rate (BER). This
combines the Random and Deterministic effects, and
predicts a peak-to-peak jitter that will only be exceeded with
a probability equal to the BER.

Jitter Summary This is not an individual measurement but a convenience
function. Pressing this button automatically adds a set of
ten jitter-related measurements with a single action. The
measurements are: TIE, RJ, RJ–δδ, DJ, DJ–δδ, PJ, DDJ,
DCD, TJ@BER, and Width@BER.

Phase Noise The RMS magnitude for all integrated timing jitter falling
between two specified frequency limits. This measurement
is only applicable for clock signals.

NPJ ‡ Non-Period Jitter is the statistics for that portion of the
non-deterministic jitter that has a bonded distribution. It is
characterized by its dual-dirac amplitude (that is, the amount
by which its presence causes an additional separation of
the two Gaussian distributions in the dual-dirac model).

xxx

‡ The NPJ measurement is only available when the Jitter Separation Model is set to Spectral + BUJ under DPOJET Preferences Setup.

Table of Measurements-Time

Definitions of the time-related measurements are given in the following table:

Table 9: Time measurements definitions

Measurement Description

Rise Time Elapsed time between the Low reference level crossing and
the High reference level crossing on the rising edge of the
waveform

Fall Time Elapsed time between the High reference level crossing
and the Low reference level crossing on the falling edge
of the waveform

High Time Amount of time the waveform remains above the high
reference voltage level
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Table 9: Time measurements definitions (cont.)

Measurement Description

Low Time Amount of time the waveform remains below the low
reference voltage level

Setup Elapsed time between the designated edge of a data
waveform and that of a clock waveform, based on the
respective mid reference level crossings

Hold Elapsed time between the designated edge of a clock
waveform and that of a data waveform, based on the
respective mid reference level crossings

Rise Slew Rate Rate of change of voltage between the two chosen
reference level crossings on the rising edges of the
waveform

Fall Slew Rate Rate of change of voltage between the two chosen
reference level crossings on the falling edges of the
waveform

Skew Time difference between two similar edges on two
waveforms assuming that every edge in one waveform has
a corresponding edge (either the same or opposite polarity)
in the other waveform; edge locations are determined by
the mid reference voltage level.

SSC Profile SSC Profile is not intended to serve as a measurement. It
is a vehicle for showing the SSC modulation profile versus
time, using a time trend plot.

SSC Mod Rate SSC Mod Rate computes the SSC modulating frequency.

SSC Freq Dev SSC frequency deviation in ppm (parts per million),
measured at each inflection point in the modulation profile

SSC Freq Dev Min The minimum frequency shift as a function of time

SSC Freq Dev Max The maximum frequency shift as a function of time

Time Outside Level. Time Outside Level Ring Back is defined as the time interval
of overshoot or undershoot.

tCMD-CMD ‡ tCMD-CMD is a timing measurement and it measures the
elapsed time between two logic states on a specified digital
bus.

xxx

‡ This measurement is available only on 64-bit MSO instruments.
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Table of Measurements-Eye

Definitions of the eye-related measurements are given in the following table:

Table 10: Eye measurements definitions

Measurement Description

Height The measured clear vertical eye opening at the center of
the unit interval. Height = High(min) – Low(max)

Height@BER The eye height at a specified Bit Error Rate

Width Measured clear horizontal eye opening at the middle
reference level.

Width = UI(mean) – TIE(max) – TIE(min)

Width@BER The horizontal eye opening projected to correspond to
a specified Bit Error Rate. This number is obtained by
measuring the jitter on the waveform, performing RJ/DJ
separation analysis, creating a bathtub curve, and reporting
the bathtub width at the appropriate error rate. This eye
width may not match the observed eye width because
it is a statistical measure. The measurement requires a
sufficient record length so that all deterministic effects can
be observed and the random jitter can be modeled.

Width(BER) = UI(mean) – TJ(BER)

Mask Hits The number of unit intervals for which mask violations
occurred. A mask violation occurs when, during a unit
interval, the waveform passes through a segment of the
defined mask. Mask hits are separately tallied for Segment
1 (upper), Segment 2 (center-of-eye mask) and Segment 3
(lower), and the total for all three segments is also reported.
Thus, as many as three hits can be added to the total count
for each unit interval. The population for this measurement
gives the total number of unit intervals observed.

Eye High The voltage at a selected horizontal position across the unit
interval, for all High bits in the waveform.

Eye Low The voltage at the selected horizontal position across the
unit interval, for all Low bits in the waveform.

Q-Factor Quality Factor is the ratio of vertical eye opening to rms
vertical noise.

xxx

Table of Measurements-Amplitude

Definitions of the amplitude-related measurements are given in the following table:
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Table 11: Amplitude measurements definitions

Measurement Description

High Vertical value in the central portion of the unit interval (UI)
for high data bits. The percent of the UI over which the
waveform is evaluated is adjustable, as is the method
by which a single value is derived from this span. The
measurement may optionally be limited to transition or
non-transition bits only.

Low Vertical value in the central portion of the unit interval (UI)
for low data bits, with configuration options matching those
of the High measurement.

High–Low Difference between the mean value of the High
measurement and the mean value of the Low measurement.

DC Common Mode Common-mode voltage for the two sources.

.

AC Common Mode The common mode voltage between two single-ended
signals. AC is defined as all the frequency components
above the cutoff frequency (30 KHz).

T/nT-Ratio Ratio of the transition eye-voltage to the nearest subsequent
non-transition eye voltage, expressed in decibels.

V–Diff –Xovr Voltage level at the crossover voltage of a differential signal
pair.

Overshoot Difference between the positive-going peak amplitude and
the reference voltage level, for each waveform event that
exceeds the reference level.

Undershoot Difference between the negative-going peak amplitude
and the reference voltage level (expressed as a positive
number), for each waveform event that exceeds the
reference level.

Cycle Pk-Pk Difference between the maximum and minimum voltage for
each cycle, where a cycle is defined as a positive half-cycle
followed by a negative half-cycle or a negative half-cycle
followed by a positive half-cycle. Half-cycles are determined
by the mid reference level crossings.

Cycle Min Defined as the peak negative voltage for each negative
half-cycle, where half-cycles are determined by the mid
reference level crossings.

Cycle Max Defined as the peak positive voltage for each positive
half-cycle, where half-cycles are determined by the mid
reference level crossings.

xxx
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Table of Measurements-Standard

Standard-specific measurements in the this category may include timing, jitter, amplitude or eye
measurements. Generally, they are measurements that have been modified to support a specific standard or
otherwise deviate from the generic measurements. Use the Standard drop-down list to view the DDR, PCI
Express and USB measurements. Use the Test Point Selection (see page 29) when available, to select the
setup file specific to the standard. Their measurement definitions are given in the following table:

Table 12: Standard-specific measurements definitions

Measurement Description

DDR

DDR Setup–SE Elapsed time between the designated edge of a data
waveform and that of a single-ended DQS waveform, based
on their respective DDR-specific reference level crossings.

DDR Setup–Diff Elapsed time between the designated edge of a data
waveform and that of a differential DQS waveform, based
on their respective DDR-specific reference level crossings.

DDR Hold–SE Elapsed time between the designated edge of a
single-ended DQS waveform and that of a data waveform,
based on their respective DDR-specific reference level
crossings.

DDR Hold–Diff Elapsed time between the designated edge of a differential
DQS waveform and that of a data waveform, based on their
respective DDR-specific reference level crossings.

DDR tCK(avg) Calculated as the average clock period across a sliding
N-cycle window.

DDR tCL(avg) Defined as the average low pulse width calculated across a
sliding N-cycle window.

DDR tCH(avg) Defined as the average high pulse width and is calculated
across a sliding N-cycle window.

DDR tERR(n) Defined as the cumulative error across multiple consecutive
cycles from tCK(avg).

DDR tERR(m-n) Defined as the cumulative error across multiple consecutive
predefined cycles from tCK(avg).

DDR tJIT(duty) Defined as the cumulative set of the largest deviation of
any single tCH from tCH(avg) and the largest deviation of
any single tCL from tCL(avg).

DDR tJIT(per) Defined as the largest deviation of any single tCK from
tCK(avg).

DDR tRPRE Defined as the width of the READ preamble, from the exit of
tristate to the first rising edge on DQS.

DDR tWPRE Defined as the width of WRITE preamble, from the exit of
tristate to the first rising edge on DQS.
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Measurement Description

DDR tPST Defined as the width of the postamble, from the last falling
mid reference level crossing to the start of an undriven state
(as judged by a rising trend per JEDEC specs), for either a
Read or Write burst.

DDR Over Area Defined as the area of a triangle for which the base is
defined by the crossings of the configured reference level
and the peak is the maximum voltage level attained between
those crossings.

DDR Under Area Defined as the area of an inverted triangle for which the
base is defined by the crossings of the configured reference
level and the (downward pointing) peak is the minimum
voltage level attained between those crossings.

DDR VID(ac) Defined as the AC differential input voltage.

DDR tDQSS WRITE command to 1st DQS latching transition.

DDR3 Vix(ac) Defined as the differential input cross-point voltage relative
to VDD/2 for (CK/CK) or (DQS/DQS).

GDDR5 tBurst-CMD ‡ Defined as the elapsed time from the last data element of a
READ or WRITE burst to the Command.

GDDR5 tCKSRE ‡ Defined as the time elapsed from the SRE command to
valid clock cycles.

GDDR5 tCKSRX ‡ Defined as the valid clock (CK) required before Self Refresh
exit (SRX).

DDR2 tDQSCK Defined as the elapsed time from the first rising DQS in a
burst to the nearest rising CK or CK#.

PCI Express

PCIe T-Tx-Diff-PP Defined as the change in voltage level across a transition
in the waveform. It is the peak-to-peak differential voltage
swing.

PCIe T-TX Defined as the measured clear horizontal eye opening at
the middle reference level.

PCIe T-Tx-Fall Defined as the time difference between the VRefLo(20%)
reference level crossing and the VRefHi(80%) reference
level crossing on the falling edge of the waveform.

PCIe Tmin-Pulse Defined as the single pulse width measured from one
transition center to the next.

PCIe DeEmph Defined as the ratio of the transition eye-voltage to the
nearest subsequent non-transition eye voltage, expressed
in decibels.

PCIe T-Tx-Rise Defined as the time difference between the VRefHi(80%)
reference level crossing and the VRefLo(20%) reference
level crossing on the rising edge of the waveform.
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Measurement Description

PCIe UI For clock signals, the elapsed time between consecutive
crossings of the mid reference voltage level in the direction
specified; one measurement is recorded per crossing pair.
For data signals, the elapsed time between consecutive
crossings of the mid reference voltage in opposite directions
divided by the estimated number of unit intervals for that
pair of crossings; one measurement is recorded per unit
interval so N consecutive bits of the same polarity result in
N identical period measurements.

PCIe Med-Mx-Jitter Defined as the maximum time between the jitter median and
the maximum deviation from the median.

PCIe T-RF-Mismch Defined as the mismatch between Rise time (TRise) and
Fall time (TFall).

PCIe MAX-MIN Ratio † Defined as the voltage range ratio over which a particular
receiver must operate for consecutive UI.

PCIe SSC FREQ DEV Defined as the SSC frequency deviation in ppm (parts per
million).

PCIe SSC PROFILE Shows the modulation profile of the SSC.

PCIe AC Common Mode The common mode voltage between two single-ended
signals. AC is defined as all the frequency components
above the cutoff frequency (30 KHz).

T-TX-DDJ Defined as the time delta between the PDF’s mean for each
zero crossing point and the corresponding recovered clock
edge.

T-TX-UTJ Referenced to a recovered data clock generated by means
of a CDR tracking function. Uncorrelated total jitter may be
derived after removing the DDJ component from each PDF
and combining the PDFs for all edges in the pattern.

T-TX-UDJDD Defined as uncorrelated jitter at the zero crossing point and
the corresponding recovered clock edge.

T-TX-UPW-TJ Defined as an edge-to-edge phenomenon on consecutive
edges.

T-TX-UPW-DJDD Defined as uncorrelated PWJ at the zero crossing.

V-TX-NO-EQ Defined by setting c-1 and c+1 to zero and measuring the
p-p voltage on the 64-ones/64-zeroes segment of the
compliance pattern.

V-TX- EIEOS Defined by setting c+1 coefficient value of –0.33 and a c-1

coefficient of 0.0 and measuring the p-p voltage on the
8-ones/8-zeroes segment of the compliance pattern, where
the pattern is repeated for a total of 128 UI.

ps21TX Measured by comparing the 64-zeroes/64- ones p-p voltage
(V111) against a 1010 pattern (V101).

USB 3.0 Essentials

USB VTx-Diff-PP Defined as the change in voltage level across a transition
in the waveform. It is the peak-to-peak differential voltage
swing.
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Measurement Description

USB TCdr-Slew-Max This measurement finds the peak-to-peak period jitter.
Period jitter can be obtained by taking the first difference of
the filtered phase jitter.

USB Tmin-Pulse-Tj Defined as the single pulse width measured from one
transition center to the next including all jitter sources.

USB Tmin-Pulse-Dj Defined as the minimum pulse width with only deterministic
jitter components.

USB SSC MOD RATE Defined as the SSC modulation rate in terms of Hz.

USB SSC FREQ DEV MAX Defined as the maximum frequency shift as a function of
time.

USB SSC FREQ DEV MIN Defined as the minimum frequency shift as a function of
time.

USB SSC PROFILE Shows the modulation profile of the SSC.

USB UI For clock signals, defined as he elapsed time between
consecutive crossings of the mid reference voltage level in
the direction specified; one measurement is recorded per
crossing pair. For data signals, defined as the elapsed time
between consecutive crossings of the mid reference voltage
in opposite directions divided by the estimated number of
unit intervals for that pair of crossings; one measurement is
recorded per unit interval so that N consecutive bits of the
same polarity result in N identical period measurements.

USB AC Common Mode The common mode voltage between two single-ended
signals. AC is defined as all the frequency components
above the cutoff frequency (30 KHz).

xxx

† Custom name for PCIe MAX-MIN Ratio is PCIe VRX-MAX-MIN Ratio.
‡ This measurement is available only on 64-bit MSO instruments.

Test Point Selection in the Standard Tab

Test Point Selection is available only for PCI Express, USB, and MIPI standards. You can either use the
Test Point “Setup” button or File > Recall option to select the setup file for the selected standard.

The Test Point shows “None Selected” if no test point is specified. Click Setup to navigate to the directory,
which contains the setup files specific to the standard.
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The setup file with oscilloscope settings and test measurements replaces any selected measurements and
oscilloscope settings before specifying the test point. A warning message is displayed as shown:

Once the test point is selected, the measurements associated with the test point are displayed in the
measurement table and the configuration specific to the standard is recalled. However, you can still add the
measurements specific to the standard. At any time, you can save the setup file to recall. The Test Point
field displays only the Test point name. A tool tip displays the entire file name as shown:

When you select PCI Express from the Standards list, a hint saying “This standard contains Gen1 and
Gen2 measurements” as shown:
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Breakdown of Jitter (Jitter Map)

The breakdown of jitter into components such as RJ, PJ and DDJ is model-based. This means that a
suitable mathematical model is proposed for the overall jitter, consisting of various jitter components.
The components are separable from each other based on observable characteristics, and the rules by
which these components combine to form an overall jitter distribution are based on well-understood
mathematical principles.

The jitter model used by DPOJET is hierarchical, and is represented by a jitter map. This map may

be displayed by clicking Select > Jitter, and then clicking the information icon ( ) in the upper right
corner of the panel.

DPOJET actually offers two different jitter maps:

When the Jitter Separation Method is set to ‘Spectral Only’ (which is the default), a simpler map that
doesn’t include NPJ and BUJ categories is used. This offers simpler and faster processing and gives
accurate results when crosstalk is not present (and often even when it is present).

When the Jitter Separation Method is set to ‘Spectral + BUJ’, the map shown below is used. This map
offers an additional model component, Non-Periodic Jitter or NPJ. This jitter model is more accurate
when certain types of crosstalk are present. The disadvantage of using this map is that more statistics
(that is, a higher population of unit intervals) must be acquired before results can be produced. This
may require longer record length, multiple acquisitions, or both.

By clicking the radio buttons in the upper left corner of the map window, you can switch between the
two jitter models. Once a model has been selected, you can add jitter measurements by clicking directly
on the buttons embedded in the map, or dismiss the map and click on the conventional buttons in the
main control window.
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Related Topics

Separation of Non-Periodic Jitter (NPJ) (see page 316)

One Touch Jitter

One Touch Jitter is a process for automatically performing complex jitter analysis with a single menu
selection. The process selects a waveform source, sets the horizontal and vertical scales, chooses
measurements, generates statistical results and creates plot summary (Histogram, Spectrum, Bathtub
and Eye Diagram). To run this process, select Analyze > Jitter and Eye Analysis (DPOJET) > One
Touch Jitter.
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By default, the DPOJET application chooses an appropriate source for the jitter measurements from the
available active source(s) (amplitude >50 mV) before generating the jitter summary.

NOTE. If the source amplitude is not greater than 50 mV, the application displays a message “Signal
amplitude is extremely low for the selected source”.

The following logic is used if none or many sources are active:

None of the sources are active (see page 33)

Only one source is active (see page 33)

Two sources are active (see page 33)

Three sources are active (see page 34)

Four or more sources are active (see page 34)

Case 1: None of the sources are active

If none of the sources are active, you are prompted to select any one of the Ch, Ref or Math sources.
The selected source is validated to have amplitude >50 mV. When the amplitude of the selected source
is >50 mV, then autoset is performed to increase vertical and horizontal resolution of the signal. The
selected source is assigned for all single source jitter measurements. The results and plots are generated
for a single sequence.

Case 2: Only one source is active

The application checks if the active source has amplitude >50 mV. The selected source is assigned for all
single jitter measurements. The results and plots are generated for a single sequence.

Case 3: Two sources are active

The application checks whether the active sources are a differential pair. If so, it creates a Math waveform
by taking the difference of the two (Example: Math1=Ref1–Ref2). The lowest numbered Math waveform
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is considered as the source for all single jitter measurements. The results and plots are generated for a
single sequence.

If the active sources are not a differential pair, the application checks if one of the source is a clock with a
period that divides the other sources. An explicit clock recovery method derives the clock from the clock
source. The application creates explicit-clock measurements TIE, Height, TJ@BER, RJ–δδ, DJ–δδ and
Width@BER for the source. The results and plots are generated for a single sequence.

If one of the active sources is not a clock, the application selects a single source from the active sources
using the following priority:

1st- Lowest numbered Math

2nd- Lowest numbered Channel

3rd- Lowest numbered Ref

The results and plots are generated for a single sequence.

Case 4: Three sources are active

The application checks whether one of the active sources is a Math, which is defined as difference of two
sources (Example: Math1=Ref1–Ref2 ). The application selects the Math waveform as the source for all
single source jitter measurements. The results and plots are generated for a single sequence.

If one of the active sources is not a Math, the application selects a single source from the active sources
using the following priority:

1st-Lowest numbered Math

2nd-Lowest numbered Channel

3rd-Lowest numbered Ref

The application creates single source jitter measurements. The results and plots are generated for a single
sequence.

Case 5: Four or more sources are active

If four or more sources are active, the application selects a single source from the active sources using
the following priority:

1st-Lowest numbered Math

2nd-Lowest numbered Channel

3rd-Lowest numbered Ref
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The application creates single source jitter measurements for the selected source. The results and plots
are generated for a single sequence. The following figure shows the summary plot after One Touch
Jitter is performed.
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About Serial Data/Jitter Guide

The Serial Data/Jitter Guide allows you to set up, configure and run a measurement without intimate
knowledge about the control menus.

Select Analyze > Jitter and Eye Analysis (DPOJET) > Serial Data/Jitter Wizard to launch the Serial
Data/ Jitter Wizard.

The Serial Data/ Jitter Wizard includes the following steps:

Select Measurement (see page 37)

Configure Measurement (see page 38)

Select Source(s) (see page 40)

Configure Autoset Options (see page 42)

Select Plots (see page 42)

NOTE. You can exit the Serial Data/Jitter Wizard without affecting any settings in the DPOJET application
by clicking Cancel anytime before clicking the Finish button.
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Select Measurement

In this step, you can select any of the listed measurements:

Period and Frequency

Skew

Time Interval Error (TIE)

Jitter Summary includes Total Jitter (TJ@BER), RJ, DJ, PJ, DDJ, TIE, and DCD measurements and
plots

Eye Summary (see page 44) includes Height, Height@BER, Width, Width@BER, and Unit Interval
measurements and plots

By default, the Period and Frequency measurement is selected. Click Next to accept the measurement

and proceed to Configure Measurement. The transition to next step is represented by on the left
along with selections or default values.
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About Configuring Measurement

By default, the configuration parameters are displayed for Period and Frequency, TIE and Eye
measurements. The Configure Measurement option is available only for Skew and Jitter Summary. The
selection in the previous step is displayed on the left.

Configure Skew Measurement (see page 38)

Configure Jitter Summary Measurement (see page 39)

Configure Measurement-Skew

If you select Skew in the previous step, you can configure edges by selecting the From and To edges and
set the measurement limits.

Click Next to select the measurement sources.

Related Topics

Configure Edges for Skew Measurement (see page 153)
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Configure Measurement-Jitter Summary

If you select Jitter Summary measurement in the previous step, you can set the pattern length by selecting
Repeating pattern and then entering the pattern length in the text box. If you have a non-repeating
waveform pattern or if the pattern length is unknown, select Arbitrary.

NOTE. The measurements that you select also determine the plot types.

Click Next to select the measurement sources.

Related Topics

RJ/DJ Analysis Parameters (see page 223)

RJ/DJ (see page 146)
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Select Sources

In this step, you can select the measurement source(s). The source selection depends on the measurement
type. By default, Source1 is displayed automatically for all the measurements depending on the waveform
last used. If Ch1/Ref1/Math1 is displayed for Source1, Source2 is Ch2/Ref2/Math2 else Ch1/Math1/Ref1
will be selected as Source2.
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The Source2 option is displayed only for two source measurements such as Skew.

Click Next to configure autoset.
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Configure Autoset Options

In this step, you can choose to automatically adjust the oscilloscope settings or the reference levels before
the measurement. The default of Yes is recommended. By selecting No, you will retain the current
oscilloscope settings and/or ref levels.

Click Next to select plots.

Select Plots

In this step, you can select the plots that you want to display. The measurements that you selected earlier
also determine which plot types will be available in this step. The following table lists the available
plots for measurements:

Table 13: Measurements and available plots

Measurement Plots

Period and Frequency Period Trend, Period Spectrum, Period Histogram.

Skew Skew Trend, Skew Spectrum.

TIE TIE Trend, TIE Spectrum, TIE Histogram.
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Table 13: Measurements and available plots (cont.)

Measurement Plots

Jitter Summary TIE Trend, TIE Spectrum, TIE Histogram, and Bathtub
Curve.

Eye Summary (see page 44) Eye Diagram (Transition Bit), Eye Diagram (Non Transition
Bit) Unit Interval Histogram, and Eye Width@BER.

xxx

In this example, the selections shown are for a Period and Frequency measurement.
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Click Finish to start the acquisition sequence using the selected settings. The Serial Data/Jitter Guide
window closes and the results screen is displayed.

NOTE. None of the user specified settings are retained if you click Cancel before clicking Finish.

Configuring for SSC (Spread Spectrum Clocking). Spread Spectrum Clocking involves modulating the
clock frequency of a device and high-speed serial signals in a controlled manner. The purpose of using
SSC modulation is to spread the spectral energy to mitigate interference due to unintentional RF radiation.
The typical modulating frequency is 33.3 KHz.

The analysis of SSC signals requires custom settings. The required settings will vary depending on
whether you are trying to obtain eye diagrams or to observe the SSC profile versus time.

Obtain an eye diagram for an SCC signal:

1. Change the Clock Recovery method in the Configure panel to PLL-Custom BW.

2. Set the Loop BW to 1.5 MHz.

3. Set the PLL Model to Type II.

4. Set the Damping to 0.7.
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If the record length being analyzed is less than 10 μs, then the Constant Clock – Mean Clock Recovery
should be used.

5. Select Apply to All so that the clock recovery settings are applied to all measurements.

View the SSC Profile vs. Time for an SSC signal: The following instructions assume a modulating
frequency of 33 KHz. If you have an SSC of a different frequency, modify the settings as appropriate.

1. If the Clock Recovery method in the Configure panel is not Constant Clock – Mean, change it and
then select Apply to All.

2. Set an adequate record length to see multiple SSC cycles.

For example, one SSC cycle is typically 30 μs. A time scale of 40 μs/div will allow more than 10 SSC
cycles. At least 5 SSC cycles is recommended.

3. Add a Period measurement if you don’t already have one.

4. On the Configure panel, select the Period measurement and then select the Filters tab.

a. Set the Low Pass Filter Spec to 3rd Order.

b. Set the Filter Frequency (F2) to 0.5 MHz (which is sufficient to capture up to the 15th harmonic of
the modulating frequency.

5. Add a Time Trend (from the Plots panel) on the Period measurement, if one is not already selected.

This plot will show the SSC profile.

About Jitter and Eye Diagram Analysis Options

Click Analyze > Jitter and Eye Analysis (DPOJET) to view the following options:

Export Data Snapshot (see page 49)

Export Measurement Summary (see page 53)

Data Logging (see page 53)

Preferences (see page 69)

Limits (see page 76)

Global Configuration (see page 111)

Measurement Summary (see page 65)
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Deskew (see page 46)

Deskew

To ensure accurate results for two-channel measurements and differential signals acquired on two channels,
it is important to first deskew the probes and oscilloscope channels before you take measurements
of your DUT (see page 46).

The application includes an automated deskew utility that you can use to deskew any pair of oscilloscope
channels.

NOTE. To produce the best deskew results, you should connect the probes to the fastest slew rate signals
from your DUT.

Connecting to a Device Under Test (DUT)

You can use any compatible probes or cable interface to connect between your DUT and oscilloscope.

WARNING. To avoid electric shock, remove power from the DUT before attaching probes. Do not touch
exposed conductors except with the properly rated probe tips. Refer to the probe manual for proper
use. Failure to do so may cause injury or death.

Refer to the General Safety Summary in your oscilloscope manual.

Deskewing on Oscilloscopes with Bandwidth Extension

Some Tektronix oscilloscopes feature software-based bandwidth extension. The bandwidth extension
may be enabled on a per-channel basis.

Enabling or disabling bandwidth extension on any channel affects the skew on that channel. Thus, you
should deskew probes and channels after you make such configuration changes. Bandwidth Extension
provides improved timing accuracy, phase matching, and amplitude accuracy. It also will provide noise
reduction. Bandwidth extension should be used at all times.

Steps to Deskew Probes and Channels

To deskew probes and oscilloscope channels, follow these steps:

1. Refer to Connecting to a Device Under Test before starting the procedure.

2. Connect both probes to the fastest signal in your DUT.
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Set up the oscilloscope as follows:

1. Use the Horizontal Scale knob to set the oscilloscope to an acquisition rate so that there is at least two,
preferably five, samples per edge or more samples on the deskew edge.

2. Use the Vertical Scale and Position knobs to adjust the signals to fill the display without missing
any part of the signals.

3. Set the Record Length so that there are more than 100 edges in the acquisition.

4. Launch the DPOJET application.

5. Click Analyze > Jitter and Eye Analysis (DPOJET) > Deskew.

6. Set the Reference channel source to Ch1. The source waveform is the reference point used to deskew
the remaining channels.

7. Set the Channel to be Deskewed source as Ch2.

8. To start the process, click Perform Deskew.

9. Repeat steps 7 and 8 for other Ch waveforms.

10. Select Summary (see page 48) to view the deskew values.
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Deskew Summary

The Deskew Summary dialog lists the channel source and its deskew values.
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Export Data Snapshot-Statistics

You can save a snapshot of the current statistics in .csv format. The default location is
C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Logs\Statistics, where
%USERPROFILE% represents your user location.

Click Analyze > Jitter and Eye Analysis (DPOJET) > Export > Data Snapshot > Statistics to view the
following:
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Table 14: Data Snapshot- Statistics options

Item Description

Select Target Measurements Displays the measurement list. Click a row to select the
measurement. By default, all measurements are selected.

Select All Selects all the measurements in the list for saving statistics.

Clear All Deselects all the measurements from the list.

Save Statistics

Save Saves the current statistics of selected target measurements
to a log file.

File Name

Browse Allows you to choose the name and location where
the .csv file will be saved. The default name is
YYMMDD_HHMMSS_Stats.csv. The default directory
is C:\%USERPROFILE%\Tektronix\TekAppli-
cations\DPOJET\Logs, where %USERPROFILE%
represents your user location.

Close Accepts the changes and closes the window.

xxx

NOTE. The default location for saving log files can be changed in the Preferences dialog box.

Related Topics

Export Data Snapshot-Measurement (see page 50)

Export Data Snapshot-Measurement

You can save a snapshot of the data points in .csv format. The default location is
C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Logs\Measurements, where
%USERPROFILE% represents your user location.
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Click Analyze > Jitter and Eye Analysis (DPOJET) > Export > Data Snapshot > Measurement
to view the following:

Table 15: Data Snapshot- Measurement options

Item Description

Select Target Measurements Displays the measurement list. Click a row to select the
measurement. By default, all measurements are selected.

Select All Selects all the measurements in the list for saving statistics.

Clear All Deselects all the measurements from the list.

Save Measurements

Save Saves the data points for current acquisition of selected
target measurements in a log file.

Folder

Browse Allows you to choose the location where the .csv files
will be saved. The default directory is C:\%USERPRO-
FILE%\Tektronix\TekApplications\DPO-

JET\Logs\Measurements, where %USERPROFILE%
represents your user location.

File Names

View Displays View Log File Names (see page 56)
dialog box which lists the measurements and
their source(s) with corresponding log file
name in YYMMDD_HHMMSS_<Measurement

Name>-<SourceName>.csv format.

Close Accepts the changes and closes the window.

xxx
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View Log File Names

The View Log File Names dialog box lists the measurements and their source(s) with corresponding
log file name in YYMMDD_HHMMSS_<Measurement Name>-<SourceName>.csv format. Click Close
to close the dialog box.

Related Topics

Export Data Snapshot (see page 49)
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Export Measurement Summary

Click Analyze > Jitter and Eye Analysis (DPOJET) > Export > Measurement Summary to save
the generated report in C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Reports,
where %USERPROFILE% represents your user location. The exported measurement summary contains
information only about application setup and configuration.

Data Logging-Statistics

The application can continuously log (save to file) the calculated statistics. You can save the statistics to a
“comma separated value” (.csv) file to import into a text editor, a spreadsheet, or an analysis tool.

By default, all measurements are selected. You can select individual measurements by selecting the
row in the table on the left.

The steps for logging statistics are:

1. Click Analyze > Jitter and Eye Analysis (DPOJET) > Data Logging > Statistics to view the
Logging Statistics screen.

DPOJET Jitter and Eye Diagram Analysis Tools 53



Operating Basics Data Logging-Statistics

2. Select the measurements that you want to log in the Select Target Measurements table on the left.
Click Select All to select all the measurements for logging or click Clear All to deselect the current
measurements list.

3. Click On/Off to enable/disable automatic logging statistics for all selected measurements.

4. Click Browse to select a directory.

The default directory is C:\%USERPROFILE%\Tektronix\TekApplications\DPO-
JET\Logs\Statistics, where %USERPROFILE% represents your user location.

Table 16: Log-Statistics options

Item Description

Select Target Measurements Displays the measurement list. Select the check box to
select the measurement. By default, all measurements are
selected.

Select All Selects all the measurements in the list.

Clear All Deselects all the measurements in the list.

Log Statistics

Off Disables automatic logging for all selected measurements.

On Enables automatic logging for all selected measurements.

Data Log File

Browse Allows you to choose the name and location where
the .csv file will be saved. The default name is YYM-
MDD_HHMMSS_Stats.csv. The default directory is
C:\%USERPROFILE%\Tektronix\TekAppli-

cations\DPOJET\Logs\Statistics, where
%USERPROFILE% represents your user location.

xxx
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NOTE. Microsoft Excel has a limitation where you cannot increase the number of rows (65,536) or
columns (256) beyond the maximum row and column limits. Opening log files in Wordpad or another
analysis package is recommended. An error message “File not loaded completely” is displayed, if you try
to open a log file with data exceeding the aforesaid row and column limits.

Related Topics

Data Logging-Measurement (see page 55)

Data Logging-Worst Case (see page 60)

Data Logging-Measurement

You can log the actual individual measurement data values as measurement files.

1. Click Analyze > Jitter and Eye Analysis (DPOJET) > Data Logging > Measurement to view the
Logging screen.

2. Select the measurements that you want to log in the Select Target Measurements table on the left.
Click Select All to select all the measurements for logging or click Clear All to deselect the current
measurements list.

3. Click On/Off to enable/disable logging for all selected measurements.

4. Click Browse to select a directory.

The default directory is C:\%USERPROFILE%\Tektronix\TekApplications\DPO-
JET\Logs\Measurements, where %USERPROFILE% represents your user location.
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Table 17: Log-Measurements options

Item Description

Select Target Measurements Displays the measurement list. Select the check box to
select the measurement. By default, all measurements are
selected.

Select All Selects all the measurements in the list.

Clear All Deselects all the measurements from the list.

Log Measurements

Off Disables automatic logging for all selected measurements.

On Enables automatic logging for all selected measurements.

Folder

Browse Allows you to choose the name and location where
the .csv file will be saved. The default directory is
C:\%USERPROFILE%\Tektronix\TekAppli-

cations\DPOJET\Logs\Measurements, where
%USERPROFILE% represents your user location.

File Names

View Displays View Log File Names (see page 56) dialog box
which lists the selected measurements with source(s)
and their corresponding log file names in <Measurement-
Name>_<SourceName>_YYMMDD_HHMMSS.csv format.

xxx

View Log File Names

The View Log File Names dialog box lists the selected measurements with source(s) and their
corresponding log file names in <MeasurementName>_<SourceName>_YYMMDD_HHMMSS.csv
format. A tool tip is displayed as shown on hovering the mouse over the text. Click Close to close the
dialog box.
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The application displays a hint at the bottom of the screen under the following conditions:

Qualifier turned on for measurements in Global > Qualify with searches specified.
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Any sources other than search types are specified. Example Math instead of Search1.
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Related Topics

Data Logging-Statistics (see page 53)

Data Logging-Worst Case (see page 60)
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Data Logging-Worst Case

1. Click Analyze > Jitter and Eye Analysis (DPOJET) > Data Logging > Worst Case to view the
Worst Case Logging screen.

2. Select the measurements which you want to log in the Select Target Measurements table on the
left. Click Select All to select all the measurements for logging or click Clear All to deselect the
current measurements list.

3. Click On/Off to enable/disable worst case logging for all selected measurements.

4. Click Browse to select a directory.

The default directory is C:\%USERPROFILE%\Tektronix\TekApplications\DPO-
JET\Logs\Waveforms, where %USERPROFILE% represents your user location.

Table 18: Log-Worst case options

Item Description

Select Target Measurements Displays the measurement list. Select the check box to
select the measurement. By default, all measurements are
selected.

Select All Selects all the measurements in the list.

Clear All Deselects all the measurements in the list.

Log Worst Case Waveforms

Off Disables the application to save worst case waveforms for
all selected measurements.
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Table 18: Log-Worst case options (cont.)

Item Description

On Enables the application to save worst case waveforms for
all selected measurements.

Folder

Browse Allows you to choose the name and location where
the .csv file will be saved. The default directory is
C:\%USERPROFILE%\Tektronix\TekAppli-

cations\DPOJET\Logs\Waveforms, where
%USERPROFILE% represents your user location.

File Names

View Displays View Log File Names (see page 61) dialog
box which lists the selected measurements with source
(labels) and their corresponding log file names in <Mea-
surementName>_Min_<Source(label)>.wfm

and <MeasurementName>_Max_<Source(la-

bel)>.wfm † format.

xxx

† For example, if the selected measurement is Skew1 with Ch1 and Ch2 as sources, then the file names will be Skew1_Min_Ch1(DQS).wfm,
Skew1_Min_Ch2(DQ).wfm, Skew1_Max_Ch1(DQS).wfm, and Skew1_Max_Ch2(DQ).wfm.

View Log File Names

The View Log File Names dialog box lists the selected measurements with source(s) and their
corresponding log file names in <MeasurementName>_Min_<Source(label)>.wfm and

<MeasurementName>_Max_<Source(label)>.wfm format. Click Close to close the dialog box.
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The application displays a hint at the bottom of the screen under the following conditions:

Qualifier turned on for measurements in Global > Qualify with searches specified.
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Any sources other than search types are specified. Example Math instead of Search1.
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Logging Worst Case for Mask Hits Measurement

The DPOJET application supports worst case logging for the Mask Hits measurement. Whenever Mask
Hits is selected, there are two waveforms corresponding to maximum and minimum values for each
of the segment as shown in the following figure:

When an additional clock source (Clock Recovery > Explicit Clock Edge) is included for the Mask Hits
measurement, there are two waveforms corresponding to maximum and minimum values for each of
the source as shown:
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NOTE. All waveforms are displayed in the reports when worst case logging is enabled. Worst case
waveform logging is now supported for all search types. For more details on the search types, refer to
your oscilloscope online help.

Related Topics

Data Logging-Statistics (see page 53)

Data Logging-Measurement (see page 55)

Measurement Configuration Summary-Measurement

Click Analyze > Jitter and Eye Analysis (DPOJET) > Measurement Configuration Summary >
Measurement to view measurement, source and the configuration parameters of each measurement.
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Table 19: Measurement configuration information

Item Description

Measurement Displays the measurement name.

Source Displays the selected source.

Others Displays the other configuration information related to the
selected measurement.

OK Closes the window.

xxx

Related Topics

Measurement Summary-Ref Levels (see page 66)

Measurement Summary-Misc (see page 68)

Measurement Summary-Ref Levels

Click Analyze > Jitter and Eye Analysis (DPOJET) > Measurement Configuration Summary > Ref
Levels to view the ref level tab. This tab provides information about ref level configuration per source.
Displays the reference voltage levels for the high, mid, and low thresholds for the rising edge and for the
falling edge of each active source, and the hysteresis.
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Table 20: Ref level configuration information

Item Description

Source Displays the selected source.

Rise High Displays the high threshold level for the rising edge of the
source.

Rise Mid Displays the middle threshold level for the rising edge of
the source.

Rise Low Displays the low threshold level for the rising edge of the
source.

Hysteresis Displays the threshold margin to the reference level which
the voltage must cross to be recognized as changing; the
margin is the relative reference level plus or minus the
hysteresis; use to filter out spurious events.

Fall High Displays the high threshold level for the falling edge of the
source.

Fall Mid Displays the middle threshold level for the falling edge of
the source.

Fall Low Displays the low threshold level for the falling edge of the
source.

OK Closes the window.

xxx

Related Topics

Measurement Configuration Summary-Measurement (see page 65)

Measurement Summary-Misc (see page 68)
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Measurement Summary-Misc

Click Analyze > Jitter and Eye Analysis (DPOJET) > Measurement Configuration Summary > Misc
tab to view various configuration parameters. The Miscellaneous tab shows whether the Gating, Qualify,
and Stat Pop Limit functions are enabled; if enabled, it also shows the source for qualification, the size for
population, and various other configuration choices.

Table 21: Miscellaneous configuration information

Item Description

State Displays On when Gating, Qualify and Population are
enabled and Off when they are disabled.

Source Displays the selected source for qualify.

Size Specifies the maximum population that can be obtained for
each active measurement.

OK Closes the window.

xxx

Related Topics

Measurement Configuration Summary-Measurement (see page 65)

Measurement Summary-Ref Levels (see page 66)
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About Preferences Setup

The application provides Preferences Setup, where you can set options. These options remain unchanged
until you reset them. Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences to view
the Preferences screen. Preferences shortcut is available in the select panel of the DPOJET and its
modules such as DDR, PCIE, and USB. To use the application more efficiently, you can set the options
in the following tabs:

Preferences-General (see page 70)

Preferences-Measurement (see page 71)

Preferences-Path Defaults (see page 75)
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Preferences-General

Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > General to view the following:

Table 22: Preferences-General options

Item Description

View Log Displays the error/warning log file in a Notepad window
when the button is pushed.

Clear Log Clears the error/warning log file when the button is pushed.

Display Units Selects the display units for time measurements, between
seconds or Unit Intervals.

Default Image Type Selects the default image format (JPEG, PNG or BMP) that
will be used by those functions that save images.

Notifier Duration Determines how long the warning notifier will remain on
the screen before disappearing. (The notifier may also be
dismissed manually).

Cancel Discards all changes and closes the Preferences window.

OK Accepts all changes and closes Preferences window.

xxx

Related Topics

Preferences-Measurement (see page 71)

Preferences-Path Defaults (see page 75)
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Preferences-Measurement

Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > Measurement to view the
following:

The Measurement tab allows you to limit Rise and Fall measurements to transition bits only, or allow these
measurements for all bits. Here, the transition bits refer to edge transitions for which the preceding
transition was only one unit interval away. This may be important for signals with pre-emphasis, since
the transition following a string of two or more like bits has an intentionally low swing that you may
not want to measure.
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Use this tab to enable or disable high-performance eye rendering. This provides a trade-off between
greater fidelity or greater rendering speed. You can also select the Jitter Separation Model, the Dual
Dirac model, and the waveform interpolation type.

Table 23: Preferences-Measurement options

Item Description

Limit Rise/Fall measurements to transition bits
only

When selected, determines whether Rise Time and Fall Time
measurements are performed on all bits or only on transition bits.

Enable high-performance eye rendering When enabled, determines whether eye diagrams are optimized
for speed or fidelity. When disabled, all unit intervals (UI) in the
waveform(s) are included in the rendered eye. This gives the highest
fidelity eye rendering, but can take considerable amount of time for
long records. When this option is checked, a statistically representative
subset of the UI is rendered, so that eye diagrams for long waveforms
can be displayed in a shorter time. The rules for high-performance
rendering are as follows:

If the waveform contains 15,000 or fewer UI, all the UIs in the
waveform are rendered.

If the waveform includes more than 15,000 UI, it is subdivided into
segments of 2000 UI each. The entire waveform is scanned to find
the specific UI, that are the worst-case violators for six different
points around the eye. For each of these worst case violators, the
entire segment of 2000 UI in which it lies is rendered. Depending
on whether multiple worst-case violators lie in the same segment or
not, as few as 2000 UI but typically from 8000 to 12,000 UI will be
rendered in the final eye.

Halt free-run on a limit failure for any
measurement

If any of the selected measurement fails in free run, sequencing is
stopped.

Waveform Interpolation Type Select the type of interpolation that is used between sample points,
to determine the exact time when a waveform crosses a reference
voltage level. Linear interpolation is faster but introduces distortion that
raises the jitter noise floor slightly. Sin(x)/x Interpolation, also known
as Sinc Interpolation, approaches theoretically perfect waveform
reconstruction but is computationally expensive.

NOTE. For Eye-High, Eye-Low, and Eye-Height measurements,
Sin(x)/x interpolation is always used for eye measurements
independent of the chosen interpolation type.

Cancel Discards the changes and closes the window.

OK Accepts the changes and closes the window.

xxx

Related Topics

Preferences-General (see page 70)

Preferences-Jitter Decomp (see page 73)

Preferences-Path Defaults (see page 75)
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Preferences-Jitter Decomp

Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > Jitter Decomp to view the
following:

The Jitter Decomp tab allows you to select the Dual Dirac model and the Jitter Separation model, and to
select the minimum number of unit intervals required for BUJ analysis.
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Table 24: Preferences-Jitter Decomp options

Item Description

Dual Dirac Model Determines which parameter-extraction method is used when RJ/DJ
separation is done under the Dual-Dirac model. This affects results for
the RJ–δδ and DJ–δδ measurements only. When Fibre Channel is
selected, RJ and DJ parameters are extracted according to guidelines
given in ANSI/INCITS Technical Report TR-35-2004 “Methodologies
for Jitter and Signal Quality Specification”. RJ and DJ values are
selected that cause an exact match between the bathtub curves from
the dual-dirac and the full analytical models at two prescribed BER
levels. When PCI/FB-DIMM is selected, RJ and DJ parameters are
determined using the methodology defined in the PCI Express Gen 2
and Fully-Buffered DIMM specifications. In this technique, the bathtub
curves are plotted on a Q-scale that linearizes the tails of the bathtub,
and the RJ and DJ values are derived from where the asymptotes to
the curves intersect the BER=0 line.

Jitter Separation Model Selects the type of jitter separation, Spectral Only or Spectral + BUJ.
Spectral Only identifies almost all categories of jitter, including Bounded
Uncorrelated Jitter (BUJ) that is periodic (PJ). However, it cannot
separate bounded random jitter from Gaussian random jitter. Spectral+
BUJ includes additional processing to identify bounded random jitter
(also called Non-Periodic Jitter or NPJ). NPJ is typically caused by
crosstalk from a signal on a different clock domain, and generally
requires a higher population of measurements for proper detection.

Minimum # of UI for BUJ Analysis Determines the number of unit intervals (UI) that must be processed
before jitter separation is performed. This item is only used for Spectral
+ BUJ processing, and is not shown if the Jitter Separation Model is
Spectral Only. A higher number of UI will allow the separation algorithm
to detect lower levels of NPJ, but will typically require longer record
length, more acquisitions, or both. A lower number of UI will allow
processing to occur on smaller populations of UI, but may only identify
stronger forms of NPJ. Also, note that the number of UI processed
for BUJ analysis is only 17% to 33% of the total UI acquired in each
waveform.

Cancel Discards the changes and closes the window.

OK Accepts the changes and closes the window.

xxx

Related Topics

Preferences-General (see page 70)

Preferences-Measurement (see page 71)

Preferences-Path Defaults (see page 75)
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Preferences-Path defaults

Click Analyze > Jitter and Eye Analysis (DPOJET) > Preferences > Path Defaults to view the
following:

The Path Defaults allows you to set the path for images, reports and log files. Click Browse to modify the
default directory path.

Table 25: Preferences-Path defaults options

Item Description

Default image export directory Selects the directory to which images will be saved, unless
overridden at the time of the export.

Default logging export directory Selects the directory to which logs will be saved, unless
overridden at the time of the export.

Default report export directory Selects the directory to which reports will be saved, unless
overridden at the time of the export.

Cancel Discards the changes and closes the window.

OK Accepts the changes and closes the window.

xxx

Related Topics

Preferences-General (see page 70)

Preferences-Measurement (see page 71)

Preferences-Jitter Decomp (see page 73)
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Limits

Limits file allows you to determine Pass or Fail status for tests. Each serial data application provides limits
file that includes combinations of all measurements and statistical characteristics, and an appropriate
range of values for each combination.

The application does not provide any limits file. You can create one by specifying limits for any of
the result parameters such as Mean, Std Dev, Max, Min, peak-to-peak, population, MaxPosDelta and
MinPosDelta. For each of these result parameters, you can specify Upper Limit (UL), Lower Limit (LL),
or Both. The measurement names in the limits file must be entered as mentioned in
Setting Up the Application for Analysis (see page 19).

NOTE. The limits file supports only absolute values.

To include Pass/Fail status in the result statistics, you can create a limits file using an XML editor or any
other editor in the following format. If the file is created in any other editor such as notepad, it should
be saved in Unicode format.

<?xml version="1.0" encoding="utf-16" ?>

<Main>

<Measurement>

<NAME>Period</NAME>

<STATS>

<STATS_NAME>Mean</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>1</UL>

<LL>0</LL>

</STATS>

<STATS>

<STATS_NAME>StdDev</STATS_NAME>

<LIMIT>LL</LIMIT>

<UL>1121</UL>

<LL>0121</LL>

</STATS>

<STATS>

<STATS_NAME>Max</STATS_NAME>

<LIMIT>BOTH</LIMIT>

<UL>1</UL>

<LL>0</LL>

</STATS>

<STATS>

<STATS_NAME>Min</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>1</LL>

</STATS>
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<STATS>

<STATS_NAME>PeakToPeak</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>1</UL>

<LL>1</LL>

</STATS>

<STATS>

<STATS_NAME>MaxPosDelta</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>1121</UL>

<LL>1121</LL>

</STATS>

<STATS>

<STATS_NAME>MinNegDelta</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>0</LL>

</STATS>

<STATS>

<STATS_NAME>Population</STATS_NAME>

<LIMIT>UL</LIMIT>

<UL>0</UL>

<LL>0</LL>

</STATS>

</Measurement>

</Main>

Table 26: Limits options

Item Description

Pass/Fail Test

Off/On Enables (On) or Disables (Off) the display of limit information
in results. Select On to choose a limits file for the selected
measurement.

Limits File
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Table 26: Limits options (cont.)

Item Description

Browse To select an existing limits file or locate the directory.

Close Accepts the changes and closes the window.

xxx

Limits for Mask Hits

Limits are available for Mask Hits. The applications displays the following in the results panel when limits
are turned on (Analyze > Jitter and Eye Analysis (DPOJET) > Limits):

If there is a hit in any of the segments, the result is FAIL as shown:

About Taking a New Measurement

If you want to change the trigger settings or localize the measurements, you should do so before you
take any measurements.
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NOTE. When you run any measurement, Sampling mode in the oscilloscope should be set to “Real Time”.
You need to do this setting in the oscilloscope to take DPOJET measurements.

Selecting a Measurement

To take a measurement, click Analyze > Jitter And Eye Analysis > Select.

Alternatively, to take a PCI Express measurement, click Analyze > PCI Express and for USB 3.0
Essentials measurement, click Analyze > USB 3.0 Essentials.

NOTE. A shortcut to Preferences is provided to set various application settings.

The application provides you different methods to set up the application:

Wizard (see page 80)

Measurement Setup sequence (see page 81)

The measurement categories are Period/Freq, Jitter, Time, Eye, Amplitude, and Standard as shown in the
following table:

Table 27: Measurement selections

Category Measurements

Period Pos Width Neg Width Freq

N–Period +Duty Cycle –Duty Cycle

Period/Freq

CC–Period +CC–Duty –CC–Duty

TIE RJ RJ–δδ Jitter Summary

TJ@BER DJ DJ–δδ

Jitter

PJ DDJ DCD Phase Noise

DPOJET Jitter and Eye Diagram Analysis Tools 79



Operating Basics Selecting a Measurement

Table 27: Measurement selections (cont.)

Category Measurements

Rise Time Fall Time Skew * SSC Profile

High Time Low Time Setup * SSC Mod Rate

Rise Slew Rate Fall Slew Rate Hold * SSC Freq Dev

Time

SSC Freq Dev Min SSC Freq Dev Max Time Outside Level tCMD-CMD ‡ §

Width Width@BER Q-Factor Mask HitsEye

Height Height@BER High Low

High DC Common Mode * Overshoot Cycle Min

Low T/nT-Ratio Undershoot Cycle Max

Ampl

High–Low V–Diff –Xovr * Cycle Pk-Pk AC Common Mode *

DDR

DDR Setup-SE * DDR Hold-Diff * DDR tCK(avg) DDR tJIT(duty)

DDR Setup-Diff * DDR tCL(avg) DDR tERR(n) DDR tJIT(per)

DDR Hold-SE * DDR t CH(avg) DDR tERR(m–n) DDR tRPRE

DDR tWPRE DDR tPST DDR Over Area DDR Under Area

DDR tDQSS * ‡ § DDR VID(ac) DDR2 tDQSCK DDR3 Vix(ac)

GDDR5 tCKSRE ‡ § GDDR5 tCKSRX ‡ § GDDR5 tBurst-
CMD ‡ §

PCI Express

PCIe T-Tx-Diff-PP PCIe T-TX PCIe T-Tx-Fall PCIe Tmin-Pulse

PCIe DeEmph PCIe T-Tx-Rise PCIe UI MAX-MIN Ratio

PCIe Med-Mx-Jitter PCIe T-RF-Mismch PCIe SSC FREQ PCIe SSC PROFILE

PCIe AC Common
Mode *

USB 3.0 Essentials

VTx-Diff-PP Tmin-Pulse-Tj USB Tmin-Pulse-Dj USB SSC MOD
RATE

TCdr-Slew-Max † USB SSC FREQ
DEV-MAX

USB SSC FREQ
DEV MIN

Standard

USB SSC PROFILE USB UI USB AC Common
Mode *

xxx

* Two Source Measurements.

† To run a slew rate measurement, you need a waveform with minimum record length of 5 MB.

‡ Bus source is required.

§ This measurement is available only on 64-bit MSO instruments.

Wizard

The Serial Data/ Jitter Guide allows you to set up, configure, and run the selected set of measurements
without requiring any knowledge of the control menus. However, it does not provide access to
many of the advanced features.
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Measurement Setup Sequence

The Measurement Setup Sequence buttons in the left navigation panel shows the logical order you
would follow to set up the application if you do not use the Wizard.

Warning Log Notifiers

Warning Log Notifiers display error messages or warnings. Warnings ( ) or Error ( ) messages are
also shown in the results tab. You can click View Log to view the error log information in a text editor.
Click OK to discard the displayed error message.

You can set the duration for which the warning notification should appear on the screen in the Preferences
(see page 69) dialog box or click OK to discard the warning information.

NOTE. The error or warning log is saved as DPOJETErrors.log in C:\%USERPROFILE%\Tek-
tronix\TekApplications\DPOJET subfolder, where %USERPROFILE% represents your user
location.
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Navigation Panel

The Navigation Panel appears on the left of the application window. It consists of the following tabs:
Select, Configure, Results, Plots and Reports.

Table 28: Navigation panel functions

Tab Description

Select Displays the various measurements available for selection.
By default, this tab is highlighted. You can click any
measurement categorized with Period/Freq, Jitter, Time,
Eye and Amplitude tabs.

Configure Displays the configuration for the selected measurement.

Results Displays the result for the selected measurement.

Plots Displays the result as a two-dimensional plot for additional
measurement analysis. You can select and configure plots
for selected measurements.

Reports Displays the configuration for generating reports in .mht
format. Allows you to select results, plots and details.

xxx

Control Panel

The Control Panel appears on the right of the application window. Using this panel, you can start or stop the
sequence of processes for the application and the oscilloscope to acquire information from the waveform.
The controls are Clear, Recalc, Single and Run. The following table describes each of these controls:
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Table 29: Control panel selections

Item Description

Clear Clears the current result display and resets any statistical
results and autoset ref levels.

Recalc Runs the selected measurements on the current acquisition.

Single Initiates a new acquisition and runs the selected
measurements.

Run Initiates a new acquisition and runs the selected
measurements repeatedly until Stop is clicked. Used only
for live sources.

Show Plots Displays the plot summary window when clicked. This
button appears in the control panel only when a plot is
selected.

DDR Analysis Shortcut to access the DDRA application from DPOJET.
Appears in the control panel only when DDRA is opened
using Analyze > DDR Analysis.

xxx

The control panel with Show Plots is as shown:
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Sources Setup

The application takes measurements from waveforms specified as input sources. You can select an
oscilloscope channel input (live), a reference or a math waveform as the source and also view labels of the
selected waveforms. Some measurements require a bus as a source. Bus as a Source (see page 85)

You can configure sources using any of the following options:

Click icon in the table which lists the selected measurements.

Double-click anywhere on a row in the table that lists the selected measurements.

The source selections depend on the selected measurement.

NOTE. Setup, Hold, V–DIff–Xovr, DC Common Mode and Skew are two source measurements. The
Source2 option is displayed only for two source measurements.

When more than one single source measurement is selected, Apply to all single source measurements
option is enabled in the source configuration screen.
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When more than one two source measurement is selected, Apply to all two source measurements
option is enabled in the source configuration screen.

NOTE. Although any DPOJET measurement can be assigned a custom name (Example: tDQSH), the
custom name is not displayed in the DPOJET source configuration screen. Instead, the default name
for the corresponding measurement is displayed.

Related Topics

Source Autoset (see page 94)

Ref Levels (see page 96)

Bus as a Source

Bus as a Source

On MSO model oscilloscopes only, some measurements (tCMD-CMD, GDDR5 tCKSRE, GDDR5
tCKSRX, and GDDR5 tBurst-CMD ) require a bus as a source. Set up the bus using the Bus Setup window
of TekScope, and set up the source using the Source Configurations window of DPOJET. If you try to
select a measurement that requires a bus, but no bus is configured, a pop up asks you to set up a bus.
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Clicking Bus Setup displays the Bus Setup window where you can configure a bus.

You can select sources using the Source configuration window. The selected bus is displayed and you can
apply both the bus and analog source settings to all similar measurements. If the measurement requires one
bus source and one clock source, the following Source Configuration window is displayed.
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If the measurement has only one bus source, and Source Autoset and Ref Level Autoset are not required,
then the following Source Configuration window is displayed.
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Related Topic

Sources Setup (see page 84)

Digital as a source

DPOJET supports the following measurement on Digital channels. Digital source measurements are
available only on MSO5000/70000 series of instruments running with 64-bit Windows 7 OS.

Table 30:

Period/Frequency
measurements Time measurements

Period Skew

Positive Width Setup

Negative Width Hold

Frequency

+Duty Cycle

-Duty Cycle

CC-Period

+CC-Duty

-CC-Duty

xxx

Digital source selection

You can select any of the Digital channels (D0 – D15) from the digital tab as shown below.

Left and Right arrows will display the previous and next set of digital channels as shown below:
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xxx

Digital sources do not have Source Autoset available. Also, digital sources are not used for performing
Ref Level Autoset.

Configurations and features

All the configurations and the features that are supported for analog sources are supported for digital
sources as well.
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Related Topic

Sources Setup (see page 84)

Custom Source Name

Any oscilloscope source (Channel, Math, or Reference) can have a custom label which is created or
changed using the main oscilloscope interface:

Channels: Vertical > Label

Maths: Math > Setup

References: File > Reference Waveform Controls

If a source has been assigned a custom label, both the native name and custom name are shown on the
Source Config panel. When sources with custom labels appear in the measurement lists (for example, on
the Select or Config panels of DPOJET), only the custom label is shown. To see the native name, move
the mouse over the row in the measurement table; a tool tip displays the native name. In these cases, the
custom label is shown, followed by the native name in parenthesis, for example DQS (Ch1).

The custom source names (DQ and DQS) appear in the following screens:

Measurement table

Source Configuration

90 DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics Custom Source Name

Results
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Plots

Data Snapshot

92 DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics Custom Source Name

Data Logging

Measurement Summary
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Export Results to Ref

Source Autoset

The Source Autoset allows you to automatically adjust the oscilloscope's vertical and/or horizontal settings
for live sources (Ch1-Ch4) to improve measurement accuracy.

The Vertical Scale option automatically checks the peak-to-peak level of live sources. The vertical scale
and offset of all signals with a peak-to-peak value less than six divisions are adjusted so the peak-to-peak
will be eight divisions. If the maximum or minimum value of a signal is “clipped”, the vertical scale and
offset are adjusted so that the peak-to-peak value will be eight divisions.

The Horizontal Resolution option checks the Rise Time/Resolution and Fall Time/Resolution of all
live channels. The instrument horizontal resolution is set to the largest value that does not cause the
samples-per-edge of the fastest edge to fall below five samples per edge. The option sets the acquisition
sampling mode to Real Time for signals with very high edge speeds. Horizontal Autoset, by default, tries
to set the record length corresponding to 10000 UI for any given waveform at highest possible sample rate.
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To automatically define both the vertical and horizontal settings for all channel sources, select the Vert
and Horiz button. The Vert and Horiz option also applies an oscilloscope autoset on each channel before
performing the vertical scale and horizontal resolution autoset.

Follow these steps to automatically define the vertical or horizontal settings for active sources:

1. Ensure that any channel waveform that you want to autoset is visible on the oscilloscope.

2. Select one of the following options:

Vert & Horiz to autoset both vertical and horizontal setting.

Vert Scale button to autoset oscilloscope vertical settings only.

Horiz Res to autoset oscilloscope horizontal settings only.

3. Select Undo to return the oscilloscope to its state before autoset.

Table 31: Autoset configuration options

Item Description

Vertical Scale If a channel waveform is clipped or does not exceed six
vertical divisions, adjust the scale so that the waveform
occupies about eight divisions.

Horiz Res Sets the horizontal resolution so that the number of samples
on the fastest transition (edge) exceeds a specified target.

Vert & Horiz Performs a sequence: Oscilloscope Autoset, Vertical scale
and Horizontal resolution.

Undo Returns to the settings present before an Autoset was
performed; disabled after measurements are taken until you
perform another source autoset.

Ref Levels Setup Click Ref Levels Setup in the Source Configuration screen
to hide/unhide the Ref Levels Setup.

xxx
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Ref Levels

Timing measurements are based on state transition times. By definition, edges occur when a waveform
crosses specified reference voltage levels. Reference voltage levels must be set so that the application
can identify state transitions on a waveform. By default, the application automatically chooses reference
voltage levels when necessary.

The DPOJET application uses three basic reference levels: High, Mid and Low. In addition, a hysteresis
value defines a voltage band that prevents a noisy waveform from producing spurious edges. The reference
levels and hysteresis are independently set for each source waveform, and are specified separately for
rising versus falling transitions. There are two ways to set the reference voltage levels: automatic (see
page 98) and manual (see page 99).
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High, Mid, and Low Reference Voltage Levels

The application uses three reference voltage levels: High, Mid, and Low:

For most measurements, the application only uses the Mid reference voltage level. The Mid reference
level defines when the waveform state transition occurs at a given threshold.

For Rise Time and Fall Time measurements, the High and Low reference voltage levels define when
the waveform is fully high or fully low.

Rising Versus Falling Thresholds

You can specify thresholds for each of the reference voltage levels: High, Mid, and Low. The application
uses the thresholds to determine the following events:

A Low/Mid/High rising event, which occurs when the waveform passes through the corresponding
Rise threshold in the positive direction.

A Low/Mid/High falling event, which occurs when the waveform passes through the corresponding
Fall threshold in the negative direction.

For a given logical reference level (such as Low, Mid, or High), rising and falling events alternate as
time progresses.

NOTE. In many cases, the rising and falling thresholds for a given reference voltage level are set to the
same value. In those cases, a hysteresis value helps prevent spurious edges produced by small amounts of
noise in a waveform.

Using the Hysteresis Option

The hysteresis option can prevent small amounts of noise in a waveform from producing multiple threshold
crossings. You can use a hysteresis when the rising and falling thresholds for a given reference voltage
level are set to the same value.

The reference voltage level ± the hysteresis value defines a voltage range that must be fully crossed by
the waveform for an edge event to occur. If the decision threshold is crossed more than once before the
waveform exits the hysteresis band, the mean value of the first and last crossing are used as the edge
event time.
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For example, if the waveform rises through the Threshold – Hysteresis, then rises through the Threshold,
then falls through the Threshold, then rises through both the Threshold and the Threshold + Hysteresis, a
single edge event occurs at the mean value of the two rising crossings.

Example of Hysteresis on a Noisy Waveform

Automatic Versus Manual Reference Voltage Levels

Each measurement source can be configured to automatically choose voltage reference levels (default), or
to use specific absolute reference voltages. In the automatic configuration, levels are chosen according to
percentages of the overall signal amplitude.

In the Ref Levels Setup panel, a table at the left edge contains all of the current active measurement sources.
If a source is configured for Percentages, appropriate reference levels will be chosen, when necessary
(typically when you press the Single or Run button). Select Autoset at the right edge of the Source
Configuration menu to force autoset to occur and to learn which absolute voltage will be used. For each
level, the absolute voltage will be shown directly under the corresponding control. If Autoset has not been
selected recently, the values will be shown as TBD; the last-used voltages will be displayed for reference.

Normally, the reference levels used for rising and falling edges are identical for a given threshold (High,
Mid or Low). Some special cases demand different thresholds for rising edges than for falling edges.
In those cases, select the Advanced check box to allow separate configuration based on polarity. The
Advanced view also allows you to adjust the Hysteresis value or choose the Base-Top method.

For more details, refer to Understanding When Ref Level Autoset will Occur (see page 99) and
Understanding How Ref Level Autoset Chooses Voltages (see page 99).
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Table 32: Configure sources ref levels autoset configuration

Item Description

Autoset * Calculates and displays the reference voltage levels for
all sources where the autoset option is set according to
the Autoset Ref Level Setup.

Base top method Specifies the Base-Top method to be used for all reference
voltage levels when autoset occurs.

xxx

* If you do not perform Autoset using the Autoset button, the application updates the reference levels (if required) when you select Single or Run
to take measurements.

Understanding When Ref Level Autoset will Occur

When Autoset is enabled for a given source, the individual reference levels are displayed but you may
not manually adjust them. Instead, the reference levels are automatically recalculated whenever one of
the following events occur:

A measurement sequence is initiated for the first time after a source has become active.

A measurement sequence is initiated for the first time after all results have been cleared.

The Autoset button at the right edge of the panel is pressed.

The Autoset button is provided as a convenience, but it is never required. Autoset will always be run (if
enabled) before an uninitialized source is used for a measurement.

Understanding How Ref Level Autoset Chooses Voltages

Once triggered, the Reference Level Autoset function uses the following logic to determine actual voltage
levels.

For each applicable source, the Top (high logic level) and Base (low logic level) are first determined. Then,
the High, Mid and Low levels are calculated as percentages of the Top-Base difference. For example,
if the Top and Base are 2.8 volts and 0.4 volts respectively and the High percentage level is 90%, this
threshold would be calculated as:

HighThres= Base+ High Percent (Top-Base)= 0.4+0.9 (2.8–0.4)= 2.56

Manually Adjusting the Reference Voltage Levels

Whether or not you use the application to automatically calculate the initial reference voltage levels, you
may need to manually change the values. To set the reference levels manually, follow these steps:

1. Click icon in the table which lists the selected measurements to view the source configuration
screen.

2. Select the desired source from the Source list.

NOTE. You cannot select inactive sources.
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3. Select the Absolute button.

4. Select the reference levels or hysteresis options and manually adjust the values. The values will not
change when you select Autoset or take measurements.

NOTE. A source will become inactive if all measurements on that source are removed. If a new
measurement is then added on that source, the source once again becomes active, and defaults to Autoset.
If you clear all measurement on a source that was set to Manual, you must reselect the Manual state (if
desired) when the source is again added.

Click Percentage to set the reference levels in percentages.

Click Absolute to set the reference levels manually to specific voltages.

Click Percentage to set the reference levels in percentages with advanced not checked.
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Click Absolute to set the reference levels manually to specific voltages with advanced not checked.

Table 33: Configure sources ref levels configuration

Item Description

Autoset * Calculates and displays the reference voltage levels for all
sources where the autoset option is set according to the
Autoset Ref Level Setup.

Base top method Specifies the Base-Top method to be used for all reference
voltage levels when autoset occurs.

Advanced Allows you to set the Rise and Fall reference levels
independently.

Absolute Allows manually setting the reference levels.

Percentage Allows setting the reference levels as a percentage.

20% – 80% Sets the low threshold level to 20%, the mid threshold level
to 50%, and the high threshold level to 80%.
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Table 33: Configure sources ref levels configuration (cont.)

Item Description

10% – 90% Sets the low threshold level to 10%, the mid threshold level
to 50%, and the high threshold level to 90%.

Ref Levels Setup (one level per source) †

Rise High Sets the high threshold level for the rising edge of the
source.

Rise Mid Sets the middle threshold level for the rising edge of the
source.

Rise Low Sets the low threshold level for the rising edge of the source.

Fall High Sets the high threshold level for the falling edge of the
source.

Fall Mid Sets the middle threshold level for the falling edge of the
source.

Fall Low Sets the low threshold level for the falling edge of the
source.

Hysteresis Sets the threshold margin to the reference level which
the voltage must cross to be recognized as changing; the
margin is the relative reference level plus or minus half the
hysteresis; use to filter out spurious events.

Close Accepts the changes and closes the window.

xxx

* If you do not update ref levels by clicking Autoset, the application updates the reference levels (if required) when you select the Single or Run
to take measurements.

† Default settings are 90% (High), 50% (Mid), 10% (Low), and 3% (Hysteresis).

Base Top Method

Click Base top method in the Ref Level Setup screen to select a method used for calculating Top and
Base of the waveform.

When the reference levels are set to Autoset, which is the default, the following steps are used during
an autoset:

Base and Top of the waveform are calculated

High, Mid and Low reference voltages are determined as percentages of the (Top - Base) difference

There are four methods to calculate the Base and Top of the waveform:

Min - Max

Low - High Histogram (Full Waveform)

Low - High Histogram (Center of Eye)

Auto
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Table 34: Autoset ref level configuration

Item Description

Base Top Method

Min-Max Uses the minimum and maximum values in the waveform
to determine the base and top amplitude. Useful on a
waveform with low noise and free from excessive overshoot.

Low-High Histogram (Full Waveform) Uses a histogram approach to determine the base top
amplitude. Creates a histogram of the amplitudes of the
entire waveform; the histogram should have a peak at the
nominal high level, and another peak at the nominal low
level.

Low-High Histogram (Center of Eye) Uses a histogram approach to determine the base top
amplitude. Creates a histogram of the amplitudes in the
center of each bit (unit interval) while ignoring the waveform
during bit transitions. The histogram should have a peak
at the nominal high level and another peak at the nominal
low level.

Auto Automatically determines the best Base Top method to use.

OK Accepts the changes and closes the window.

xxx

* Default settings are 90% (High), 50% (Mid), 10% (Low), and 3% (Hysteresis).

Min - Max

The figure shows a typical data waveform with a vertical histogram turned on. If base-top method
Min-Max is selected, the voltages indicated by the red lines is used for the base and top since these are
the absolute min and max points in the entire waveform. If there isn't too much overshoot in a waveform
this is a good base top method.
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Low - High Histogram (Full Waveform)

If base-top method Low - High Histogram (Full Waveform) is selected, the oscilloscope performs two
histogram measurements: one on the top half of the waveform and another on the lower half of the
waveform. The upper and lower blue lines in the figure show the modes of the upper and lower histogram,
respectively. The mode of a histogram is the value that appears most frequently; visually, it is the peak of
the histogram. It does a good job of picking out the high and low logic levels to which the waveform settles.

Low - High Histogram (Center of Eye)

If base-top method Low - High Histogram (Center of Eye) is selected, the waveform is assumed to be a
serial data signal and DPOJET performs clock recovery on the waveform. Then, the point at the center of
each unit interval is taken. These samples are sorted into low bits and high bits. One histogram is formed
on the low samples, and another on the high samples. The Base and Top are the modes of these histograms.
This is similar to the Histogram Mode method Low - High Histogram (Full Waveform), except it is less
influenced by the shape of the waveform during transitions between bits.

Auto

Base-top method Auto is the default. In Auto, method Low - High Histogram (Full Waveform) is tried
first. But sometimes that method gives ambiguous results because there's no clear point to choose on the
histogram. If that occurs, DPOJET switches to method Min-Max.

About Configuring a Measurement

You can configure the measurements listed under the following categories:

Period/Freq

Jitter

Time

Eye

Amplitude

Standard

NOTE. Configure tabs are displayed only when you select a measurement.
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The following tables list the configure tabs displayed for each measurement.

Table 35: Period/Freq measurements

UI Name Measurements Edges
Bit
Config

Clock
Recov-
ery RJDJ Filters

Gen-
eral Global

Clock PeriodPeriod

Data Period

Clock
Frequency

Freq

Data Frequency

Pos
Width

Pos Width

Neg
Width

Neg Width

N–Pe-
riod

N–Period

+Duty
Cycle

+Duty Cycle

-Duty
Cycle

-Duty Cycle

CC-Pe-
riod

CC-Period

+CC-
Duty

+CC-Duty

-CC-
Duty

-CC-Duty

xxx

Table 36: Jitter measurements

UI Name Measurements
Bit
Config Edges

Clock
Recov-
ery RJDJ Filters General Global

Clock TIETIE

Data TIE

Clock TJTJ@
BER Data TJ

Clock DCDDCD

Data DCD

Clock RJRJ

Data RJ

Clock DJDJ

Data DJ

DPOJET Jitter and Eye Diagram Analysis Tools 105



Operating Basics About Configuring a Measurement

Table 36: Jitter measurements (cont.)

UI Name Measurements
Bit
Config Edges

Clock
Recov-
ery RJDJ Filters General Global

DDJ DDJ

Clock RJ–δδRJ–δδ

Data RJ–δδ

Clock DJ–δδDJ–δδ

Data DJ–δδ

Clock PJPJ

Data PJ

Jitter
Sum-
mary 1

Phase
Noise

xxx

1 Jitter Summary is not an individual measurement but a convenience function. Pressing this button automatically adds a set of eleven
jitter-related measurements with a single action. The measurements are: TIE, RJ, RJ–δδ, DJ, DJ–δδ, PJ, DDJ, DCD, TJ@BER, and
Width@BER.
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Table 37: Timing measurements

Measure-
ments SSC

Bus
State Edges

Clock
Recov-
ery RJDJ Filters General Global

Rise Time

Fall Time

Skew

High Time

Low Time

Setup

Rise Slew
Rate

Fall Slew Rate

Hold

SSC Profile

SSC Mod Rate

SSC Freq Dev

SSC Freq Dev
Min

SSC Freq Dev
Max

Time Outside
Level

tCMD-CMD

xxx

Table 38: Eye measurements

Measure-
ments

Bit
Config Edges

Clock
Recov-
ery BER RJDJ Filters General Global

Width

Width@BER

Height

Height@BER

Mask Hits

Eye High

Eye Low

Q-Factor

xxx
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Table 39: Amplitude measurements

Measurements
Bit
Config Edges

Clock
Recov-
ery RJDJ Filters General Global

High

DC Common
Mode

AC Common
Mode

Low

T/nT Ratio

High–Low

V–Diff–Xovr

Overshoot

Undershoot

Cycle Pk-Pk

Cycle Min

Cycle Max

xxx

Table 40: Standard-specific measurements

Measure-
ments

Bus
State

Bit
Config Edges

Clock
Recov-
ery BER Filters General Global

DDR

DDR
Setup-SE

DDR Setup-
Diff

DDR Hold-SE

DDR Hold-Diff

DDR tCK(avg)

DDR tCH(avg)

DDR tCL(avg)

DDR tERR(n)

DDR
tERR(m-n)

DDR tJIT(duty)

DDR tJIT(per)

DDR tRPRE

DDR tWPRE
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Table 40: Standard-specific measurements (cont.)

Measure-
ments

Bus
State

Bit
Config Edges

Clock
Recov-
ery BER Filters General Global

DDR tPST

DDR Over
Area

DDR Under
Area

DDR tDQSS

DDR VID(ac)

GDDR5
tBurst-CMD

GDDR5
tCKSRE

GDDR5
tCKSRX

DDR2
tDQSCK

PCI Express

PCIe Med-Mx-
Jitter

PCIe T-RF-
Mismch

PCIe MAX-
MIN Ratio ‡

PCIe SSC
FREQ DEV

PCIe SSC
PROFILE

PCIe T-Tx-
Diff-PP

PCIe T-TX

PCIe T-Tx-Fall

PCIe Tmin-
Pulse

PCIe DeEmph

PCIe T-Tx-
Rise

PCIe UI

PCIe AC
Common
Mode

T-TX-DJ
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Table 40: Standard-specific measurements (cont.)

Measure-
ments

Bus
State

Bit
Config Edges

Clock
Recov-
ery BER Filters General Global

T-TX-UTJ

T-TX-UDJDD

T-TX-UPW-TJ

T-TX-
UPWDJDD

V-TX-NO-EQ

V-TX- EIEOS

ps21TX

USB 3.0 Essentials

USB VTx-
Diff-PP

USB TCdr-
Slew-Max

USB Tmin-
Pulse-Tj

USB Tmin-
Pulse-Dj

USB SSC
MOD RATE

USB SSC
FREQ-DEV
MAX

USB SSC
FREQ DEV-
MIN

USB SSC
PROFILE

USB UI

USB AC
Common
Mode

xxx

‡ Custom name for PCIe MAX-MIN Ratio is PCIe VRX-MAX-MIN Ratio.

Related Topics

Global (see page 111)

General (see page 118)

Filters (see page 119)

Clock Recovery (see page 124)
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Bit Config (see page 140)

RJDJ (see page 146)

Configuring Bus States (see page 149)

Edges (see page 151)

Spread Spectrum Clocking (SSC) (see page 167)

About Global

This configuration tab is common for all measurements. You can limit the waveform data analysis by
Gating, by applying a Qualifier, or by setting the measurement population limits. Access the Global
configuration directly from the oscilloscope menu under Analyze > Jitter and Eye Analysis (DPOJET) >
Global Configuration..

Gating

Gating allows you to focus the analysis on a specific area of the waveform bounded by a gated region,
which is a way to filter unnecessary information.
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You can set up a gated region in one of the following ways:

Zoom

Cursors

Selecting Marks changes the window by adding a gating Configure button.

Table 41: Global-Gating options

Item Description

Off No gating occurs; application takes measurements over
the entire waveform.

Zoom Zooms the specified region of the source waveform to take
measurements within the selected area. The region of
waveform within the zoom is analyzed.

Cursors Gates the waveform with Vertical cursors. The region of
waveform within the cursors is analyzed.

Marks Marks are enabled only for 64-bit machines. Gates the
waveform with marks. The region of the waveform within
the marks (a burst) is analyzed.

xxx
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Qualify

Qualifiers allows you to limit the application to more narrowly defined conditions before taking
measurements. All sources for the measurements and Qualify input must have the same Horizontal Sample
Rate, Record Length, and Position to ensure that measurements function properly. For measurements
which require clock recovery such as TIE or eye measurements, only the first qualified region will be
measured even if multiple qualified regions are present. For all other measurements, the entire waveform
is processed.

Table 42: Global-Qualify options

Item Description

Off Disables the application from using the defined conditions
while taking measurements.

On Enables the application to use the defined conditions while
taking measurements.

Configure Displays the Qualify with Logic (see page 114) dialog box.

xxx
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Configuring Qualify with Logic
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Table 43: Qualify-Configure options

Item Description

Source * Selects a waveform to qualify the signal or clock source
used for the measurement. The input source waveforms or
files are Ch, Ref, Math and Search (see page 115). Displays
the burst control type selected in DDRA when you turn on
the qualifier. Also indicates that ASM is turned on.

Mid Shows the vertical reference level of the qualifier waveform. ‡

Hysteresis Shows the amount of hysteresis applied to the vertical
reference level of the qualifier waveform. Hysteresis
prevents small amounts of noise in a waveform from
producing multiple threshold crossings.

Active

High † Enables measurements in regions † where the qualifier
waveform exceeds the mid reference level.

Low † Enables measurements in regions † where the qualifier
waveform falls below the mid reference level.

OK Accepts the changes and closes the window.

xxx

* Measurement and Qualify sources must have the same Horizontal Sample Rate, Record Length, and Position to ensure that measurements
function properly.

† For measurements that require clock recovery, only the first qualified region will be measured even if multiple qualified regions are present.
‡ The default behavior for all reference levels is to automatically adjust based on the signal amplitude after a Clear operation, unless you disable

the autoset check box in the source configuration panel. Whether you use the Qualify with Logic dialog box to adjust the levels or not, be
aware that the levels may change if automatic adjustment is still enabled. For more information, refer to Automatic Versus Manual Reference
Voltage Levels (see page 98).

Search Behavior in DPOJET

When search is configured, the application analyzes the identified marks on the source waveform. Read
and Write bursts are selected in ASM when search is selected as the qualify source. Each Mark indicates
the start and stop of a burst. These marks are used by the DPOJET measurement when the qualify source is
configured to Search. You can configure up to eight searches (Search1 – Search8) in ASM (Advanced
Search and Mark). The same search number gets reflected in DPOJET. Search is used for Multiple burst
analysis. Multiple burst is used for all DDR measurements except clock measurements. For more details,
refer to your oscilloscope online help.
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Population

The Population control allows you to limit the amount of waveform data that is analyzed. This is often
done in industry standards to make sure that there is consistency between measurement techniques.

Table 44: Global-Population options

Item Description

Off Disables the application from using a Population limit while
taking measurements.

On Enables the application to use a Population limit while
taking measurements.

Configure Displays the Population Limit (see page 117) dialog box
wherein you can set a limit on a maximum population to
obtain, for selected measurements.

xxx
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Configuring Population Limit

Table 45: Population-Configure options

Item Description

Limit By

Population The limit determines the population of measurement
observations that will be accumulated. Some measurements
may accumulate observations more quickly than others.

Acquisitions The limit determines the number of acquisition cycles that
will be performed.

Stop Conditions

Each Measurement Each measurement stops accumulating as soon as it
reaches the specified limit. Sequencing does not stop until
all measurements have reached the limit, at which time
every measurement will have exactly the limit.

Last Measurement Sequencing continues and all measurements continue
accumulating until the last (slowest accumulating)
measurement reaches the limit, at which time they all stop.
When sequencing stops, all measurements except one may
have higher population than the limit.

Limit Specifies the number of acquisitions or measurements the
application takes before sequencing stops.

OK Accepts the changes and closes the window.

xxx
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General

This configuration tab allows you to customize the measurement name and qualify the measurement within
a selected result range. The General tab looks the same for all the measurements but is not common. The
values are different for different measurements. You can set the custom name per measurement here. Use
the virtual keyboard to enter the measurement name of your choice. Measurements selected in DDRA are
the custom names for the measurements defined in DPOJET. A tool tip displays the custom name and the
DPOJET-based measurement name (in brackets) on moving the mouse over the row in the measurement
table, results, data snapshot, and measurement configuration summary.

NOTE. Custom measurement names revert to their DPOJET-based measurement names on being cleared
in the General configuration screen.

Table 46: General options

Item Description

Off Disables the application from using the specified
measurement limits.

On Enables the application to use the specified measurement
limits.

Max or Min value Specify the maximum and minimum range of valid
measurement values measurements. The default values
for the Measurement Range Limits options vary by
measurement.

Custom Measurement Name Option to modify the measurement name. Allows adding a
user-specified name to any measurement. This is useful for
aligning DPOJET measurements with a user measurement
list or standard.

xxx

NOTE. If a max value smaller than the min value is entered, it is accepted and the min value is also silently
reduced to the same value. Likewise, if a min value larger than the max is entered, both are set to that value.
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Filters

This configuration tab allows you to modify the measurement data by applying a High Pass filter to block
low frequency band components or a Low Pass filter to block high frequency band components. For
Example, Selecting a 1 MHz high pass filter can reduce the effect of SSC on results.

For some measurements (Period, Frequency, TIE, +Duty Cycle, –Duty Cycle, +CC Duty, – CC Duty,
CC–Period, Positive Width, Negative Width, N–Period, Rise Time, Fall Time, Low Time, High Time,
DC Common Mode, High–Low, High, Low, T/nT Ratio, PCIe T-Tx-Rise, PCIe T-Tx-Fall, PCIe
T-RF-Mismch, PCIe UI, USB UI, PCIe SSC FREQ DEV, USB TCdr-Slew-Max, USB SSC FREQ DEV,
USB SSC MOD RATE and USB SSC PROFILE), the measurements versus time waveform (time trend)
that is derived from the original oscilloscope waveform can be filtered before it is passed to the statistics
and plotting subsystems.

Band Pass Filtering

You can create a band pass filter by enabling both the High Pass and the Low Pass filters on a measurement.
The cut-off frequency for the Low Pass filter must be greater than or equal to the cut-off frequency for the
High Pass filter.

You should be aware that setting the cut-off frequencies close to each other may effectively filter out all
of the measurement data, or all but a small amount of timing noise. This diagram shows the spectrum
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of the measurement data passed to the statistics and plotting subsystems when you use both the High
Pass and the Low Pass filters.

High Pass filters attenuate low frequencies, and filter out DC values entirely. When a high pass filter is
added to a period or frequency measurement, the mean value of the filtered measurement goes to zero.
This can be seen by creating a Time Trend plot of a high-pass-filtered period or frequency measurement.
Although this is the correct theoretical behavior for the filtered measurement, it is not very useful if the
Results panel reports that the mean period or frequency is zero. For this reason, the mean values that
appear in the results panels for Period and Frequency measurements are the values before the filter.

Measurements such as AC Common Mode, PCIe AC Common Mode, and USB AC Common Mode use a
high-pass sliding window filter. This filter is applied to remove low frequency common mode noise. It
has a 30 kHz cutoff frequency.
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Table 47: Filter options

Item Description

High Pass

Filter Spec When enabled, blocks the low frequency band and passes
only the high frequency band of the waveform; defined as
1st order, 2nd order, 3rd order Butterworth and No filter, being
the default.

Freq (F1) * High Pass filter cut-off frequency at which the filter
magnitude falls by 3 dB.

Low Pass

Filter Spec When enabled, blocks the high frequency band and passes
only the low frequency band of the waveform; defined as 1st

order, 2nd order, 3rd order Butterworth, and No filter, being
the default.

Freq (F2) * Low Pass filter cut-off frequency at which the filter
magnitude falls by 3 dB.

Advanced Displays the Advanced Filter Configuration (see page 122)
dialog box.

Apply to All Settings of the measurement are applied to all
measurements with those settings.

xxx

* Includes a 3 dB cut-off frequency.

Brick Wall Filter Configuration

Measurements such as PCIe DeEmph and PCIe Med-Mx Jitter use the Brick Wall filter. A brick wall filter
is applied to the PCIe signal to remove the low frequency jitter components. The PCI Express application
applies the filter as per the PCIe specification. A Brick Wall filter has a very sharp cut-off frequency.
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Advanced Filter Configuration

The measurement filters are implemented using infinite impulse response (IIR) designs. As with any
causal filter, a transient may occur at the filter’s output in response to the arrival of the input signal. It is
usually desirable to exclude this transient from the measurement results.

In the DPOJET application, the filter transient is managed in two ways. First, the input to the filter is
gently “ramped up” from zero to its full value over some ramp time tr. Second, the output of the ramp
is “blanked” over some duration tb, so that the remaining effects of any transient are omitted from
measurement results, statistics and plots. The sequence of operations is depicted here:

The ramp function has a raised-cosine profile and is defined in the time domain as:

You may adjust the ramp time tr by means of the Advanced control panel. If you wish to turn off the
ramp function, set the ramp time to 0.

Similarly, you may adjust the blanking duration tb by means of the Advanced control panel. Setting the
blanking duration to 0 will allow you to see the entire filtered measurement, including any transients.
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Both, the ramp time tr and the blanking duration tb, are set relative to the reciprocal of the lowest filter
frequency Fc. By default, both of these parameters are set to 1/Fc. Since they are normalized to the filter
frequency, they will automatically adjust if you change the filter cut-off frequency.

The complete set of signal processing options, together with representative waveforms that suggest how
the options affect the measurement vector, are shown here:
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Table 48: Advanced filter configuration options

Item Description

Ramp Time Duration of the raised-cosine smoothing function applied to
the measurement vector before the vector is filtered.

Blanking Time Duration of the filter’s output that is suppressed. The
blanked portion of the output is not included in the
measurement statistics, or in any plots.

OK Accepts changes and closes.

xxx

About Clock Recovery

Clock recovery refers to the process of establishing a reference clock, the edges of which can be used
as a basis for timing comparisons. The Clock Recovery configuration tab allows you to select one of
the following clock recovery methods:

Constant Clock - Mean (see page 126)

Constant Clock - Median (see page 127)

Constant Clock - Fixed (see page 128)

Phase Locked Loop Standard BandWidth (see page 131)

Phase Locked Loop Custom BandWidth (see page 132)

Explicit Clock - Edge (see page 134)

Explicit Clock - PLL (see page 137)

The first five methods derive the reference clock from the same channel upon which the measurement
is defined. This is the conventional method of clock recovery for serial data communications, where no
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separate clock is available. The last two methods (Explicit Clock) derive the reference clock from a
channel other than the one upon which the measurement is defined.

About Constant Clock Recovery

In Constant Clock Recovery, the clock is assumed to be of the form A*sin (2Π ft +Φ), where the frequency
(f) and phase (Φ) are treated as unknown constants. Once a source waveform has been acquired and the
edges extracted, one or both of these constants are determined using linear regression, so that the recovered
clock minimizes the mean squared sum of the Time Interval Error (TIE) for that waveform.

If Constant Clock - Mean is selected as the clock recovery method, both the frequency and the phase
are chosen to minimize the mean squared error.

If Constant Clock - Fixed is selected as the clock recovery method, the precise frequency specified is
used but the phase is chosen so that the median error between the recovered and measured edges is zero.

If Constant Clock - Median is selected as the clock recovery method, the phase is chosen so that the
median error between the recovered and measured edges is zero.
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Constant Clock - Mean

This method provides the following options that control how the clock recovery is performed:

Auto Calc First Acq

Auto Calc Every Acq

Selecting Autocalc First Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase only on the first acquisition. Subsequent acquisitions will choose a best fit on clock
phase but retain the clock frequency found on the first acquisition.

Selecting Autocalc Every Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase for each new oscilloscope acquisition.

Clearing the measurement results by choosing Clear on the sequencing panel will reset the clock recovery
so that both frequency and phase are optimized on the subsequent acquisition.

Table 49: Constant clock - mean options

Item Description

Auto Calc First Acq Calculates the best fit of the initial acquisition or the first
acquisition after clearing results, and then uses the value
until you clear the results.

Auto Calc Every Acq Calculates the best fit for each acquisition (default).

Apply to All

Apply Applies the current clock recovery configuration to all
selected measurement(s), PLL-Standard clock recovery
options that have Clock Recovery as configuration tab.

Advanced Displays the Clock Recovery Advanced Setup (see
page 128) dialog box.

xxx
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Constant Clock - Median

This method provides the following options that control how the clock recovery is performed:

Auto Calc First Acq

Auto Calc Every Acq

Selecting Autocalc First Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase only on the first acquisition. Subsequent acquisitions will choose a best fit on clock
phase but retain the clock frequency found on the first acquisition.

Selecting Autocalc Every Acq will allow the clock-recovery algorithm to choose a new best-fit clock
frequency and phase for each new oscilloscope acquisition.

Clearing the measurement results by choosing Clear on the sequencing panel will reset the clock recovery
so that both frequency and phase are optimized on the subsequent acquisition.

Table 50: Constant clock - median options

Item Description

Auto Calc First Acq Calculates the best fit of the initial acquisition or the first
acquisition after clearing results, and then uses the value
until you clear the results.

Auto Calc Every Acq Calculates the best fit for each acquisition (default).

Apply to All

Apply Applies the current clock recovery configuration to all
selected measurement(s) that have Clock Recovery as the
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup (see
page 128) dialog box.

xxx
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Constant Clock - Fixed

This method provides a single option that controls how the clock recovery is performed. With Fixed
Constant Clock recovery, no attempt is made to derive information about the actual data rate from the
signal under test. Instead, the precise frequency that you specify will be used. (However, the clock phase
will be chosen so that the median difference between the recovered and measured edges is zero.)

NOTE. Click Apply to All to apply the clock recovery configuration to all selected measurement(s) that
have Clock Recovery as configuration tab.

Clock Recovery Advanced Setup

The Advanced Clock Recovery methods are used when unusually high noise defeats normal clock recovery
methods. Under most normal operating conditions, these methods are not required nor recommended.
Nominal Data Rate and Known Data Pattern are the two advanced clock recovery methods.

In Nominal Data Rate, you can provide the nominal data rate to the clock recovery algorithm. Normally,
the application analyzes your data and determines the nominal data rate automatically. Using Nominal
provides a starting point or hint to the clock recovery algorithm from which it analyzes data.

In Known Data Pattern, the pattern is specified by using an ASCII text file containing the characters 1
and 0. The file may contain other characters, spaces and tabs for formatting purposes, but they will be
ignored. Several files for commonly used patterns are included with the application, and you may use these
as examples if you wish to create your own pattern files. Click Browse to modify the default location
for pattern files.

NOTE. The last line of the pattern file must end with a CR/LF. Without the CR/LF, you will receive a
too many bits error message.

128 DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics Clock Recovery Advanced Setup

Table 51: Advanced clock recovery options

Item Description

Nominal Data Rate

Off, On Enables (On) or disables (Off) the advanced clock recovery
through data rate guidance.

Bit Rate Defines the nominal data rate in bits per second (b/s). Use
the pop-up keypad to set the data rate.

Known Data Pattern

Off, On Enables (On) or disables (Off) advanced clock recovery
through a known data pattern.

Pattern File Name

Browse Selects a file to use for the data pattern.

OK Accepts changes and closes.

xxx
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About PLL Clock Recovery Setup

When PLL-based clock recovery is selected, the application simulates the behavior of the hardware Phase
Locked Loop clock recovery circuit. This is a feedback loop in which the Voltage-Controlled Oscillator
(VCO) is used to track or follow slow variations in the bit rate of the input waveform. Such loops are
frequently used to recover the clock in communication links that do not transmit the clock as a separate
signal. The PLL parameters in the application may be adjusted to simulate with the behavior of a receiver
in such a link, within certain guidelines.

NOTE. The effective transfer function of a PLL loop is not equal to the PLL Loop BW setting. The Transfer
function depends on the factors such as damping, transition density and type.

NOTE. PLL response is not instantaneous. This causes some signals to have a ramped trend at the
beginning of a waveform as the PLL locks to the applied signal. To avoid a PLL start-up transient, part of
the output is blanked out. This is applicable only when you select PLL Custom BW, PLL Standard BW or
Explicit Clock-PLL as the clock recovery method. PLL blanking is used by measurements such as TIE,
RJ, RJ-δδ, DJ, DJ-δδ, PJ, TJ@BER, High Voltage, Low Voltage, High-Low, T n/t Ratio, Eye Width, Eye
Height, Width@BER, Height@BER, Rise Time and Fall Time.
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About PLL Loop BW versus JTF BW

Phase locked loops are characterized according to their bandwidth (BW), and several different bandwidths
are commonly used. The terminology used for these bandwidths is described here, since it varies
somewhat across different industries.

Loop BW (or Closed Loop BW) is the frequency at which the closed-loop gain has fallen to -3 dB
(half power) relative to unity-gain. The closed-loop gain function has the character of a low-pass filter.

JTF BW (Jitter Transfer Function BW or Error Function BW) is the frequency below which input jitter
to a tracking loop is removed. The JTF BW has a high-pass filter characteristic.

For Type I loops, the Loop BW and the JTF BW are always equal. For Type II loops, these two bandwidths
are different, and their ratio depends on the PLL damping factor. You can choose to specify either
bandwidth, and the other is displayed for reference.

PLL Standard BW

The PLL control area provides control over the phase-locked loop used for clock recovery. You can choose
the loop bandwidth and the loop order, and if a Type II loop is chosen, you can specify the damping factor.

To set the loop bandwidth automatically, based on a serial standard, select PLL: Standard BW as the clock
recovery method. From the Standard: b/s list box, select the standard that matches your data link. For
example, choose “PCI-E: 2.5” to test a 2.5 Gbit/second PCI Express link. In this case, the PLL bandwidth
will be set to 1.5 MHz, which is 1/1667 of the baud rate as specified in PCI Express standard.

You can use the PLL Model list box to choose between Type I and Type II loop. A Type I loop has a
transfer function that approaches zero frequency with a slope of 1/s and a Type II loop approaches zero
frequency with a 1/s2 slope (In much of the PLL literature, these terms are used interchangeably with
First-Order and Second-Order loops. For a thorough discussion of loop type versus order, see Frequency
Synthesis by Phase Lock, by William Egan).

NOTE. Although it is possible to configure a Type II PLL with a bandwidth up to 1/10 of the baud rate,
such a loop will have poor dynamic performance. This is because Type II loops have less phase margin
than Type I loops. A preferred alternative to using a Type II PLL with a bandwidth close to its baud rate is
to use a second order high-pass measurement filter to emulate the effects of the PLL.
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Related Topics

About PLL Loop BW versus JTF BW (see page 131)

Table 52: PLL-Standard clock recovery options

Item Description

PLL Model Selects between a Type I or Type II phase-locked loop.

Damping Use the keypad to specify the damping ratio of the PLL. It is
enabled only for Type II phase-locked loop.

Loop BW Displays the Closed Loop bandwidth that has been
configured based on the current standard.

JTF BW Displays the Jitter Transfer Function bandwidth that has
been configured based on the current standard.

Standard: b/s Implicitly sets the loop bandwidth of the clock recovery PLL,
based on selection of the industry standard and data rate in
bits/second.

Apply to All Applies the current clock recovery configuration to all
selected measurements that have user-configurable clock
recovery.

Apply Applies the current clock recovery configuration to all
selected measurement(s) that have Clock Recovery as the
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup. For more
details, refer to the Clock Recovery Advanced Setup (see
page 128).

xxx

PLL Custom BW

The PLL control area provides control over the phase-locked loop used for clock recovery. You can choose
the loop bandwidth and the loop order, and if a Type II loop is chosen, you can specify the damping factor.
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To manually control the loop bandwidth, select PLL: Custom BW as the clock recovery method and use
the BW control to choose the –3 dB bandwidth, in Hz.

You can use the PLL Model list box to choose between a Type I and Type II loop. A Type I loop has a
transfer function that approaches zero frequency with a slope of 1/s and a Type II loop approaches zero
frequency with a 1/s2 slope. (In much of the PLL literature, these terms are used interchangeably with
First-Order and Second-Order loops. For a thorough discussion of loop type versus order, see Frequency
Synthesis by Phase Lock, by William Egan).

If you choose a Type II loop, you can use the radio buttons to select whether you will directly control the
Loop BW (low-pass function) or the JTF BW (high-pass function). You must also select the Damping
Factor for a Type II loop.

NOTE. Although it is possible to configure a Type II PLL with a bandwidth up to 1/10 of the baud rate,
such a loop will have poor dynamic performance. This is because Type II loops have less phase margin
than Type I loops. A preferred alternative to using a Type II PLL with a high bandwidth is to use a 2nd
order high-pass measurement filter to emulate the effects of the PLL.

Related Topics

About PLL Loop BW versus JTF BW (see page 131)
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Table 53: PLL-Custom clock recovery options

Item Description

PLL Model Selects between Type I or Type II phase-locked loop.

Damping Use the keypad to specify the damping ratio of the PLL. It is
enabled only for Type II phase-locked loop.

JTF BW Explicitly sets the JTF bandwidth of the clock recovery PLL
when the PLL Model is Type II and the JTF BW radio button
is selected.

Loop BW Explicitly sets the Loop bandwidth of the clock recovery
PLL when the PLL Model is Type II and the Loop BW radio
button is selected.

Apply to All Applies the current clock recovery configuration to all
selected measurements that have user-configurable clock
recovery.

Apply Applies the current clock recovery configuration to all
selected measurement(s) that have Clock Recovery as the
configuration tab.

Advanced Displays the Clock Recovery Advanced Setup. For more
details, refer to the Clock Recovery Advanced Setup (see
page 128).

xxx

About Explicit Clock Recovery

In Explicit Clock Recovery, the reference clock is not derived from the measurement’s target source at all,
but is instead taken from a separately-identified source. Since the source used for the measurement now
differs from the source used to derive the reference clock, selecting this type of clock recovery converts
the measurement from a single-source measurement to a dual-source measurement. The reference clock
source is always shown on the right when the two sources appear in a measurement table. Changing the
clock-recovery method back to a non-explicit clock method will change the measurement back to a
single-source measurement.

Explicit Clock-Edge

Select Explicit Clock-Edge method if you want to use the edges found in the selected clock source
(possibly multiplied up by an integral number). If the Clock Multiplier is set to 1 (the default), only these
edges will be used. If the Clock Multiplier is set to a number N other than 1, linear interpolation will be
used between each pair of actual edges to create N-1 additional reference edges. The interpolated edge
times, combined with the actual edges, give a total of N reference edge times per actual edge.
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Table 54: Explicit-Clock edge options

Item Description

Clock Source Select Ch1 to Ch4, Ref1 to Ref4, or Math1 to Math4 as
reference source for clock recovery.

Clock Edge Specify whether the rising, falling or both edges of selected
source should be considered.

Clock Multiplier Specify the number of edges to be used.

Apply to All

Apply Applies the current clock recovery configuration to all
selected measurement(s) that have Clock Recovery as the
configuration tab.

Advanced Displays the Advanced Explicit Clock-Edge (see page 136)
dialog wherein you can adjust the timing relation between
reference clock source and data source.

xxx
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Advanced Explicit Clock-Edge

To compare the reference clock times to the edge times from the data source, some assumptions must be
made about how they align. The default assumption is that each data source edge is associated with the
reference clock edge to which it is nearest in time. This assumption may not be optimum, for example if
the probes for the reference clock and data signal have different cable lengths.

To change the way the reference clock edges and data edges are associated, you can control the Nominal
clock Offset Relative to Data.

Table 55: Advanced Explicit-Clock edge options

Item Description

Nominal Clock Offset Relative to Data

Auto Automatically calculates the clock data skew and shifts the
reference clock edges before the application associates
each data edge with the closest clock edge.

Manual Specify a time delay (positive or negative) to shift the
reference clock edge before the application associates each
data edge with the closet data edge.

Recalculate

When required Recalculates the nominal clock offset value whenever a
new measurement is added or results are cleared or there
are any measurement configuration changes.

Every acquisition Recalculates the nominal clock offset value for every
acquisition.

xxx

Related Topics

Effect of Nominal Clock Offset on Eye Diagrams (see page 139)
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Explicit Clock-PLL

Select Explicit Clock-PLL as the clock recovery method if you want to feed the edges from the selected
clock source through a PLL rather than using them directly. The actual edges from the clock source will
be used to drive a software PLL model, and the edge times coming out of the PLL will be used as the
reference edges for the target measurement. If the Clock Multiplier is set to a number N other than 1, the
output of the PLL will have N edges per actual edge.

Table 56: Explicit-Clock PLL options

Item Description

Clock Source Select Ch1 to Ch4, Ref1 to Ref4 or Math1 to Math4 as
reference source for clock recovery.

Clock Edge Specify whether the rising, falling or both edges of selected
source should be considered.

Clock Multiplier Specify the number of edges to be used.

Apply to All

Apply Applies the current clock recovery configuration to all
selected measurement(s) that have Clock Recovery as
configuration tab.

Advanced Displays the Advanced Explicit Clock-PLL (see page 137)
dialog wherein you can adjust the timing relation between
reference clock source and data source.

xxx

Advanced Explicit Clock-PLL

In the Advanced Explicit Clock- PLL, you can specify the PLL type, bandwidth, damping factor and
nominal clock offset relative to data. Damping numeric input is enabled only for Type II phase-locked loop.
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Nominal Clock Offset Relative to Data

To compare the reference clock times to the edge times from the data source, some assumptions must be
made about how they align. The default assumption is that each data source edge is associated with the
reference clock edge to which it is nearest in time. This assumption may not be optimum, for example if
the probes for the reference clock and data signal have different cable lengths.

To change the way the reference clock edges and data edges are associated, you can control the Nominal
clock Offset Relative to Data.
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Table 57: Advanced Explicit-Clock PLL options

Item Description

PLL Settings for Explicit Clock

JTF BW Explicitly sets the JTF bandwidth of the clock recovery PLL
when the PLL Model is Type II and the JTF BW radio button
is selected.

Loop BW Explicitly sets the Loop bandwidth of the clock recovery
PLL when the PLL Model is Type II and the Loop BW radio
button is selected.

PLL Model Selects between Type I or Type II phase-locked loop.

Damping Use the keypad to specify the damping ratio of the PLL. It is
enabled only for Type II phase-locked loop.

Nominal Clock Offset Relative to Data

Auto Automatically calculates the clock data skew and shifts the
reference clock edges before the application associates
each data edge with the closest clock edge.

Manual Specify a time delay (positive or negative) to shift the
reference clock edge before the application associates each
data edge with the closet data edge.

Recalculate

When required Recalculates the nominal clock offset value whenever a
new measurement is added or results are cleared or there
are any measurement configuration changes.

Every acquisition Calculates the nominal clock offset value for every
acquisition.

xxx

Related Topics

Effect of Nominal Clock Offset on Eye Diagrams (see page 139)

Effect of Nominal Clock Offset on Eye Diagrams

Nominal Clock Offset does not affect the eye diagrams directly. Data and clock timing relationship is
maintained ignoring the clock offset value. The clock offset still affects the eye diagram shape indirectly
through edge labeling and TIE measurement but not with alignment.

When Explicit Clock Recovery is used, the Nominal Clock Offset does not affect eye diagram alignment.
The relative alignment between data and clock is maintained as acquired. An absolute alignment is
controlled by Ref Clock Alignment setting in Eye Diagram plot configuration panel. To ensure proper
alignment between data and clock it is important to properly deskew oscilloscope channels.
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Bit Config for Eye Height Measurements

This configuration tab allows you to select which waveform bit types (Transition bits, Non-Transition or
All Bits) are included when taking Eye Height.

Table 58: Bit Config for eye height

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

xxx
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Bit Config for Eye High, Eye Low, and Q-Factor Measurements

This configuration tab allows you to select which waveform bit types (Transition bits, Non-Transition or
All Bits) are included when taking Eye Height. This configuration tab also allows you to set the percent
of unit interval where the measurement is taken.

Table 59: Bit Config for eye high, low, and Q-Factor

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Measure at X% Sets the X% where the measurement is taken

xxx
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Bit Config for Height@BER Measurements

This configuration tab allows you to select which waveform bit types (Transition bits, Non-Transition,
or All Bits) are included when taking Height@BER measurements. This configuration tab also allows
you to select the measurement range in terms of percentage UI and the number of bins to be considered
within the given range.

Table 60: Bit Config for height@BER

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Measurement Range (UI%)

Start Defines the starting point of the analysis.

End Defines the ending point of the analysis.

# of Bins Defines the number of bits to be considered within the
specified interval.

xxx
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Bit Config for Mask Hits Measurements

This configuration tab allows you to select the waveform bit type (All Bits, Transition, or Non-Transition)
and the mask to be used for Mask Hits measurements.

Table 61: Bit Config for mask hits

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Mask

Browse Allows selection of the mask file. (If none of the supplied
mask files meets your need, you may create a custom mask
file with a text editor by using one of the existing mask
specification files as a template.)

xxx
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Bit Config for Amplitude Measurements

This configuration tab is present only for High, Low and High–Low measurements. You can select the
waveform bit type (All Bits, Transition, Non-Transition) and method.

Table 62: Bit Config for amplitude measurements

Item Description

Bit Type

All Bits Eye analysis includes both transition and non-transition bits.

Transition Eye analysis only on transition bits.

Non-Transition Eye analysis only on non-transition bits.

Measure the Center X% of the Bit Determines what percentage (1 to 100) of a unit interval,
centered in the middle of the bit, shall be included in each
measurement. The waveform points selected by the
percentage form a distribution (vertical histogram) from
which a single value is extracted, based on the Method
control.

Method Determines whether the Mean value or the Median of the
selected distribution is used for the measurement value for
each unit interval.

xxx
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Bit Config for PCI Express Measurements

This configuration tab allows you to select which waveform bit types (Transition, Non-Transition or All
Bits) are included when taking PCI Express measurements, PCIe T-Tx-Rise and PCIe T-Tx-Fall.

Table 63: Bit Config for PCI Express measurements

Item Description

Bit Type

All Bits Analysis includes both transition and non-transition bits.

Transition Analysis only on transition bits.

Non-Transition Analysis only on non-transition bits.

xxx
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BER for PCI Express Measurements

The BER configure panel is available for T-TX-UTJ, T-TX-UDJDD, T-TX-UPW-TJ,and
T-TX-UPW-DJDD measurements.

Item Description

Target BER

BER= 1E-? Sets the Bit Error Rate exponent, thereby setting the
statistical level at which Total Jitter and Eye Opening are
reported.

Apply To All

Apply Applies the Target BER value to both Jitter Target BER and
Target BER for all the measurements that have the BER as
the configuration tab.

xxx

About RJ/DJ

This configuration tab allows you to select an appropriate decomposition method for jitter analysis. RJ/DJ
decomposition analysis breaks the timing jitter into various categories and uses the results to predict the
total jitter at a selected bit error rate (BER). The RJ/DJ tab is present for the RJ, DJ, PJ, DCD, DDJ, RJ–δδ,
DJ–δδ,TJ@BER and Width@BER measurements.

The DPOJET application offers two methods of RJ/DJ analysis:

A method based on spectral analysis that is appropriate for cyclically repeating data patterns.

A method that works for arbitrary data sequences.

Related Topics

RJDJ Analysis of Arbitrary Pattern (see page 148)
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RJDJ Analysis of Repeating Pattern (see page 147)

RJ/DJ Analysis of Repeating Pattern

This method of RJ/DJ analysis uses a Fourier transform of the time-interval error signal to identify and
separate jitter components. It is described in the Fibre Channel - Methodologies for Jitter and Signal
Quality Specification (MJSQ) and has wide industry acceptance.

This method requires that the data signal be composed of a pattern of N bits that are repeated over and
over. The pattern length (N) must be known, although it is not necessary to know the specific bits that
make up the pattern.

Table 64: RJ/DJ analysis of repeating options

Item Description

Data Signal Settings

Pattern Type Selects between repeating or arbitrary pattern analysis.

Pattern Length When the Pattern Type is set to Repeating, sets the pattern
length of the repetitive pattern data; use for spectrum
analysis RJ/DJ separation.

Jitter Target BER ‡

BER= 1E-? Sets the Bit Error Rate exponent, thereby setting the
statistical level at which Total Jitter and Eye Opening are
reported.

Apply To All

Apply Applies the Target BER value to Jitter Target BER for all the
measurements that have the RJDJ as the configuration tab.

xxx

‡ Only available for TJ@BER and Width@BER measurements.
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RJ/DJ Analysis of Arbitrary Pattern

When the data pattern is not repeating, or is unknown, a second method of RJ/DJ analysis may be used. (It
may also be used if the pattern is repeating, and correlates well with the Spectral method in this case.) This
method assumes that the Inter Symbol Interference (ISI) from a given edge only affects a relatively small
number of subsequent bits. For example, in a band-limited link where a string of ones follows a string of
zeros, the signal may require three or four bit periods to fully settle to the “high” state.

In this method, an analysis window with a width of K+1 bits is slid along the waveform. For each position
of the window, the time interval error of the rightmost bit in the window is stored, along with the K-bit
pattern that preceded it. After the window has been slid across all positions, it is possible to calculate the
component of the jitter that is correlated with each observed K-bit pattern, by averaging together all the
observed errors associated with that specific pattern.

In the configuration menu for the arbitrary-pattern method, the Window Length field allows you to select
how many bits are included in the sliding window. The window should include enough bits to encompass
the impulse response of the system under test, usually 5 to 10 bits. A good practical test is to check whether
increasing the window length causes any appreciable change in the jitter results; if not, the window length
is effectively capturing all the ISI effects. The disadvantage of increasing the window length is that it uses
more memory and requires additional processing time and greater measurement population to form an
answer. If the measurement population is not sufficient at the end of a processing cycle to calculate an
answer, the results table displays <Min# of UI.

The configuration menu also includes a field for selecting what population of each K-bit pattern must
be accumulated before the TIE associated with that pattern is considered acceptable. Using a larger
population means that more observations are averaged together, so that the variance of the measurement is
reduced. Specifying a larger population has the disadvantage of requiring a longer measurement period
before results can be calculated and it may be necessary to sequence the instrument several times before
enough statistics are accumulated to provide results.

The arbitrary pattern approach for measuring jitter may not be appropriate if there are very-long-duration
memory effects in your data link. An example would be if there are impedance mismatch reflections that
arrive long enough after the initial edge to fall outside the analysis window.
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Table 65: RJ/DJ analysis of arbitrary options

Item Description

Data Signal Settings

Pattern Type Selects between repeating or arbitrary pattern analysis.

Window Length When the Pattern Type is set to Arbitrary, sets the pattern window
length in terms of Unit Interval (UI) used for arbitrary pattern RJ/DJ
separation.

Population When the Pattern Type is set to Arbitrary, sets the minimum population
limit for each pattern to be qualified for arbitrary pattern RJ/DJ
separation.

Jitter Target BER †

BER= 1E-? Set the Bit Error Rate exponent, thereby setting the statistical level at
which Total Jitter and Eye Opening are reported.

Apply to All

Apply Applies the current RJ/DJ configuration settings to all the selected
measurement(s) that have the RJ/DJ as the configuration tab.

xxx

† Available only for TJ@BER and Width@BER measurements.

Configuring Bus States

The following topic applies only to MSO series oscilloscopes, since it depends on the ability to define a
digital bus using the oscilloscope logic channels.

Use this configuration tab to select the bus states, clock source, edge and polarity used in measurements
that require a bus source. The configuration changes based on the selected measurement. Measurement
tCMD-CMD requires two different bus states to calculate the time between them. Select the bus states
using a bus symbol file or a bus pattern setup. Select between the options using the radio buttons.

If a symbol file is not loaded, Enter pattern is selected. If a symbol file is loaded, Use symbol file is
selected. The symbol file loads commands into the drop down lists. The Bus State user interface stays in
sync with the Bus Setup window of the oscilloscope. Any change in Bus state configuration tab will reflect
in Bus setup window and vice versa.

When a symbol file is loaded, the From Symbol and To Symbol drop downs are displayed, with the
commands loaded from the symbol file. You can select the required Measure at bus states. Changing
Measure at to Clock Edge lets you set the clock source and polarity. Clock Edge considers the time at
which commands are registered, that is, at the Rising or Falling edge of the clock, depending on the
Clock Polarity configuration.

DPOJET Jitter and Eye Diagram Analysis Tools 149



Operating Basics Configuring Bus States

Measurements like tCKSRE require one waveform source and one bus state. Select the waveform source
from the Clock Source drop down or the Source Configuration window. Your selected source is the first
choice in the Clock Source drop down. Select the bus state using the Symbol drop down.

The tBurst-CMD measurement is a single-source measurement by default. The Measure at selection does
not have a Clock Edge selection, only Start and Stop.

Select Enter pattern to directly enter the required symbol bit patterns.
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Table 66: Bus state options

Item Description

Use symbol file Use the bus state in the symbol file.

Enter pattern Specify a bus state pattern.

Symbol File Browse for the symbol file to use.

Between source and bus state

Symbol The bus state symbol to use in measurements.

Measure at Specify where to take the measurement.

Clock Edge Settings

Clock Source Specify the clock source for the measurement.

Clock Polarity Specify the clock polarity for the measurement.

Between bus states

From Symbol Specify where the measurement is take from.

To Symbol The symbol file specifies where to measurement to.

Measure at The symbol file specifies where to take the measurement.

Start - Considers Start time of the command.
Stop - Considers Stop time of the command.
Clock Edge - Considers the time at which Commands are registered,
that is, at the Rising edge of the clock.

xxx

Configuring Edges

This configuration tab allows you to select which waveform edge or edges the application will use to take
each measurement. Depending on the particular measurement, the tab will offer access to other options
and constraints that help guide the analysis. The application is able to automatically detect whether
a signal is clock or data, and will do so by default. This can be overridden by configuring the signal
type as Clock or Data.
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The following configuration options apply to most measurements. See the subsequent sections for Edge
tabs corresponding to particular measurements.

Item Description

Signal Type

Clock Forces the signal type to be interpreted as a Clock.
Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising
and falling edges are used.

Auto Allows the application to automatically detect whether
the signal is clock or data. If the signal is a clock, the
Clock Edge control will determine which edges are used;
otherwise the Clock Edge control will have no effect.

Clock Edge

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

xxx
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Configuring Edges for Skew Measurements

This configuration tab is displayed for Skew measurements.

Item Description

From Edge - Defines which edge of the first waveform is used to take measurements.

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

To Edge - Defines which edge on the second waveform is used to take measurements.

Same as From Each measurement is defined by a pair of like edges (Rise
to Rise or Fall to Fall).

Opposite as From Each measurement is defined by a pair of opposing edges
(Rise to Fall or Fall to Rise).

xxx
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Configuring Edges for Differential CrossOver Voltage Measurements

This configuration tab is displayed for Differential CrossOver Voltage measurements.

Item Description

Main Edge - Defines which edges on the Source1 waveform are used to take the measurement.

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses Both the rising and falling edges of the signal.

xxx
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Configuring Edges for Phase Noise Measurements

This configuration tab is displayed for Phase Noise measurements. Phase noise measurements are
undefined for data signals, so the signal is assumed to be a clock.

The Noise Integration Limits determine the portion of the phase noise spectrum that is integrated to
produce a single measurement per waveform acquisition.

Item Description

Active Edge-Defines which edge of the source waveform is used to take measurements.

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

Noise Integration Limits

Upper Frequency Sets the upper end of the noise integration frequency range.

Lower Frequency Sets the lower end of the noise integration frequency range.

xxx
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Configuring Edges for N-Period Measurements

This configuration tab is displayed for N–Period measurements.

Item Description

Signal Type

Clock Forces the signal to be interpreted as a Clock.
Measurements will take place on the edges specified by
the Clock Edge control.

Data Forces the signal to be interpreted as a Data. Both rising
and falling edges are used.

Auto Allows the application to automatically detect whether
the signal is clock or data. If the signal is a clock, the
Clock Edge control will determine which edges are used;
otherwise the Clock Edge control will have no effect.

Clock Edge

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

N= Specifies number of cycles or unit interval in each N-period
group.

Edge Increment Specifies the temporal displacement in edges between
consecutive measurements.

xxx
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Configuring Edges for Two Source Measurements

This configuration tab is displayed for two source measurements: Setup and Hold.

Item Description

Clock Edge(Source 1)

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

Data Edge(Source 2)

Rise Uses only the rising edges of the signal.

Fall Uses only the falling edges of the signal.

Both Uses both the rising and falling edges of the signal.

xxx
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Configuring Edges for CC-Period/Duty Cycle Measurements

This configuration tab is displayed for the CC–Period, +Duty Cycle and –Duty Cycle measurements.
These measurements are only defined for clock signals, and each measurement value is evaluated over one
full clock cycle.

Item Description

Clock Edge

Rise Measurements are only initiated on the Rising edges of the
clock signal.

Fall Measurements are only initiated on the Falling edges of
the clock signal.

Both Measurements are initiated on both the Rising and falling
edges of the clock signal.

xxx
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Configuring Edges for DCD Measurement

This configuration tab is displayed for DCD measurement.

Item Description

Signal Type

Clock Forces the signal type to Clock. Edges are selectable.

Data Forces the signal type to Data. Both rising and falling edges
are used.

Auto Automatically detects whether the signal is clock or data.

xxx
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Configuring Edges for Overshoot/Undershoot Measurements

This configuration is displayed for both Overshoot and Undershoot measurements. The algorithm
calculates the maximum peak amplitude above/below the specified edge configuration reference level
voltage (see page 97) for Overshoot/Undershoot measurements.

An Overshoot event is defined by a rising crossing followed by a falling crossing of the reference level.
Undershoot is defined by a falling crossing followed by a rising crossing of the reference level.

The difference between the peak amplitude and the reference level voltage is shown in the measurement
results, expressed as a positive value in all cases. The results are stored zero for the cycles which do not
have Overshoot/Undershoot.
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Configuring Edges for Rise Slew Rate

This configuration is displayed for Rise Slew Rate measurement:

Item Description

From Level

Mid Uses the source configuration mid reference voltage level
for the Rise slew rate.

Low Uses the source configuration low reference voltage level
for the Rise slew rate. Default is low.

To Level

High Uses the source configuration high reference voltage level
for the Rise slew rate.

Mid Uses the source configuration mid reference voltage level
for the Rise slew rate.

Slew Rate Technique

Nominal Method Determines the slew rate between From->Low level to
To->High level.

DDR Method Determines the slew rate between low to high reference
level. If the actual signal is earlier than the nominal slew
rate line, then the slew rate is calculated using the tangent
method From->Low level to To->High to the sample, which
occurred earlier.

xxx

Reference

High Mid and Low Reference Voltage Levels (see page 97)
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Configuring Edges for Fall Slew Rate

This configuration is displayed for Fall Slew Rate measurement:

Item Description

From Level

High Uses the source configuration high reference voltage level
for the Fall slew rate.

Mid Uses the source configuration mid reference voltage level
for the Fall slew rate. Default is low.

To Level

Mid Uses the source configuration mid reference voltage level
for the Fall slew rate.

Low Uses the source configuration low reference voltage level
for the Fall slew rate.

Slew Rate Technique

Nominal Method Defines the slew rate between From->Low level to To->High
level.

DDR Method Determines the slew rate between high to low reference
level. If the actual signal is earlier than the nominal slew
rate line, then the slew rate is calculated using the tangent
method From->High level to To->Low to the sample, which
occurred earlier.

xxx

Reference

High Mid and Low Reference Voltage Levels (see page 97)
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Configuring Edges for DDR tCH(avg) and DDR tCL(avg)

This configuration tab is displayed for both DDR tCH(avg) and DDR tCL(avg). Set the window size for
clock measurements. The measurement analysis is done on a sliding window of size 200 cycles with a step
increment of 1 cycle. You can set window size up to 1M, with at least 200.
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Configuring Edges for DDR tERR(m-n)

This configuration tab is displayed for DDR tERR(m-n) measurement.

Item Description

Clock Edge

Rise Measurements are only initiated on the Rising edges of the
clock signal.

Fall Measurements are only initiated on the Falling edges of the
clock signal.

Number of Periods

Minimum Specify the minimum number of periods required to calculate
error across multiple consecutive cycles from tCK(avg).

Maximum Specify the maximum number of periods required to
calculate error across multiple consecutive cycles from
tCK(avg).

Window Size Measurement analysis is done on a window of size 200
cycles with a step increment of 1 cycle. As per the standard,
the default window size is 200. You can set window size
up to 1M.

xxx
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Configuring Edges for DDR tERR(n)

This configuration tab is displayed for DDR tERR(n) measurement.

Item Description

Clock Edge

Rise Measurements are initiated only on the Rising edges of the
clock signal.

Fall Measurements are initiated only on the Falling edges of the
clock signal.

Number of Periods Timing error (tERR) requires number of periods (n(per))
to calculate error across multiple consecutive cycles
from tCK(avg). You can configure n(per) up to 50, with a
resolution of 1.

Window Size Measurement analysis is done on a window of size 200
cycles with a step increment of 1 cycle. As per the standard,
the default window size is 200. You can set window size
up to 1M.

xxx
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Configuring Edges for DDR tHZDQ and DDR tLZDQ

This configuration tab is displayed for both DDR tHZDQ and DDR tLZDQ.

Configuring Edges for DDRtJIT(per), DDRtCK(avg) and DDRtJIT(duty)

This configuration tab is displayed for DDRtJIt(per), DDRtCK(avg) and DDRtJIT(duty).

Item Description

Clock Edge

Rise Measurements are only initiated on the Rising edges of the
clock signal.

Fall Measurements are only initiated on the Falling edges of the
clock signal.

Window Size Measurement analysis is done on a window of size 200
cycles with a step increment of 1 cycle. As per the standard,
the default window size is 200. You can set window size
up to 1M.

xxx
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Configuring Edges for Time Outside Level

This configuration is displayed for the Time Outside Level measurement:

Item Description

Level

High Time Outside Level measurement is computed only in
overshoot using High Ref Level.

Low Time Outside Level measurement is computed only in
undershoot using Low Ref Level.

Both Time Outside Level measurement is computed in both
overshoot and undershoot using High and Low Ref Levels.

High Ref Voltage Displays or allows you to define the high reference voltage
level.

Low Ref Voltage Displays or allows you to define the low reference voltage
level.

xxx

Reference

High Mid and Low Reference Voltage Levels (see page 97)

Spread Spectrum Clocking (SSC)

This configuration tab allows you to set the nominal frequency of the Spread Spectrum Clocking (SSC).
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Table 67: Spread spectrum clock

Item Description

Nominal frequency

Auto Allows the application to determine the frequency.

Manual You enter the nominal frequency of the spread spectrum
clock.

xxx

Sequencing

Use the Control Panel (see page 82) to start or stop the sequence of processes the application and
oscilloscope use to acquire information from a waveform. The application then determines if the algorithm
for the selected measurement can be applied to the waveform information. Sequencing is the steps to
acquire waveform information, determine if the information is usable for the measurement, take the
measurement, and display the results (and plots if selected).

When you click Recalc, Single or Run, the corresponding button is changed to Stop and the Progress
indicator is displayed. For more details, refer to the Control Panel (see page 82).
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The Progress Indicator displays the sequencer state. Select Stop, if you want to interrupt the sequence
before its completion.

For more details on progress bar status messages, refer to Progress Bar Status Messages (see page 231).
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Viewing Statistical Results

The application displays results for the measurements for all acquisitions or for the current acquisition. By
default in the detail view, the limits will not be shown unless the limits are turned on.
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Result statistics for most of the measurements show Population in terms of UI or transitions. According to
the JEDEC specification, the analysis for most of the clock measurements is done for a 200-cycle moving
window. However, for clock measurements such as DDRtCL(avg) and DDRtCH(avg), the population is
shown as tCK(avg) units. For Data Eye Width, the population number is shown as per acquisition.

Table 68: Results menu options

Item Description

Displays an error message. You can click to view the
error log information in a text editor.

Displays a warning. You can click to view the error
log information in a text editor.

Description Lists the measurement name and the source.

Mean Lists a statistical mean value for the measurement data.

Std Dev Lists a statistical standard deviation value for the
measurement data.

Max Lists a statistical maximum value for the measurement data.
Shows Pass if the statistics is within the specified Upper
Limit Equality (ULE).

Min Lists a statistical minimum value for the measurement data.
Shows Fail if the statistics has crossed the specified Lower
Limit Equality (LLE).

p-p Lists a statistical peak-to-peak value for the measurement
data.

Population † Lists the total number of measurement data points used
for displaying the statistics.

Max-cc Lists the maximum cycle-to-cycle differences per acquisition.

Min-cc Lists the minimum cycle-to-cycle differences per acquisition.

Options

Click to view Save Current Stats, Export to Ref Waveform,
and Display Units-Absolute options.

Save Current Stats... Saves the current statistics as log information.

Export to Ref Waveform Exports time trend data of the selected measurement to
the reference memory.

Display Units- Absolute Default display unit is Absolute.

Click to view the result details.

xxx

† Jitter measurements such as RJ, DJ show population in terms of acquisitions.

NOTE. For Mask Hits measurement, only Mean, Max, Min and Population values are displayed in the
results table. On clicking , Hits in Segment 1, Segment 2 and Segment 3 are displayed. For Mask Hits
measurements, mean indicates the total number of hits for all acquisitions.
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The results tab with limits turned on is as shown. You can click the zoom icon, available for Max and
Min values irrespective of the limits being turned on/off in the current acquisition. A tool tip displays the
message “Click to view the event on the waveform” and appends the result statistics in full resolution
(without any truncation) on hovering the mouse.

NOTE. The zoom feature is available only for vector measurements.

Results with Error/Warning Notification

The results tab with error icon is as shown. Click View Log to view the error log information in a
text editor.

The results tab with warning icon is as shown. You can click View Log to view the error log
information in a text editor.
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Overall Test Result

There are two ways to view the statistical results of measurements:

Summary (see page 174)

Details (see page 175)

NOTE. Alternatively, you can toggle between Summary and Details using the Expand/Collapse button.

On clicking Single/Run, the Overall Test Result shows Pass/Fail icons depending on the result of the
measurement(s).

For example, the Overall test result is fail if any measurement has limit failure. The result statistic which
has failed is highlighted in red as shown:
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NOTE. When limits are turned off, Summary and Overall Test Result options are not available.

Summary

Displays the summary of the results for all acquisitions. Pass/Fail information is included whereas
Max-cc and Min-cc information is excluded. Click the Expand button for the summary view as shown:
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Details

Displays the detailed results specifying values for High Limit, Low Limit, Pass/Fail, and current
acquisition. Click the Expand button for the details view as shown:

Export Results to Ref Waveform

Using this option, you can export the time trend plot of a measurement to any of the available reference

memory, Ref1-Ref4. Click on the right corner of the results panel to select the “Export Results to
Ref” option.

The Export Results to Ref waveform dialog box appears. It lists all the possible measurements that have
time trend result data (that is measurements for which time trend plot is enabled in the plot panel).

From the list of measurements, results of any one measurement can be exported to any one of the reference
memory (Ref1-Ref4) which is not used as the source of any measurement.
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Before exporting results to a reference memory, the application checks for the following:

If any of the ref waveforms are already used as source for one of the measurement(s), then you cannot
export the results on those ref destinations. The application prevents exporting by displaying an
error message 2003 (see page 232).

If all the reference waveforms (Ref1-Ref4) are already used as sources for various measurements, the
“Export Results to Ref Waveform” is not displayed. Instead, an error message 2002 (see page 232) is
displayed.

If a ref destination is assigned to a measurement from the list which is not empty (that is, if the ref is
already defined and holds any other recalled waveform), a warning prompts you from overwriting the
existing definition of the selected destination ref.

In case of any error (2002 or 2004) or warning (Overwriting the existing definition) and you select
the response as “No”, the destination ref reverts to its previous value. For example, if the selected
measurement is Period-Ref1, and the destination ref assigned to the measurement is Ref3, and if you
try to change the destination from Ref3 to Ref1, an error message 2003 (see page 232) is displayed.
Ref3 is retained as the destination ref.

Time trend result export to the reference waveform for a measurement is independent of time trend
plot. Time trend result can be exported to ref without selecting/defining plots in the plots panel.

If “Export Results to Ref” is selected without any measurement selection, an error message 2005
(see page 232) is displayed.

If none of the selected measurements have time trend data, an error message 2007 (see page 232) is
displayed and “Export Results to Ref” dialog is not displayed.

If the selected measurements have no results (results are cleared or measurements are not run to
produce results), an error message 2006 (see page 232) is displayed and “Export Results to Ref”
dialog box is not displayed.

If the destination is none for all measurements, the results are not exported to ref on clicking OK. An
information/warning 2008 (see page 232) is displayed.

Results as Plots

The application can display the results as two-dimensional plots for easier analysis. Before or after you
take measurements, you can set up the Select Plots and Plots Configure menus to define up to four plots.
The last plot selected is displayed when the application completes sequencing (see page 168).

NOTE. Plots are not available for DDR tJIT(duty), DDR tJIT(per), DDR tERR(n), DDR tERR(m–n), PCIe
Tmin-Pulse, PCIe Med-Mx Jitter, PCIe Tmin-Pulse-Tj, PCIe Tmin-Pulse-Dj, USB UI,DDR VID(ac), USB
SSC FREQ DEV MAX and USB SSC FREQ DEV MIN, ps21TXand T-TX-DDJ measurements.

If you set up plots after sequencing, the application displays the plot based on the current measurement
and result.
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NOTE. When taking measurements in the Run mode, you must stop the sequencing before you can use
some plot features.

Table 69: Plot type definitions

Item Description

Time Trend Represents the measurement values versus the time
location.

Data Array Represents the measurement values versus the index
number of the measurement array.

Histogram 1 Represents measurements sorted by value as a distribution
of measurement values versus the number of times the
value occurred.

Spectrum Represents the frequency content computed using the FFT
of the Time Trend of the measurement data.

Transfer Represents the magnitude ratio of spectrum of time trend
data of two measurements from the following set: Clock
Period, Clock Frequency, Clock TIE, Clock PLL TIE, Data
Period, Data Frequency, Data TIE, Data PLL TIE.

Phase Noise 2 Represents the phase noise of a clock signal and is plotted
in the frequency domain for only Clock TIE measurements.

Eye Diagram 3 Represents data for the eye diagram based on the
recovered clock as the timing reference; used for mask
testing.

Waveform 4 Represents the acquired waveform. It is available for use
with eye diagram mask tests to locate bit errors in the
real-time waveform.

Bathtub 5 Represents the Bit Error Rate versus the unit interval for
measurements that include RJ/DJ analysis.
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Table 69: Plot type definitions (cont.)

Item Description

Q-Bathtub 6 Represents Q-Scale value versus the Unit interval for the
PCIe 3 Uncorrelated Jitter Measurements.

Q-PulseWidth 7 Represents Q-Scale value versus Time for the PCIe 3
Uncorrelated Pulse Width Jitter Measurements.

xxx

1 Available for all measurements except Mask Hits, DDR tJIT(duty), DDR tJIT(per), DDR tERR(n), DDR tERR(m–n), PCIe Tmin-Pulse, PCIe UI,
and PCIe Med-Mx Jitter.

2 Available only for Phase Noise measurement.
3 Available only for all Eye, TIE and PCIe-T-TXA measurements.
4 Available only for Mask Hits measurement.
5 Available only for TJ@BER and Width@BER measurements.
6 Available only for PCIe TTX-UDJDD and PCIe TTX-UTJ measurements.
7 Available only for PCIe TTX-UPWTJ and PCIe TTX-UPWDJDD measurements.

You can select the measurements from the displayed measurement list table on the left. The Plots for the
selected measurements are displayed in Select Plots. The plots which are not applicable for the selected
measurement are not available under Select Plots. You can select up to 4 plots.

Plot Usage

This section provides a description of various plots such as Histogram, Time Trend, Data Array, Spectrum,
Transfer, Phase Noise, Eye Diagram, Waveform, and Bathtub.

Histogram Plot Usage

A Histogram plot displays the results such that the horizontal axis represents the measurement values and
the vertical axis represents the number of times that each value occurred. Unlike most other plots, a
histogram plot can accumulate measurements over multiple acquisitions, up to a total population size of
2.1 billion.

Histograms are particularly useful in analyzing jitter. A histogram of the Time Interval Error (TIE)
represents the basis of jitter analysis using a histogram approach. In a histogram, Deterministic Jitter (DJ)
is bounded so that the horizontal span of the plot will remain relatively constant. Random Jitter (RJ) is
unbounded and amplitude (horizontal span) will continue to grow as more population is acquired. The TIE
histogram provides a good way to quickly and informally assess jitter.

Spectrum Plot Usage

A Spectrum plot is obtained from the Fourier Transform of measurement data from a Time Trend.
This plot is useful in identifying periodic frequency components that contribute to timing errors, such
as phase modulation.

When the signal has a repetitive data pattern, an analysis of the TIE Spectrum of the signal can be used to
separate Random Jitter (RJ) from Deterministic Jitter (DJ) as well as to separate subcomponents such as
Periodic Jitter (PJ), ISI and DCD. Spectral components (spikes ) that do not correlate with the frequencies
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contained in the data pattern can be a clue that external deterministic noise sources are coupling into a
system.

Data Array Plot Usage

A Data Array plot shows measurement values versus measurement index, where the indexes are always
equally spaced along the horizontal axis. In contrast, the measurement values on a Time Trend plot are
not equally spaced along the horizontal time axis.

Time Trend Plot Usage

A Time Trend plot is a waveform trace of a measurement versus time. Each measurement value is placed
precisely at the time at which the measurement took place. Measurements that involve two timing points
are placed at the midpoint between those two time. For example, a Risetime measurement is placed
halfway between the low threshold crossing and the high threshold crossing.

A Time Trend plot is useful, for example, in determining if the embedded clock in a serial bit stream is
modulated outside the capabilities of your receiver to recover the clock. If the TIE time trend plot starts
to take an unexpected periodic shape, then this could indicate that you have uncorrelated periodic jitter
from crosstalk or from power supply coupling.

Bathtub Plot Usage

A Bathtub curve is the industry standard way of viewing the statistical Jitter Eye Opening. A Bathtub
curve represents eye opening as a function of the BER (Bit Error Ratio). Most serial standards call for
Total Jitter to be measured at a BER of 10-12. The eye opening represented by the Bathtub Curve is what is
left of the unit interval after the total jitter measurement is subtracted.

The Jitter Eye opening and the Total Jitter have the following relationship:

Total Jitter + Jitter Eye Opening = 1 Unit Interval
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The Bathtub Curve plot shows the eye opening and total jitter values as functions of the BER level. The
plot is obtained from jitter analysis that performs RJ/DJ separation.

Q-Bathtub Plot Usage

TTX-UTJ and TTX-UDJDD are two jitter measurements in the PCI Express 3.0 Compliance Specification.
The Q-Bathtub plot provides a graphic visualization of the Q-Scale extrapolation used to arrive at the
measurement value. The plot represents the Q-Factor value on the y-axis over one unit interval on the
x-axis and the extrapolation points are clearly indicated.

Q-PulseWidth Usage

TTX-UPWTJ and TTX-UPWDJDD are two critical jitter measurements in the PCI Express 3.0
Compliance Specification. The Q-PulseWidth plot provides a graphic visualization of the Q-Scale
extrapolation used to arrive at the measurement value. The Q-Factor values lie on the y-axis, and the x-axis
represents a part of one unit interval significant for the measurement.

Phase Noise Plot Usage

A Phase Noise plot shows a frequency domain view of the jitter noise on a waveform normalized in
an industry-standard way. The vertical axis is logarithmic and uses the units of dBc/Hz, which means
“decibels (relative to the carrier) per Hertz”. The horizontal axis is logarithmic with units.

Transfer Function Plot Usage

A Transfer Function plot shows the magnitude ratio of the frequency spectrums of two measurements
on logarithmic axes. This can be a useful way to depict the response of a system to stimuli at various
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frequencies, or to identify poles and zeros in a system characteristic equation. Suppose that x(t) is a
jitter measurement at the input of a device, and y(t) is a corresponding jitter measurement at the output
of the device. The Transfer Function plot can be used to show the following function, where X(f) is
the Fourier Transform of x(t):

The horizontal axis of the Transfer Function plot goes up to the Nyquist frequency of X or Y, whichever is
lower. These plots work best if averaged across multiple acquisitions to reduce the effects of measurement
noise.

Waveform Plot Usage

The waveform plot is only applicable to the Mask Hits measurement. It depicts a copy of the source
waveform, with all mask violations denoted in a highlight color. These are the same violations that
appear on the Mask Hits eye diagram, but the waveform plot allows them to be seen in the context of a
continuous-time waveform.

Eye Diagram Plot Usage

An eye diagram is a plot of the voltage versus time for a serial bit stream, with the time axis “wrapped”
so that all unit intervals are superimposed on top of each other in a time-aligned fashion. Because the
resulting plot has many waveforms overlaid, color grading is used to separate areas with many coincident
waveforms from areas that are only rarely crossed.

If there is an area free of waveforms in the center of the diagram, the eye is said to be “open”,
and a comparator circuit repetitively sampling the waveform at this point in the unit interval could
unambiguously separate the two logic states. For experienced signal integrity engineers, the eye diagram
allows many common problems to be recognized instantly.
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Selecting Plots

Before or after you take measurements, you can set up plots for the selected measurements by following
these steps:

1. Click Plots in the navigation panel (see page 82) to view the Select Plot window. The currently active
measurements and source(s) are displayed in the table on the left (measurement table).

2. Click any of the plot icons that are available for the selected measurement. The corresponding plot
type and measurement are then added to a table on the right (plot table).

3. Add another plot for the current measurement, or select a different measurement and choose from its
plot types. A maximum of four plots can be selected at any given time.

Table 70: Plot selections

Item Description

Plots Lists only the plots which are available for the selected
measurement. Click a plot icon to add the plot type to the
table on the right.

Clear Selected Clears the selected plot from the plot table.

Clear All Clears all plots from the plot table.

Configure Allows you to adjust display options for the selected plot.

xxx

About Configuring Plots

Most plot types (except Data Array and Waveform) have display options that can be adjusted for each
instance of the selected plot.
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The steps to configure a plot are:

1. Select a plot instance by clicking on a row from plot table on the right.

2. Click Configure to display a pop-up window with the available configuration options.

3. Adjust the configuration options and click OK to accept the changes and close the window.

4. Click Show Plots in the control panel to view the configured plot.

NOTE. The Show Plots icon appears in the control panel (see page 82) only when one or more plots
are defined.

Related Topics

Configuring a Time Trend (see page 186)

Configuring a Histogram Plot (see page 186)

Configuring a Spectrum Plot (see page 185)

Configuring a Transfer Plot (see page 188)

Configuring a Phase Noise Plot (see page 189)

Configuring an Eye Diagram for Mask Hits (see page 191)

Configuring an Eye Diagram Plot for Eye Height (see page 189)

Configuring a Bathtub Plot (see page 183)

Configuring a Bathtub Plot

Select a Bathtub plot in the table on the right and click Configure to configure the plot.
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Item Description

Vertical Scale

Log Selects logarithmic scaling for the vertical axis.

Linear Selects linear scaling for the vertical axis.

Minimum Displayed BER=1E? Sets the lower axis limit for logarithmic plots to this value
(expressed as the negative of a base-10 exponent).

OK Accepts the changes and closes the window.

xxx
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Configuring a Spectrum Plot

Select a Spectrum plot in the table on the right to and click Configure to configure the plot.

Item Description

Vertical Scale

Log Selects logarithmic scaling for the vertical axis.

Linear Selects linear scaling for the vertical axis.

Base Sets the lower axis limit for logarithmic plots to this value
(expressed as a base-10 exponent). Available only when
the vertical scale is log.

Horizontal Scale

Log Selects logarithmic scaling for the horizontal axis.

Linear Selects linear scaling for the horizontal axis.

Mode Selects whether the plot shows only the most recent
spectrum, the uniform average of all spectrums since
the last time the results were cleared, or the peak of the
envelope of all spectrums since the last time the results
were cleared.

Normal - Shows magnitude values from the most recent
acquisition.

Average - Averages the magnitude values at each
frequency.

Peak Hold - Keeps the maximum value at each frequency.

OK Accepts the changes and closes the window.

xxx
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Configuring a Time Trend

Select a Time Trend plot in the table on the right and click Configure to configure the plot.

Item Description

Vector Connects measurement points with straight lines to form a
continuous waveform.

Bar Places a vertical bar at the horizontal position of each
measurement with a height (positive or negative) that
represents the value of that measurement; a horizontal
baseline represents the mean value of the Time Trend.

OK Accepts the changes and closes the window.

xxx

Configuring a Histogram Plot

Select a Histogram plot in the table on the right and click Configure to configure the plot.
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Item Description

Vertical Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the vertical axis.

Number of Bins

Resolution Defines resolution by the number of bins into which Span is
divided: 25, 50, 100, 250, or 500.

Horizontal Scale

Auto Scale Causes the horizontal scale of the histogram to be adjusted
automatically based on the accumulated data points.
If subsequently acquired data falls outside the current
horizontal scale, histogram bins are consolidated so that the
number of bins is preserved and the horizontal scale allows
all data to be plotted. When checked, disables the “Center”
and “Span” numerical inputs.

Center Manually sets the value for the horizontal center of the
Histogram, for subsequent plot updates. You can set values
up to 1 as (atto second) using your keyboard.

Span Manually sets the value for the total horizontal range of the
Histogram, for subsequent plot updates. You can set values
up to 1 as (atto second) using your keyboard.

Autoset Uses the results of the latest acquisition to determine
the logical values for the Center and Span options (if the
population of the measurement is three or more).

OK Accepts the changes and closes the window.

xxx
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Configuring a Transfer Plot

Select a Transfer Function plot in the table on the right and click Configure to configure the plot.

Item Description

Definition

Numerator Measurement for which the magnitude spectrum is used as
a reference.

Denominator Measurement for which the magnitude spectrum is used
to normalize the numerator.

Vertical Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the vertical axis (default).

Horizontal Scale

Linear Selects linear scaling for the vertical axis.

Log Selects logarithmic scaling for the horizontal axis (default).

Mode Selects whether the plot shows only the most recent
spectrum, or the uniform average of all spectrums since the
last time the results were cleared (default).

Normal - updates the plot with current values.

Average - averages the magnitude values at each
frequency.

OK Accepts the changes and closes the window.

xxx
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Configuring a Phase Noise Plot

Select a Phase Noise plot in the table on the right and click Configure to configure the plot.

Item Description

Vertical Position

Baseline Sets the lower axis limit for logarithmic plots to this value.

OK Accepts the changes and closes the window.

xxx

Configuring an Eye Diagram Plot for Eye Height

Select an Eye Diagram plot (for all eye measurements other than Mask Hits) in the table on the right and
click Configure to configure the plot.
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Item Description

Mask

On Enables display and mask testing.

Off Disables display and mask testing.

Browse Select a mask file to import from the C:\Users\Pub-
lic\Tektronix\TekApplications\DPO-

JET\Masks directory.

Horizontal Scale

Auto Scale When checked, causes the horizontal scale to be adjusted
automatically.

Resolution Manually sets the horizontal resolution, when Auto Scale
is unchecked.

Superimpose Reference Clock Eye (if available) When checked, superimposes DQS eye onto the data eye
diagram.

Ref Clock Amplitude

Scale to Ref Clock Scales the waveform to the one which is larger among the
superimposed eye when the Superimpose Reference Clock
Eye option is checked.

Scale to Data Autoscales to the vertical height of the data signal (DQ as in
DDRA) without regard to the reference clock (DQS) signal
amplitude.

Ref Clock Alignment Determines how an eye diagram is positioned on the plot.
The position is determined by the eye reference point,
which is the location of overlapping recovered or explicit
clock edge locations. Typically, the eye is located so that
waveform edges are approximately at 25% and 75% of the
width of the diagram. This ensures that the eye opening is
centered on the plot facilitating cursor measurements and
mask testing.

Auto Determines the alignment property automatically. Eye
diagram is aligned automatically. Auto is typically equivalent
to Left.

Center Eye reference point is centered on the plot. Center
alignment is appropriate for DDR Write bursts or other
signals with explicit reference clock where the clock and
data signals are out of phase.

Left Eye reference point is positioned on the left of the plot so
that eye opening is centered. Left alignment is appropriate
for DDR Read bursts and signals with recovered clock or
explicit clock where the clock and data signals are in phase.

OK Accepts the changes and closes the window.

xxx

Related Topics

Effect of Nominal Clock Offset on Eye Diagrams (see page 139)
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NOTE. If there is unwanted skew between the data and explicit clock signals, the channels must be properly
deskewed. Refer to your oscilloscope online help on how to deskew the channels.

Configuring an Eye Diagram for Mask Hits

An eye diagram plot is activated whenever a mask hits measurement is selected. Click Configure in
the plots panel to configure the plot.

Item Description

Mask Shows which mask has been selected (for the Mask Hits
measurement, the mask selection is performed as part of
measurement configuration rather than plot configuration).

Horizontal Scale

Auto Scale When checked, causes the horizontal scale to be adjusted
automatically.

Resolution Manually sets the horizontal resolution, when Auto Scale
is unchecked.

Superimpose Reference Clock Eye (if available) When checked, superimposes DQS eye onto the data eye
diagram.

Ref Clock Alignment Determines how an eye diagram is positioned on the plot.
The position is determined by the eye reference point,
which is the location of overlapping recovered or explicit
clock edge locations. Typically, the eye is located so that
waveform edges are approximately at 25% and 75% of the
width of the diagram. This ensures that the eye opening is
centered on the plot facilitating cursor measurements and
mask testing.
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Item Description

Auto Determines the alignment property automatically. Eye
diagram is aligned automatically. Auto is typically equivalent
to Left.

Center Eye reference point is centered on the plot. Center
alignment is appropriate for DDR Write bursts or other
signals with explicit reference clock where the clock and
data signals are out of phase.

Left Eye reference point is positioned on the left of the plot so
that eye opening is centered. Left alignment is appropriate
for DDR Read bursts and signals with recovered clock or
explicit clock where the clock and data signals are in phase.

OK Accepts the changes and closes the window.

xxx

Related Topics

Effect of Nominal Clock Offset on Eye Diagrams (see page 139)

NOTE. If there is unwanted skew between the data and explicit clock signals, the channels must be properly
deskewed. Refer to your oscilloscope online help on how to deskew the channels.

About Viewing Plots

You can create and configure up to four plots. If you already have measurement results, creating a plot will
cause it to be displayed immediately. If there are no current results, the plot will be created when you
sequence the application and results have been calculated. The Show Plots icon appears in the control

panel whenever at least one plot is defined. The Show Plots icon appears in the control panel
whenever at least one plot is defined. By default, all defined plots windows are grouped in a single window
on the upper half of the display, but the window can be moved, resized, or dragged to a second monitor.
The application includes tools to help you select which plots to view, to size and position the plot windows,
to save plot information, to use the zoom function, and to use the cursors functions.

If your Windows desktop is extended to a second monitor, you can drag the plots window to the second
monitor.

192 DPOJET Jitter and Eye Diagram Analysis Tools



Operating Basics Using a Second Monitor to View Plots

NOTE. When sequencing is complete, the plot window displays with the last plot selected. The plot window
also updates whenever you reconfigure a plot.

Using a Second Monitor to View Plots

If your oscilloscope setup includes a second monitor that extends the Windows desktop, you can select and
drag the title bar of the plot window to position it in the second monitor. This allows you to simultaneously
display a waveform on the oscilloscope, measurement results, and the plot for easy viewing.

Toolbar Functions in Plot Windows

The Plot Toolbar window includes the following functions:

Table 71: Plot toolbar functions

Icon Functions

Export Figure.

Print Figure.

Zoom and Pan.

Vertical and Horizontal Cursor controls.

Moving and Resizing Plots.

Plot properties.

Plot Summary Views.

Full view of plots 1 to 4.

xxx
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Moving and Resizing plots

You can move and resize plot windows the same way you would move and resize any window.

You can change the plot size to the whole display of the oscilloscope, or to half the display. When
viewing a plot in half the display, you can position the plot to the top or bottom. The tools also return
the plot to the original size. To position a plot quickly on the oscilloscope, select one of the following
tools in the plot window:

enlarges the plot to fill the entire display.

positions the plot to the top.

positions the plot to the bottom.

always keep the plot on top layer.

Using Zoom in a Plot

Once you have created a plot, you can use the Zoom tools to examine the data at various scales.

TIP. If you prefer to use the zoom functions in a plot window with your finger, you can activate the Touch
Screen on the oscilloscope.

Table 72: Zoom functions in a plot

Item Description

Zoom in (Horizontal and Vertical) – Expands part of the plot;
the data appears in more detail.

Zoom out – Contracts part of the plot; the data appears in
less detail.

Zoom in (Horizontal only) – Expands the horizontal axis only
and retains the vertical axis.

Resets the zoom to 100%.

xxx

Changing the Scale of Data in a Plot (Zoom)

To change the scale of the data in a Plot Details window, select one of the following plot zoom tools:

zooms in to expand the scale.

zooms out to contract the scale.
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zooms in to expand the horizontal axis only.

moves the plot anywhere within the scale.

zooms in to restore the entire waveform data.

When you select the tool, you can use a select-drag-release action to expand part of the waveform
(zoom in) by an arbitrary amount on both axes. After you select (touch with a finger or click with the
mouse) and begin dragging, a bounding box shows what part of the waveform will be expanded upon
release.

Select any part of the plot to expand the data by a factor of two (2X) equally on both axes. Double
selecting expands the data to the maximum factor.

To contract an expanded part of the data (zoom out), select anywhere on the data. The view contracts to
the values that existed before the most recent expansion of the data. Selecting multiple times will restore
successively earlier views. To expand the scale of the horizontal axis only by a factor of two (2X), click a
part of the waveform. The plot retains the scale of the vertical axis.

TIP. Select to see the entire available waveform.
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Using Cursors in a Plot

Cursors allow you to view numerical values associated with a plot based on cursor locations. There are
two types of cursors:

Horizontal cursors

Vertical cursors

Table 73: Cursor functions in a plot

Item Description

Displays the vertical coordinate where each cursor touches
the plot and the difference (Δ) between the cursors.

Displays the horizontal coordinate where each cursor
touches the plot and the difference (Δ) between the cursors.

Brings the cursors into the visible part of the plot.

Displays the plot properties.

xxx

Cursors in a Plot

You can use cursors to read the coordinate where each cursor (line) touches the plot and also view the
difference (Δ) between the two cursors. The steps to use cursors in a plot details window are:

1. Select any of the following cursors:

to use horizontal cursors.

to use vertical cursors.

to bring cursors into the visible plot.

2. Select and drag either cursor to move the cursor to the desired part of the plot. The cursor readout
changes to reflect the cursor position.

NOTE. You can drag cursors only when the Zoom functions are disabled.

TIP. If you prefer to move the cursors in the plot window with your finger, you can activate the touch
screen on the oscilloscope.
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Exporting Plot Files

You can export plot image in Plot Toolbar window. Click to save the contents of the plot window in
any of the format as a MATLAB figure format (.fig), .bmp, .jpg, .png, .emf, .tif, .mat and .csv.

The steps to export a plot file are:

1. Set up the plot window.

2. Select to save the plot as a figure.

3. Select the directory and enter a file name.

4. Click Save. The application saves the file in C:\%USERPROFILE%\Tektronix\TekApplica-
tions\DPOJET\images, where %USERPROFILE% represents your user location.

Printing Plots

The steps to print a plot are:

1. Verify that the printer is configured.

2. Set up the plot window with zoom, cursors, or grid functions.

3. Click icon in the plot details/summary window. The Print Preview dialog is displayed.

4. Click to set up the printing options and print a plot file.

NOTE. You can customize the print layout using the MATLAB page setup options. The DPOJET online
help does not provide information on MATLAB page setup. For more information, refer to the MATLAB
documentation.

About Reports

You can use the Reports to configure and generate a compliance report to view later or to share with others.
You can also access reports using Analyze > Jitter and Eye Analysis (DPOJET) > Reports. You can
select the option which you want to display in the report as shown in the following table:
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NOTE. When only the Mask Hits measurement is selected, the report shows only the Pass/Fail information.
If any other measurement having limits is selected along with the Mask Hits measurement, limit
information section is also included in the generated report.

Table 74: Report generation options

Item Description

Auto increment report name if duplicate Select/Clear the option to auto increment the report name
if its already existed. The auto generated report is of
YYMMDD_HHMMSS_savedfile.mht format.

View report after generating Select this option to view the report after generation.

Report Name Lists the directory path where the last generated report is
stored.

Save Saves the changes in the default report directory.
Manipulates the report name based on “Auto increment
report name if duplicate” option.

Save As Displays the browser where you specify the directory
to save the generated report. You can also edit the
report name in the Save As browser. By default, the
generated report is saved in C:\%USERPROFILE%\Tek-
tronix\TekApplications\DPOJET\Reports,
where %USERPROFILE% represents your user location.

Append Adds the current settings to an existing report.

View Opens the generated report in the default browser.

Content To Save

Include pass/fail results summary Select/Clear the option to include/exclude the pass/fail
status in the generated report.

Included detailed results Select/Clear the option to include/exclude the measurement
result details in the generated report.

Include plot images Select/Clear the option to include/exclude the plot images
like measurement plots and oscilloscope waveform in the
generated report.

Saving a report from Internet Explorer does not save plot
images.
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Table 74: Report generation options (cont.)

Item Description

Include setup configuration Select/Clear the option to include/exclude the setup
information like DPOJET version, oscilloscope version, and
status in the generated report.

Include complete application configuration Select/Clear the option to include/exclude the complete
configuration details in the generated report.

Save waveform file(s) along with report Select/Clear the option to include/exclude the oscilloscope
waveform details in the generated report.

Include user comments Select the option to include any comments in the generated
report. To do so, click the Add/Edit Comments button.

xxx

Reports Format

The generated reports are in .mht format and includes the following configured set of information:

Comments displays any user comments.

Setup Configuration such as DPOJET version and oscilloscope version.

Measurement Configuration such as measurement name, source and other configuration parameters.
Click on the measurement name to view the oscilloscope waveform details.

Source Reference Levels displays the reference voltage levels for the high, mid, and low thresholds
for the rising edge and for the falling edge of all sources, and the hysteresis.

Miscellaneous Settings such as Gating, Qualify and Population status.

Pass/Fail Summary indicating the Pass/Fail status for the selected measurements. Also displays the
limits information for measurements selected along with Mask Hits.

Measurement Results with statistics.

Plot Images includes both selected plots and oscilloscope waveforms.

Reference waveforms stored at includes the location of the waveforms used.
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Append Reports

Click the Append button to add the generated report to an existing report of the same format. The
application prompts you with a message “Do you wish to append the current results to xxx.mht”? before
the append action.

NOTE. Time stamp differentiates various appended reports.

Reports compatibility.

The application displays a warning when you try to append the report with other reports, generated using
previous versions of DPOJET. Click Yes to overwrite an old report with a newer format.

NOTE. If there is not enough disk space to save the report, the application displays “Cannot save file:
There may not be enough free disk space. Delete one or more files to free disk space, and then try again”.

Printing reports. You need to set the following while printing reports to get the alternate gray and white
rows in the table:

Select Internet Explorer, go to Tools > Internet Options.

In the Advanced tab, select the option Print Background Color and Images under Printing as shown.
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Saving waveform files. You can save waveform(s) used for the measurement by checking the option
“Save Waveform file(s) along with report” in the reports screen. The waveforms are stored under
C:\%USERPROFILE%\Tektronix\TekApplications\DPOJET\Reports, where %USERPROFILE%
represents your user location.

If one or more waveforms are to be saved, the report name is incremented for every append action by
including a number in the parenthesis as shown:

NOTE. If the waveform path name is greater than 128 characters, the applications displays a warning
even though the waveform is created with a truncated name (without a .wfm extension).
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Add Comments

Check “Include user comments” option to include the comments in the generated report. Click Add
comments in the report panel to include comments in the report. Add Comments changes to Edit
Comments in the report panel until all the contents are cleared in the Comment dialog box.

Item Description

Clear Clears the edited contents.

Copy Copies the edited contents.

Paste Pastes the copied contents in the new comments dialog box even after closing the window
without clicking “Ok”.

Cancel Closes the dialog box without saving any added contents.

Ok Saves the edited text.

xxx
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Introduction to the Tutorial

This tutorial teaches how to set up the application, take measurements, and view results as plots or statistics.

Before you begin the tutorial, perform the following tasks:

Set up the oscilloscope.

Start the application.

Recall the tutorial waveform.

NOTE. The screen captures shown in this section are from a DPO7254 oscilloscope.

Setting Up the Oscilloscope

The steps to set up the oscilloscope are:

1. Click File > Recall Default Setup in the oscilloscope menu bar to recall the default settings.

2. Press the individual CH1, CH2, CH3, and CH4 buttons as needed to add or remove active waveforms
from the display.

Starting the Application

Click Analyze > Jitter and Eye Analysis (DPOJET) > Select to open the application.

Waveform Files

The application provides the following tutorial waveforms:

Rt-EyeTutorial.wfm

ckminus_50gs_18g_20m_pat1.wfm

ckplus_50gs_18g_20m_pat1.wfm

dplus_50gs_18g_20m_pat1.wfm

dminus_50gs_18g_20m_pat1.wfm

The waveform files are found at C:\Users\Public\Tektronix\TekApplications\DPOJET\Exam-
ples.
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Recalling a Waveform File

To recall a waveform file, follow these steps:

1. Click File > Recall in the oscilloscope menu bar to display the Recall dialog box.

NOTE. If the application is in button mode, select the Recall button to recall the tutorial waveform.

2. ClickWaveform icon in the left of the Recall dialog box.

3. Select Ref1, Ref2, Ref3, or Ref4 as the Destination option.

4. Browse to select the waveform. Use the keypad to edit the waveform file name.

5. Click Recall. The oscilloscope recalls and activates the Reference Waveform control window.

6. Click On to display the waveform.

7. Click to return to the application. Alternatively, DPOJET can also be accessed from Analyze >
Jitter and Eye Analysis (DPOJET) > Select.

In the Summary tutorial, the tutorial waveforms are recalled as Math waveforms using the following setup:

dplus_50gs_18g_20m_pat1.wfm is recalled as Ref1 and dminus_50gs_18g_20m_pat1.wfm as Ref2.

NOTE. Using Math Setup ( Select Math > Math Setup in the menu bar to view the Math Setup dialog.
For more details, refer to the “Math Equation Editor: Controls in your oscilloscope online help), set
Math1=Ref1–Ref2 (Data signals)..

ckplus_50gs_18g_20m_pat1.wfm is recalled as Ref3 and ckminus_50gs_18g_20m_pat1.wfm as Ref4.

NOTE. Using Math Setup, set Math2 =Ref3–Ref4 (Clock Signals).

Taking a Period Measurement

In this lesson, you will learn how to take a period measurement and view the results. You can also learn the
following tasks:
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Select a measurement and a source

Configure measurement

Take measurements

View results as plots or statistics

View reports

Return to the application

Setting up a Period Measurement

Follow these steps to take a period measurement:

1. To set the application to default values, click File > Recall Default Setup. This is not necessary if
you have just started the application.

2. To view the DPOJET application, select Analyze > Jitter and Eye Analysis (DPOJET) > Select.

3. Go to Select in the left navigation panel. Click Period in the Measurements area. The application
shows the measurement and source selection on the right of the display. The current measurement
selection is displayed as Period1. The subsequent selections will be Period2, Period3 and so on. In
this example, Rt-EyeTutorial.wfm is recalled as Ref1 and is selected as source for Period1. New
measurements initially use the same source as the earlier measurement, or the most recently used
source.

4. Click or the row which lists the selected measurement to configure the source. Select Ref1 for
Period1. For more details, refer to Source Setup (see page 84).

5. Click Ref Levels Setup. The Configure Reflevel menu appears. For more details, refer to Ref
Levels (see page 96).

6. Click Configure in the left navigation panel of the main application window to view the configure
tabs. For more details, refer to About Configuring a Measurement (see page 104).

7. Click Plots to view the available plots for the selected measurement. Select Time Trend for Period.
For more details, refer to Configuring Time Trend (see page 186).

8. Click Single to run the application. When complete, the result statistics is shown in the results tab.
The plots are displayed as shown:
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NOTE. You can log result statistics (see page 49), measurement data points (see page 50) to a .csv file and
worst case waveforms (see page 60) to a .wfm file.

Taking a TIE Measurement

For jitter application, use the PLL TIE measurement. The steps to take a TIE measurement are:

1. To set the application to default values, click File > Recall Default Setup. This is not necessary if
you have just started the application.

2. Go to Select in the left navigational panel. Click Jitter tab to select TIE in the Measurements area.
The application shows the measurement and source selection on the right of the display. In this
example, Rt-EyeTutorial.wfm is recalled as Ref1 and is selected as source for TIE1.

3. Click or the row which lists the selected measurement to configure the source. Select Ref1 for
TIE1. For more details, refer to Source Setup (see page 84).
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4. Click Ref Levels Setup in the source configuration dialog. The Configure Reflevel menu appears. For
more details, refer to Ref Levels (see page 96).

5. Click Configure in the left navigation panel to view the configure tabs. For more details, refer to
Configuring Measurements (see page 104).

6. Click Plots to view the available plots for the selected measurement. Select Time Trend and Spectrum
plots for TIE measurement. For more details, refer to Configure Plots (see page 182).

7. Click Single to run the application. When complete, the result statistics is shown in the results tab.
The plots are displayed as follows:

NOTE. You can log result statistics (see page 49), measurement data points (see page 50) to a .csv file and
worst case waveforms (see page 60) to a .wfm file.

Taking an Eye Height and Width Measurement

For signal integrity application, use the Eye Height and Width measurements.

1. Select Analyze > Jitter and Eye Analysis (DPOJET) > Select to run the DPOJET application.

2. Go to Select in the left navigation panel. Click Eye tab to select Height and Width measurement. In
this example, Rt-EyeTutorial.wfm is recalled as Ref1 and is selected as source for Height1 and Width1.
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3. Select Ref1 as source for Height and Width measurements. For more details, refer to Source Setup
(see page 84).

4. Click Plots to view the available plots for the selected measurement. Select Eye Diagram for Height
measurement.

5. Select Eye diagram Plot type and click Configure to turn on the Mask in the Configure Eye Diagram
for Eye Height dialog. For more details, refer to the Configuring Eye Diagram Plot for Eye Height
(see page 189).

6. Select Histogram plot for Width measurement.

7. Click Single to run the application. When complete, the result statistics is shown in the results tab.

8. The Plot summary window is displayed as shown in the following figure:

NOTE. You can log result statistics (see page 49), measurement data points (see page 50) to a .csv file and
worst case waveforms (see page 60) to a .wfm file.
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Summary Tutorial

For a summary tutorial, the following example is considered:

Case 1: Period measurement with Low pass filters to show SSC profile:

1. Select Analyze > Jitter and Eye Analysis (DPOJET) > Select to run the DPOJET application. For
more details on waveforms recalled on Math1, Refer Recalling a Waveform File (see page 204).

2. Select Period measurement on Math1.

3. Click Configure. In the Filters configuration tab, select 2nd order low pass filter and specify the
cut-off frequency as 33 kHz. (F2= Fbaud/1667).

4. Go to Plots. Select Time Trend for Period measurement.

5. Click Single to run the application. When complete, the result statistics is shown in the results tab.
The Time Trend plot is as shown.

Case 2: A pair of TIE for showing jitter integration caused by SSC and the effect of a high pass filter
on SSC spectrum plots:

1. Click Jitter to select TIE measurement.

2. Select Math1 (see page 204) as the source for both TIE1 and TIE2.
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3. Click Configure. Do the following settings for TIE1 and TIE2 in the Filters configuration tab:

Select “No Filter” for TIE1.

Select 2nd order High Pass filter for TIE2. In this example, the F1 cut-off frequency is set to 1 GHz.

4. Go to Plots. Select Time Trend for both TIE1 and TIE2.

5. Select Spectrum plot for both TIE1 and TIE2.

6. Click Single to run the application. When complete, the result statistics is shown in the results tab.

7. A Plot Summary window shows Time Trend plots for TIE1, TIE2 and Spectrum plots for TIE1, TIE2.

NOTE. You can log results as statistics (see page 49), measurement data points (see page 50) to a .csv file
and worst case waveforms (see page 60) to a .wfm file.

Stopping the Tutorial

If you need more than one session to complete the tutorial lessons, you can stop the tutorial and return
to it later.

To save the application setup, refer to Saving a Setup File (see page 18). To exit the DPOJET application,

click present at the right corner of the application.

Returning to the Tutorial

To return to the tutorial setup, you can start the application and then recall the saved setup. To recall the
application setup, refer to Recalling a Saved Setup File (see page 18).
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About Parameters

This section describes the DPOJET application parameters and includes the menu default settings. Refer to
the user manual for your oscilloscope for operating details of other controls, such as front-panel buttons.

The parameter tables list the selections or range of values available for each option, the incremental unit of
numeric values, and the default selection or value.

Refer to the GPIB (see page 321) section for a complete list of the GPIB Command Syntax. The topics
include a complete list of the GPIB commands along with the arguments, variables, and variable values
that correspond to the DPOJET parameters.

Measurement Select Parameters

The Measurement Select includes the following measurement categories:

Period/Freq: Frequency, Period, CC–Period, N–Period, Pos Width, Neg Width, +Duty Cycle, –Duty
Cycle, +CC–Duty, and –CC–Duty.

Jitter: TIE, RJ, DJ, PJ, DDJ, DCD, RJ–δδ, DJ–δδ, TJ@BER, Jitter Summary, and Phase Noise.

Time: Rise Time, Fall Time, High Time, Low Time, Setup, Hold, Rise Slew Rate, Fall Slew
Rate, Skew, SSC Profile, SSC Mod Rate, SSC Freq Dev, SSC Freq Dev Min, SSC Freq Max, and
tCMD-CMD.

Eye: Height, Width, Mask Hits, Width@BER, Height@BER, Q-Factor, Eye High, and Eye Low.

Ampl: High, Low, DC Common Mode, AC Common Mode, High–Low, T/nT Ratio, Overshoot,
Undershoot, V–Diff –Xovr, Cycle Min, Cycle Max, and Cycle Pk-Pk.

Standard: Standard-specific measurements are as follows:

DDR: DDR Setup–SE, DDR Setup–Diff, DDR Hold–SE, DDR Hold–Diff, DDR tCK(avg),
DDR tCH(avg), DDR tCL(avg), DDR tERR(n), DDR tERR(m–n), DDR tRPRE, DDR tWPRE,
DDR tPST, DDR tJIT(duty), DDR tJIT(per), DDR Over Area, DDR VID(ac), DDR Under Area,
DDR tDQSS, GDDR5 tBurst-CMD, GDDR5 tCKSRE, GDDR5 tCKSRX, DDR2 tDQSCK,
DDR3 Vix(ac).

PCI Express: PCIe T-Tx-Diff-PP, PCIe T-TX, PCIe T-Tx-Fall, PCIe Tmin-Pulse, PCIe DeEmph,
PCIe T-Tx-Rise, PCIe UI, PCIe Med-Mx-Jitter, PCIe T-RF-Mismch, PCIe MAX-MIN Ratio
(Custom name is PCIe VRX-MAX-MIN Ratio), PCIe SSC FREQ DEV, PCIe SSC PROFILE,
PCIe AC Common Mode.

USB 3.0 Essentials: USB VTx-Diff-PP, USB TCdr-Slew-Max, USBTmin-Pulse-Tj, USB
Tmin-Pulse-Dj, USB SSC MOD RATE, USB SSC FREQ DEV MAX, USB SSC FREQ DEV
MIN, USB SSC PROFILE, USB UI, USB AC Common Mode.
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You can set the Source option as any of the following waveforms: Ch1, Ch2, Ch3, Ch4, Ref1, Ref2, Ref3,
Ref4, Math1, Math2, Math3, Math4, B1, B2, B3, B4, B5, B6, B7, B8, B9, B10, B11, B12, B13, B14, B15,
or B16 (bus source types are applicable for bus measurements only).

Table 75: Source parameters

Option Parameters Default

Source1 Ch1-Ch4, Math1-Math4, Ref1-Ref4 Ch1

Source1 B1–B16 User should configure

Source2 Ch1-Ch4, Math1-Math4, Ref1-Ref4 Ch2

xxx

Autoset Parameters

The Configure Source Autoset includes the following command buttons:

Vert Scale

Horiz Res

Vert & Horiz

Undo
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Ref Level Menu Parameters

The Configure Ref Level menu parameters includes the following command buttons:

Autoset

Setup

Option Parameters Default setting

Source Ch1-Ch4, Ref1-Ref4, Math1-Math4

Autoset Set, Clear Set

Rise High –20 V to 20 V 1 V

Rise Mid –20 V to 20 V 0 V

Rise Low –20 V to 20 V –1 V

Fall High –20 V to 20 V 1 V

Fall Mid –20 V to 20 V 0 V

Fall Low –20 V to 20 V –1 V

Hysteresis 0 to 10 V 30 mV

xxx

Autoset Ref Levels Parameters

Option Parameters Default setting

Base Top Method Min-Max

Low-High Histogram (Full
Waveform)

Low- High Histogram (Center of
Eye)

Auto

Auto

Rise High 1 to 99% 90%

Rise Mid 1 to 99% 50%

Rise Low 1 to 99% 10%

Fall High 1 to 99% 90%

Fall Mid 1 to 99% 50%

Fall Low 1 to 99% 10%

Hysteresis 0 to 50% 3%

xxx
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Preferences Parameters

The Analyze > Jitter and Eye Analysis (DPOJET) > Preferences includes the following tabs:

General

Measurement

Path Defaults

Option Parameters Default setting

General

Display Units Seconds, Unit Intervals Seconds

Default Image Type PNG, JPG, BMP PNG

Notifier Duration 2 to 20 s 5 s

Measurement

Limit Rise/Fall measurements to
transition bits only

Set, Clear Clear

Enable high-performance eye
rendering

Set, Clear Set

Halt free-run on a limit failure for any
measurement

Set, Clear Clear

Dual Dirac Model Fibre Channel,
PCI/FB-DIMM

PCI/FB-DIMM

Waveform Interpolation Type Linear, Sin(x)/x Linear

Path Defaults

Default image export directory Browser C:\%USERPROFILE%\Tektronix\TekAp-

plications\DPOJET\Images 1

Default logging export directory Browser C:\%USERPROFILE%\Tektronix\TekAp-

plications\DPOJET\Logs 1

Default report output directory Browser C:\%USERPROFILE%\Tektronix\TekAp-

plications\DPOJET\Reports 1

xxx

1 %USERPROFILE% represents your user location.
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Deskew Parameters

The Analyze > Jitter and Eye Analysis (DPOJET) > Deskew includes the following command buttons:

Perform Deskew

Summary

Option Parameters Default setting

Reference Channel

Source Ch1, Ch2, Ch3, Ch4 Ch1

Mid –20 V to 20 V 0 V

Hysteresis 0 to 10 V 30 mV

Channel to be Deskewed

Source Ch1, Ch2, Ch3, Ch4 Ch2

Mid –20 V to 20 V 0 V

Hysteresis 0 to 10 V 30 mV

Edges Rise, Fall, Both Rise

Deskew Range

Max Value –24.9 ns to 25 ns 1 ns

Min Value –25.0 ns to 24.9 ns –1 ns

xxx
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Data Logging Parameters

The application includes the following Log menus:

Statistics

Measurement

Worst Case

Option Parameters Default

Statistics

Select Target Measurements Set, Clear Set

Log Statistics Off, On Off

Data Log File Browser C:\%USERPROFILE%\Tek-

tronix\TekApplica-

tions\DPOJET\Logs\Sta-

tistics 1

Measurement

Select Target Measurements Set, Clear Set

Log Measurements Off, On Off

Folder Browser C:\%USERPROFILE%\Tek-

tronix\TekApplica-

tions\DPOJET\Logs\Mea-

surements 1

Worst Case

Select Target Measurements Set, Clear Set

Log Worst Case Waveforms Off, On Off

Folder Browser C:\%USERPROFILE%\Tek-

tronix\TekApplica-

tions\DPOJET\Logs\Wave-

forms 1

xxx

1 %USERPROFILE% represents your user location.
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Control Panel Parameters

The Control Panel menu includes the following command buttons:

Clear

Recalc

Single

Run

Show Plots

NOTE. Show Plots appears in the control panel only when one or more plots are selected.
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Bit Config Parameters

The Eye configure menu has the following parameters:

Option Parameters Default setting

Bit Type All Bits, Transition, Non-Transition All Bits

Mask * Browser C:\Users\Public\Tek-

tronix\TekApplica-

tions\DPOJET\Masks

Measure the Center of the Bit † 1 to 100% 1%

Method † Mean, Mode Mean

Measurement range (% UI) ‡ Start, End, # of Bins 50%, 50%, 1

xxx

* The Mask selector is available only for Mask Hits measurement.

† Available only for High, Low, and High–Low measurements.

‡ Available only for Height@BER measurement

Edges Parameters

The Edges configure menu depends on the measurement selected.

Edges-Two Source Parameters

Option Parameters Default setting

Clock Edge Rise, Fall, Both Rise

Data Edge Rise, Fall, Both Both

xxx

Edges-Phase Noise Parameters

Option Parameters Default setting

Active Edge Rise, Fall, Both Rise

Noise Integration Limits

Upper Frequency 0 to 1 T 1 MHz

Lower Frequency 0 to 1 T 0 Hz

xxx

Edges-CrossOver Parameters

Option Parameters Default setting

Main Edge Rise, Fall, Both Both

xxx
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Edges-TIE Parameters

Option Parameters Default setting

Signal Type Clock, Data, Auto Auto

Clock Edge Rise, Fall, Both Rise

xxx

Edges-Skew Parameters

Option Parameters Default setting

From Edge Rise, Fall, Both Both

To Edge Same as From, Opposite as From Same as From

xxx

Edges-N-Period Parameters

Option Parameters Default setting

Signal Type Clock, Data, Auto Auto

Clock Edge Rise, Fall, Both Rise

N= 1 to 1M 6

Edge Increment 1, 10 K 1

xxx

Edges-DCD Parameters

Option Parameters Default setting

Signal Type Clock, Data, Auto Auto

xxx

Edges-DDR tCH(avg) and DDR tCL(avg)

Option Parameters Default setting

Window Size 200 to 1M 200

xxx

Edges-DDR tERR(m-n)

Option Parameters Default setting

Clock Edge Rise, Fall Rise

Number of Periods

Maximum 6 to 50 The value varies for different DDR
generations. For example, for DDR
(6–10) measurement, the maximum
default is 10.
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Option Parameters Default setting

Minimum 2 to 50 The value varies for each DDR
generation. For example, for DDR
(6–10) measurement, the minimum
default is 6.

Window Size 200 to 1M 200

xxx

Edges-DDR tERR(n)

Option Parameters Default setting

Clock Edge Rise, Fall Rise

Number of Periods 2 to 50 The value varies for each DDR
generation. For example, for DDR
tERR(7per) measurement, the default
value is 7.

Window Size 200 to 1M 200

xxx

Edges-DDR tJIT(per), DDR tCK(avg) and DDRtJIT(duty)

Option Parameters Default setting

Clock Edge Rise, Fall Rise

Window Size 200 to 1M 200

xxx

Edges-Overshoot/Undershoot Measurements

Option Parameters Default setting

Ref Voltage –100 V to 100 V 0 V

xxx

Edges-Rise Slew Rate

Option Parameters Default setting

From Level Mid, Low Low

To Level High, Mid High

Slew Rate Technique Nominal Method, DDR Method Nominal Method

xxx

Edges-Fall Slew Rate

Option Parameters Default setting

From Level High, Mid High

To Level Mid, Low Low

Slew Rate Technique Nominal Method, DDR Method Nominal Method

xxx
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Edges-Time Outside Level

Option Parameters Default setting

Level High, Low, Both High

High Ref Voltage User selectable 0 V

xxx

Clock Recovery Parameters

The Clock recovery configure menu depends on the clock recovery method being selected.

PLL Clock Recovery Method Parameters

Option Parameters Default setting

PLL Standard BW

PLL Model Type I, Type II Type I

Standard: b/s IBA2500: 2.5G, PCI-E: 2.5G

FC133: 132.8M, FC266: 265.6M,
FC531: 531.2M, FC1063: 1.063G,
FC2125:2.125G,

SerATAG1:1.5G, SerATAG2:3.0,
SerATAG3:6.0G

USB FS:12M, USB HS:480M

1394b S400b: 491.5M, 1394b S800b:
983.0M, 1394b S1600b: 1.966G

GB Ethernet: 1.25G

100BaseT:125M

OC1:51.8M, OC3:155M, OC12:622M,
OC48:2.488G,

FC4250:4.25G, FC8500:8.5G

PCI_E_GEN2: 5.0G,IBA_GEN2:
5.0G

FBD1:3.2G, FBD2: 4.0G, FBD3: 4.8G

XAUI: 3.125G, XAUI_GEN2: 6.25G

SAS15:1.5G, SAS3: 3.0G, SAS6:
6.0G

RIO125: 1.25G, RIO250: 2.5G,
RIO3125: 3.125G

PCI-E: 2.5G

Damping 1 0.5 to 2 700 m

Loop BW 1 to 2.5 GHz 1.5 MHz

PLL Custom BW
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Option Parameters Default setting

PLL Model Type I, Type II Type I

Loop BW 1 to 2.5 GHz 1.5 MHz

xxx

1 Enabled only for Type II PLL models.

Constant Clock Recovery Method Parameters

Option Parameters Default setting

Constant Clock-Mean

Auto Calc First Acq, Every Acq First Acq

Constant Clock-Median

Auto Calc First Acq, Every Acq First Acq

Constant Clock-Fixed

Clock Frequency 1 Hz to 25 GHz 2.5 GHz

xxx

Explicit Clock Recovery Method Parameters

Option Parameters Default setting

Explicit Clock-Edge/Explicit Clock-PLL

Clock Source Ch1-Ch4, Ref1-Ref4, Math1-Math4 Ch2

Clock Edge Rise, Fall, Both Both

Clock Multiplier 1 to 10 K 1

xxx
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Advanced Clock Recovery Configuration Parameters

Option Parameters Default setting

PLL Custom BW/PLL Standard BW/ Constant Clock-Mean/Constant Clock-Median

Nominal Data Rate Off, On Off

Bit Rate 1 b/s to 25 Gb/s 2.5 b/s

Known Data Pattern On, Off Off

Pattern Filename Browse C:\Users\Public\Tek-

tronix\TekApplica-

tions\DPOJET\Patterns

Explicit Clock: Edge

Nominal Clock Offset Relative to Data Auto, Manual Auto

Recalculate Every acquisition, When required When required

Explicit Clock:PLL

PLL Method Type I,Type II Type I

Damping 0.5 to 2 700 m

Loop B/W 1 to 2.5 GHz 1.5 MHz

Nominal Clock Offset Relative to Data Auto, Manual (-1s to 1s) Auto

Recalculate When required, Every acquisition When required

xxx

SSC Parameters

The Spread Spectrum Clock menu has the following parameters:

Option Parameters Default setting

Nominal frequency

Auto Determined by instrument TBD

Manual User selectable 2.5 GHz

xxx

RJDJ Analysis Parameters

The RJDJ configure menu has the following parameters:

Option Parameters Default setting

Data Signal Settings

Pattern Type Repeating, Arbitrary Repeating

Pattern Length * 2 UI to 1M 2 UI

Window Length † 2 to 16 UI 5 UI

Population † 5 to 5000 100
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Option Parameters Default setting

Jitter Target BER

BER = 1E-? ‡ 2 to 18 in whole numbers 12

xxx

* Only for Repeating Patterns.
† Only for Arbitrary Patterns.
‡ Only for TIE, TJ@BER, and Width@BER measurements.

Filters Parameters

The Filter configure menu has the following parameters:

Option Parameters Default setting

High Pass (F1)

Filter Spec No Filter, 1st order, 2nd order, 3rd order No Filter

Freq (F1) 10 Hz to 1000 THz 1 kHz

Low Pass (F2)

Filter Spec No Filter, 1st order, 2nd order, 3rd order No Filter

Freq (F2) 10 Hz to 1000 THz 1 kHz

xxx

Advanced Filter Configure Parameters

The Advanced Filter Configuration includes the following parameters:

Option Parameters Default setting

Ramp Time 0/F to 10/F 2/F

Blanking Time 0/F to 10/F 4/F

xxx
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Bus State

The Bus State configure menu has the following parameters:

Table 76: Bus state options

Option Parameters Default setting

Use symbol file On, Off On

Enter pattern On, Off Off

Symbol MODE_REG, REFRESH, PRECHARGE,
ACTIVATE, WRITE, READ, SRX,
DESELECT, SRE, PDE

PDE

Measure at Clock Edge, Start, Stop Clock Edge

Clock Source Ch1, Ch2, Ch3, Ch4, Math1, Math2,
Math3, Math4, Ref1, Ref2, Ref3, Ref4

Ch2

Clock Polarity Rising, Falling Rising

From Symbol MODE_REG, REFRESH, PRECHARGE,
ACTIVATE, WRITE, READ, SRX,
DESELECT, SRE, PDE

MODE_REG

To Symbol MODE_REG, REFRESH, PRECHARGE,
ACTIVATE, WRITE, READ, SRX,
DESELECT, SRE, PDE

MODE_REG

Clock Edge Settings

To Symbol MODE_REG, REFRESH, PRECHARGE,
ACTIVATE, WRITE, READ, SRX,
DESELECT, SRE, PDE

MODE_REG

Measure at Clock Edge, Start, Stop Clock Edge

xxx

General Parameters

The General configure menu has the following parameters:

Option Parameters Default setting

Measurement Range Limits Off, On Off

xxx

Maximum and minimum values vary for different measurements. For more details, refer to Measurement
Values.
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Global Parameters

The Global configure menu has the following parameters:

Option Parameter Default setting

Gating

Gating Off, Zoom, Cursors Off

Qualify

Qualify Off, On Off

Qualify With Logic

Source Ch1-Ch4, Ref1-Ref4, Math1-Math4,
Search1-Search8

Ch1

Mid –20 V to 20 V O V

Hysteresis 0 to 10 V 30 mV

Active High, Low High

Population

Population Off, On Off

Population Limit

Limits By Population, Acquisitions Acquisitions

Limit 1 to 231 1 K

Stop Condition Each Measurement, Last
Measurement

Each Measurement

xxx
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Histogram Plot Parameters

The Histogram plot has Autoset as the command button.

Option Parameters Default setting

Vertical Scale Log, Linear Linear

Number of Bins

Resolution 25, 50, 100, 250, 500 250

Horizontal Scale

Auto Scale Set, Clear Set

Center 0 s to 1 Ts 100 ns

Span 0 s to 1 Ts 4 ns

xxx

Eye Diagram Plot Parameters

The Eye Diagram plot has the following parameters:

Option Parameters Default setting

On, Off OffMask

Browser C:\Users\Public\Tek-

tronix\TekApplica-

tions\DPOJET\Masks

Horizontal Scale

Auto Scale Set, Clear Set

Resolution 2.00E–13 to 2.00E–08 1.00E–12

Superimpose Reference Clock Eye
(if available)

Set, Clear Clear

Ref Clock Alignment Auto, Centre and Left Auto

xxx

Spectrum Plot Parameters

The Spectrum plot has the following parameters:

Option Parameters Default setting

Vertical Scale Log, Linear Linear

Base –20 to 15 –15

Horizontal Scale Log, Linear Linear

Mode Normal, Average, Peak Hold Normal

xxx
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Time Trend Plot Parameters

The Time Trend plot has the following parameters:

Option Parameters Default setting

Mode Vector, Bar Vector

xxx

Phase Noise Plot Parameters

The Phase Noise plot has the following parameters:

Option Parameters Default setting

Vertical Position

Baseline –200 to 0 –170

xxx

Bathtub Plot Parameters

The Bathtub plot has the following parameters:

Option Parameters Default setting

Vertical Scale Log, Linear Log

Minimum displayed BER= 1E-? 2 to 18 * 14

xxx

* Applicable for Log and Linear scale only.

Transfer Function Plot Parameters

The Transfer Function plot has the following parameters:

Option Parameters Default setting

Vertical Scale Log, Linear Log

Horizontal Scale Log, Linear Log

Mode Normal, Average Average

xxx
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Reports

The Reports menu has the following command buttons:

Save

Save As

Append

View

Add/Edit Comments

Option Parameters Default setting

Auto increment report name if
duplicate

Set, Clear Set

View report after generating Set, Clear Set

Content To Save

Include pass/fail results summary Set, Clear Set

Include detailed results Set, Clear Set

Include plot images Set, Clear Set

Include setup configuration Set, Clear Set

Include user comments Set, Clear Set

Include complete application
configuration

Set, Clear Set

Save Waveform file(s) along with
report

Set, Clear Clear

Report Name Browser C:\%USERPROFILE%\Tek-

tronix\TekApplica-

tions\DPOJET\Reports,
where %USERPROFILE% represents
your user location.

xxx
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Progress Bar Status Messages

Function/Measurement module Status/Message Description

Autoset-Source Autoset VertAuto-Chx Vertical autoset for Chx is going on.

Autoset-Source Autoset HorizAuto-Chx Horizontal autoset for Chx is going on.

Autoset-Source Autoset Zooming Horiz Zooming the horizontal scale after
horizontal autoset.

Autoset-Ref Level Autoset RefAuto-Chx Reference level autoset for Chx is
going on.

Autoset-Ref Level Autoset RefAuto-Refx Reference level autoset for Refx is
going on.

Autoset-Ref Level Autoset RefAuto-Mathx Reference level autoset for Mathx is
going on.

Sequencing Sequencing Refers to the measurement
setup-edge extraction.

Measurement Name Running the measurement specified
by name.

Plotting Plotting is started.

Bathtub Creating Bathtub plot.

Spectrum Creating spectrum plot.

Time Trend Creating time trend plot.

Histogram Creating Histogram plot.

Transfer Func Creating Transfer Function plot.

Eye Mask Hits Creating Eye Diagram plot.

Eye Height Creating Eye Diagram plot.

Data Array Creating Data Array plot.

Plots

Phase Noise Creating Phase noise plot.

Edge Extraction Finding Edges Extracting Edges from signal
waveform.

Clock Data Recovery Recovery Clk Clock and Data recovery.

Worst case logging Saving WC Wfm Logging the worst case waveform.

Trigger Slow Trigger Waiting for trigger/trigger not available.

Measurements Name Progress Bar Display

Amplitude High Low Ampl High–Low

Amplitude HighV Amp High

Amplitude LowV Ampl Low

CMV Common Mode

DCD DCD

DDJ DDJ

DiffXovrV V-Diff-Xovr

DJ DJ
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Function/Measurement module Status/Message Description

DJδδ DJ–δδ

EdgeExtractor Edge Extractor

EyeHeight Eye Height

EyeHeightBER Eye Height@BER

EyeMaskHits Eye Mask Hits

EyeWidth Eye Width

EyeWidthBER Eye Width@BER

FallTime Fall Time

Frequency Freq

HighTime High Time

Hold Hold

LowTime Low Time

NegativeDutyCycle –Duty Cycle

NegativeDutyCycleCycle –CC–Duty

NegativeWidth Neg Width

NPeriod N–Period

PerCycleCycle CC–Period

Period Period

PhaseNoise Phase Noise

PJ PJ

PositiveDutyCycle +Duty Cycle

PositiveDutyCycleCycle +CC–Duty

PositiveWidth Pos Width

RiseTime Rise Time

RJ RJ

RJδδ RJ–δδ

Setup Setup

Skew Skew

TIE TIE

TJ TJ@BER

TNTRatio T/nT Ratio

xxx

Error Codes

Code Description

E102 File does not exist

E103 DPOJET is not able to open the help file. In order to use the help file, please reinstall
DPOJET.
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Code Description

E104 Mask Hits measurement requires an Eye diagram plot but no more plots can be
assigned. Please remove a plot before adding a Mask Hits measurement.

E105 The maximum number of plots you can select is 4.

E106 No Spectrum plot data is available.

E107 This plot type is not configurable.

E109 The SSC PROFILE measurement requires an Time Trend plot but no more plots can be
assigned. Please remove a plot before adding a SSC PROFILE measurement.

E202 The upper range must be greater than the lower range.

E400 A measurement failed to complete successfully.

W410 Number of edges are not sufficient for a measurement.

E411 In at least one zone, there are too few edges to complete a measurement.

E424 No edges or UI of the required type were found in the waveform. If this is not a clock
signal, check the Vref threshold and record length.

E425 No transitions of the selected Bit Type were found in the waveform.

E426 Result has 0 population since all measurement points fall within the PLL's settling time.
Either acquire a longer waveform, or increase the PLL's bandwidth.

E500 The record lengths of the source waveforms differ. Please configure for sources with
equivalent record lengths.

E1001 Vertical Autoset Failed: Signal on Source x has extreme offset.

E1002 Vertical Autoset Failed: Amplitude of Source x is too small.

E1003 Vertical Autoset Failed: Amplitude or DC offset of Source x is too high.

E1004 Vertical Autoset Failed: No signal on Source x.

E1005 Vertical Autoset Failed: Signal on Source x exceeds top of scale.

E1006 Vertical Autoset Failed: Signal on Source x exceeds bottom of scale.

E1007 Vertical Autoset Failed: Signal on Source x is clipped on top.

E1008 Vertical Autoset Failed: Signal on Source x is clipped on bottom.

E1009 Vertical Autoset Failed: Measurement error ( ISDB error code = 6 ) on Source x.

E1010 Vertical Autoset Failed: Measurement error ( ISDB error code = 7 ) on Source x.

W1011 A change to Source x vertical settings caused overload disconnect. Original settings
are restored and Source x is reconnected. Ignore oscilloscope message.

E1012 Vertical Autoset Failed: None of the selected measurements use live sources
(Ch1-Ch4). Vertical autoset works for live sources only.

E1013 Vertical Autoset Failed: Invalid signal on Source x.

E1020 Horizontal Autoset Failed: None of the selected measurements use live sources
(Ch1-Ch4). Horizontal autoset works for live sources only.

E1021 Horizontal Autoset Failed: On Source x, cannot determine resolution of rising/falling
edges.

E1022 Horizontal Autoset Failed: Horizontal resolution is at the maximum.

E1026 Horizontal Autoset Failed: Source amplitude is too low.

E1027 Horizontal Autoset Failed: Signal is clipped at the top - positive clipping.

E1028 Autoset Failed: Signal is clipped at the bottom - negative clipping.
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E1029 Horizontal Autoset Failed: Signal frequency is extremely low.

E1035 Oscilloscope has gone into invalid state. Please restart the system.

E1040 Autoset Failed: None of the live sources (Ch1-Ch4) selected.

W1051 Ref Level Autoset: Waveform for the source x is clipped.

W1053 Ref Level Autoset: Source amplitude is extremely low.

E1054 Ref Level Autoset: Error in setting reference levels.

E1055 Ref Level Autoset Failed: No waveform to measure.

E1056 Ref Level Autoset: Unstable Histogram for waveform on source x.

E1057 Ref Level Autoset: No selected source.

E1058 Ref Level Autoset Failed: Invalid signal on source x.

E1059 Ref Level Autoset Failed: High/Low Method measures High = Low on.

E1060 Ref Level Autoset Failed: Max/Min Method measures Max = Min on.

E1061 Since Digital Filters (DSP) Enabled, Maximum sampling rate has been retained.
To enable adaptive use of lower sampling rate, please choose Analog Only under
Vertical->Bandwidth Enhanced.

E1062 The maximum Record Length (RL) in autoset is restricted to 25M, set the RL manually
for > 25M.

E1063 The minimum Record Length (RL) in autoset is restricted to 500K, set the RL manually
for < 500K.

W1064 Ref Level Autoset: Unable to trigger.

E2001 The maximum number of measurements has been reached.

E2002 All the refs are used as sources by the measurements. Export to Ref is not possible.

E2003 Ref ‘x’ is already used as a measurement source.

E2004 Ref ‘x’ is already used as a destination for other measurement.

E2005 No measurement(s) are selected. Export to Ref is not possible.

E2006 No results available to export to ref.

E2007 There are no time trend results for the selected measurement(s).

E2008 No ref destination is selected. Results will not be exported to ref.

E3001 Could not open or create a log file. Please ensure that you have read/write permission
to access log folders and files.

E3002 The specified path is invalid (for example, the specified path is not mapped to a drive).

E3003 The specified path, file name or both exceed the system defined length. For example,
on Windows-based platforms, the path name must be less than 248 characters and file
names less than 260 characters.

E3004 The specified path directory is read-only or is not empty.

E3005 Please ensure that the file is currently not in use by other process and/or has not
exceeded the file size limit.

E3006 Invalid filename: Check whether the file name contains a colon (:) in the middle of
the string.

E3007 Select at least one measurement from the table before you save.

E3008 There are currently no results to save. Please run a measurement.
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E3009 Current statistics is successfully saved at C:\%USERPROFILE%\Tektronix\TekApplica-
tions\DPOJET\Logs\Statistics, where %USERPROFILE% represents your user location.

E3010 Access to file/directory denied. Please ensure that the file/directory has read/write
permissions.

E3011 Mask Hits Measurements will not be selected as this feature is not available for Mask
Hits measurement.

E3012 Folder does not exist.

E4000 Not enough data points. Unable to render plot(s).

E4001 Internal measurement error. Please remove a measurement and try again.

E4002 Not enough data points for spectrum computation.

E4003 Due to high memory usage, only a portion of the waveform could be processed. Please
reduce your record length or the number of measurements.

E4004 An error occurred in the edge extraction process.

E4005 Qualifier: The record length and sample interval must match across the waveforms.

E4006 A maximum of 4096 qualifier zones is supported. The entire waveform will not be
processed and hence partial measurement results are available.

E4007 Logic Qualifier enabled and no qualifier zones found.

W4008 The configured Ref voltage for Overshoot must be greater than or equal to the mid
autoset ref levels.

W4009 The configured Ref voltage for Undershoot must be lesser than or equal to the mid
autoset ref levels.

E4013 The configured Ref voltage must be greater than or equal to the mid autoset ref levels.

E4014 The configured Ref voltage must be lesser than or equal to the mid autoset ref levels.

E4015 ‡ One or more qualifier zones had too few edges for measurement calculation.

E4016 Not enough edges in the waveform for measurement calculation.

E4017 Qualifier not enabled and hence no qualifier zones found. Please enable the qualifier.

E4018 The preamble is incomplete in all the qualifier zones.

E4019 ‡ The preamble is incomplete in one or more qualifier zones.

E4020 The postamble is incomplete in all the qualifier zones.

E4021 ‡ The postamble is incomplete in one or more qualifier zones.

E4022 ‡ Not enough samples present in the qualifier zones. Please increase the sampling
rate and reacquire the waveform.

E4023 The configured ref levels are not correct. The high ref level should be >= Mid and Mid
should be >= Low for both Rise and Fall slopes. Reconfigure the ref levels and run
the measurement.

E4024 Could not compute proper High and Low values.

W4025 The signal does not cross the configured Ref Voltage and hence the result shows zero
population. Please adjust the Ref voltage value.

W4026 Command Patterns were not found in the required order.

E4027 From Symbol not found in the acquisition.

E4028 To Symbol not found in the acquisition.
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Code Description

E4029 The configured High Ref voltage must be ≥ to the mid autoset ref levels.

E4030 The configured Low Ref voltage must be ≤ to the mid autoset ref levels.

E4031 The configured High Ref voltage must be ≥ to the mid autoset ref levels and the
configured Low Ref voltage must be ≤ to the mid autoset ref levels.

E4032 Set up the DDR Search and turn on the Qualifier to run this measurement.

E4033 Required command was not found after the burst.

E4034 Self Refresh Entry command is not registered in the current acquisition.

E4035 Self Refresh Exit command is not registered in the current acquisition.

E5005 1 Occurs while running setup. Please make sure you have finished any previous setup
and closed other applications.

W5005 The path or file name exceeds the system limit of 260 characters.

W9005 Derating value calculated using single Slew Rate measurement value.

W9006 Derating value cannot be computed since the calculated Slew Rate is not present in
the derating table †.

E9007 Derating Error *.

xxx

* Slew Rate measurements used to calculate the derated value failed to Run as there are no sufficient edges on the Rise and Fall slopes of
the waveform.

Base measurement limits are not defined as per the specification.
† Signal Slew Rate value is outside the derating table (Example: If DDR2-800 MT/s tDS derating with a differential probe has a DQS differential slew

rate of 0.65 V/ns, this warning message is displayed as the derating table definition starts from 0.8 V/ns).

Derating value is not supported (TBD) in the specification (Example: If the DQS differential slew rate is 2.0 V/ns and the DQ slew rate is 0.7 V/ns,
then the value is -(TBD).

Derating will not be applied for the above cases and the base limit will be displayed in the results table.
‡ Displays the zone number for which the preamble/postamble fails.
1 This error occurs during DPOJET installation on a DPO/MSO oscilloscope. Delete the Installshield folder under C:\Program files\Common Files

and delete all files and folders under C:\Windows\Temp folder. Restart the installation again.

Measurement Values

The following table lists the maximum and minimum values of all measurements:

NOTE. Measurement Range Limits are provided for each measurement under the General configure
tab of the DPOJET application. These range limits are always ON (OFF is disabled) for two-source
measurements such as Skew, Setup, Hold and others. The range limits are used by the algorithms to
associate the valid edge of first source to the valid edge of the second source.

Measurement range limits (Max) Measurement range limits (Min)

Name Default Max Min Default Max Min

Period/Freq measurements

Period 1 ms 1 ks 0 ns 0 ns 1 ks 0 ns

CC–Period 1 ns 1 s 1 fs –1 ns –1 fs –1 s
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Measurement range limits (Max) Measurement range limits (Min)

Name Default Max Min Default Max Min

Freq 10 GHz 50 GHz 1 MHz 10 kHz 50 GHz 1 MHz

N–Period 1 ms 1 ks 0 ns 0 ns 1 ks 0 ns

Pos Width/
Neg Width

10 ns 1 Ms 1 ps 1 ns 1 Ms 1 ps

+Duty
Cycle/–Duty
Cycle

90 % 100 % 0 % 10 % 100 % 0 %

+CC–Duty/
–CC–Duty

1 ns 1 ks –1 ks –1 ns 1 ks –1 ks

Jitter Measurements

TIE 1 ns 1 µs –1 µs –1 ns 1 µs –1 µs

RJ 1 ns 1 µs 0 ns 1 ns 1 µs 0 ns

RJ–δδ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns

TJ@BER 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns

DJ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns

DJ–δδ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns

Phase Noise 1 ms 1 ms 0 s 0 s 1 ms 0 s

DCD 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns

DDJ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns

PJ 1 ns 1 µs 0 ns 0 ns 1 µs 0 ns

Time Measurements

Rise Time 200 ns 1 ks 0 ns 0 s 1 ks 0 ns

Setup 10 ns 1 s –1 s 0 ns 1 s –1 s

High Time 10 ns 1 Ms 1 ps 0 s 1 Ms 1 ps

Fall Time 200 ns 1 ks 0 ns 0 s 1 ks 0 ns

Rise Slew
Rate

1 V/ns 100 V/ns 1 uV/ns 0 V/ns 0 V/ns –100 V/ns

Fall Slew
Rate

0 V/ns 0 V/ns –100 V/ns –1 V/ns –1 uV/ns –100 V/ns

Hold 10 ns 1 s –1 s 0 ns 1 s –1 s

Low Time 10 ns 1 Ms 1 ps 0 s 1 Ms 1 ps

Skew 10 ns 1 s –1 s –10 ns 1 s –1 s

SSC Profile 1 ms 1 ks 0 s 0 s 1 ks 0 s

SSC Mod
Rate

10 kHz 50 GHz 100 Hz 1 kHz 50 GHz 100 Hz

SSC Freq
Dev

1 kppm 1 Gppm -1 Gppm -1 kppm 1 Gppm -1 Gppm

SSC Freq
Dev Min

1 kppm 1 Gppm -1 Gppm -1 kppm 1 Gppm -1 Gppm
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Measurement range limits (Max) Measurement range limits (Min)

Name Default Max Min Default Max Min

SSC Freq
Dev Max

1 kppm 1 Gppm -1 Gppm -1 kppm 1 Gppm -1 Gppm

Time Outside
Level

1 ms 1 ks 0 s 0 s 1 ks 0 s

tCMD-CMD 1 ms 1 ks 0 s 0 s 1 ks 0 s

Eye Measurements

Height 500 mV 1 kV 0 mV 50 mV 1 kV 0 mV

Height@
BER

500 mV 1 kV 0 mV 50 mV 1 kV 0 mV

Width 1 ns 1 s 0 ps 50 ps 1 s 0 ps

Mask Hits 500 Hits 1 MHits 0 Hits 0 Hits 1 MHits 0 Hits

Width@BER 0.9 UI 1.0 UI 0 UI 0.1 UI 1.0 UI 0 UI

Eye High 500 mV 10 V -10 V -500 mV 10 V -10 V

Eye Low 500 mV 10 V -10 V -500 mV 10 V -10 V

Q-Factor 1 k 1 G 0 0 1 G 0

Amplitude Measurements

DC Common
Mode

500 mV 10 V –10 V –500 mV 10 V –10 V

AC Common
Mode

500 mV 10 V –10 V –500 mV 10 V –10 V

High 500 mV 10 V –10 V –500 mV 10 V –10 V

T/nt-Ratio 8 dB 12 dB –12 dB 0 dB 12 dB –12 dB

High–Low 500 mV 10 V –10 V –500 mV 10 V –10 V

Low 500 mV 10 V –10 V –500 mV 10 V –10 V

V–Diff–Xovr 500 mV 10 V –10 V –500 mV 10 V –10 V

Overshoot 500 mV 10 V 0 V –500 mV 10 V 0 V

Undershoot 500 mV 10 V 0 V –500 mV 10 V 0 V

Cycle Pk-Pk 500 mV 10 V -10 V –500 mV 10 V –10 V

Cycle Min 500 mV 10 V -10 V –500 mV 10 V –10 V

Cycle Max 500 mV 10 V -10 V –500 mV 10 V –10 V

Standard-Specific Measurements

DDR
Setup–SE

10 ns 1 s –1 s 0 ns 1 s –1 s

DDR
Setup–Diff

10 ns 1 s –1 s 0 ns 1 s –1 s

DDR
Hold–SE

10 ns 1 s –1 s 0 ns 1 s –1 s

DDR
Hold–Diff

10 ns 1 s –1 s 0 ns 1 s –1 s
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Measurement range limits (Max) Measurement range limits (Min)

Name Default Max Min Default Max Min

DDR
tCK(avg)

1 ms 1 ks 0 ns 0 ns 1 ks 0 ns

DDR
tCH(avg)

1 ms 1 ks 0 ns 0 ns 1 ks 0 ns

DDR
tCL(avg)

1 ms 1 ks 0 ns 0 ns 1 ks 0 ns

DDR
tJIT(duty)

10 ns 1 ms –1ms –10 ns 1 ms –1 ms

DDR
tJIT(per)

10 ns 1 ms –1 ms –10 ns 1 ms –1 ms

DDR
tERR(n)

10 ns 1 ms –1 ms –10 ns 1 ms –1 ms

DDR
tERR(m-n)

10 ns 1 ms –1 ms –10 ns 1 ms –1 ms

DDR tRPRE 2.5 ns 1 ks 0 s 0 s 1 ks 0 s

DDR tWPRE 2.5 ns 1 ks 0 s 0 s 1 ks 0 s

DDR tPST 2.5 ns 1 ks 0 s 0 s 1 ks 0 s

DDR Over
Area

660 mVs 1 kVs 0 Vs 0 Vs 1 kVs 0 Vs

DDR
UnderArea

660 mVs 1 kVs 0 Vs 0 Vs 1 kVs 0 Vs

DDR VID(ac) 500 mV 10 V –10 V –500 mV 10 V –10 V

DDR tDQSS 1 ms 1 ks 0 s 0 s 1 ks 0 s

DDR2
tCKSRE

1 ms 1 ks 0 s 0 s 1 ks 0 s

DDR3 Vix-
(ac)

500 mV 10 V –10 V –500 mV 10 V –10 V

PCIe Med-
Mx-Jitter

1 ms 1 ks 0 s 0 s 1 ks 0 s

GDDR5
tCKSRX

1 ms 1 ks 0 s 0 s 1 ks 0 s

GDDR5
tBurst-CMD

0 s 0 s -100 s -1 s -1 μs -100 s

GDDR5
tDQSCK

1 ms 1 ks -1 ks -1 ms 1 ks 0 s

PCIe AC
Common
Mode

500 mV 10 V –10 V –500 mV 10 V –10 V

PCIe T-RF-
Mismch

1 ns 1 ks 0 s 0 s 1 ks 0 s

PCIe MAX-
MIN Ratio *

1 V 10 V –10 V –1 V 10 V –10 V
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Measurement range limits (Max) Measurement range limits (Min)

Name Default Max Min Default Max Min

PCIe SSC
FREQ DEV

200 ns 1 ks 0 s 0 s 1 ks 0 s

PCIe SSC
PROFILE

1 ms 1 ks 0 s 0 s 1 ks 0 s

PCIe-T-Tx-
Diff-PP

1 V 10 V –10 V –1 V 10 V –10 V

PCIe T-TX 1 ns 1 s 0 s 50 ps 1 s 0 s

PCIe T-Tx-
Fall

200 ns 1 ks 0 s 0 s 1 ks 0 s

PCIe Tmin-
Pulse

1 ms 1 ks 0 s 0 s 1 ks 0 s

PCIe
DeEmph

8 dB 12 dB –12 dB 0 dB 12 dB –12 dB

PCIe T-Tx-
Rise

200 ns 1 ks 0 s 0 s 1 ks 0 s

PCIe UI 1 ms 1 ks 0 s 0 s 1 ks 0 s

T-TX-DDJ 1 ns 1 μs 0 s 0 s 1 μs 0 s

T-TX-UTJ 1 ns 1 μs 0 s 0 s 1 μs 0 s

T-TX-
UDJDD

1 ns 1 μs 0 s 0 s 1 μs 0 s

T-TX-
UPW-TJ

1 ns 1 μs 0 s 0 s 1 μs 0 s

T-TX-UPW-
DJDD

1 ns 1 μs 0 s 0 s 1 μs 0 s

V-TX NO-EQ 1.2 V 2 V 0 V 0 V 2 V 0 V

V-TX EIEOS 1.2 V 2 V 0 V 0 V 2 V 0 V

ps21TX 8 dB 12 dB –12 dB 0 dB 12 dB –12 dB

USB AC
Common
Mode

500 mV 10 V –10 V –500 mV 10 V –10 V

USB VTx-
Diff-PP

1 V 10 V –10 V –1 V 10 V –10 V

USB TCdr-
Slew-Max

200 ns 1 ks 0 s 0 s 1 ks 0 s

USB Tmin-
Pulse-Tj

1 ms 1 ks 0 s 0 s 1 ks 0 s

USB Tmin-
Pulse-Dj

200 ns 1 ks 0 s 0 s 1 ks 0 s

USB SSC
MOD RATE

200 ns 1 ks 0 s 0 s 1 ks 0 s
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Measurement range limits (Max) Measurement range limits (Min)

Name Default Max Min Default Max Min

USB SSC
FREQ DEV
MAX

200 ns 1 ks 0 s 0 s 1 ks 0 s

USB SSC
FREQ DEV
MIN

200 ns 1 ks 0 s 0 s 1 ks 0 s

USB SSC
PROFILE

1 ms 1 ks 0 s 0 s 1 ks 0 s

USB UI 1 ms 1 ks 0 s 0 s 1 ks 0 s

xxx

* Custom name for PCIe MAX-MIN Ratio is PCIe VRX-MAX-MIN Ratio.

Measurement Units

The following table lists the engineering multipliers that the DPOJET application uses.

Table 77: Measurement units

Abbreviation Unit Multiplier

y yocto or septillionths 1E-24)

z zepto or sextillionths 1E-21)

a atto or quintillionths 1E-18)

f femto or quadrillionths 1E-15)

p pico or trillionths 1E-12)

n nano or billionths 1E-09)

u micro or millionths 1E-06)

m milli or thousandths 1E-03)

one 1E+00)

k kilo or thousands 1E+03)

M mega or millions 1E+06)

G giga or billions 1E+09)

T tera or trillions 1E+12)

P peta or quadrillions 1E+15)

E exa or quintillions 1E+18)

Z zetta or sextillions 1E+21)

Y yotta or septillions 1E+24)

xxx
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About Algorithms

The DPOJET application can take measurements from one or two waveforms. The number of waveforms
used by the application depends on the type of measurement being taken.

Oscilloscope Setup Guidelines

For all measurements, use the following guidelines to set up the oscilloscope:

1. The signal is any channel, reference, or math waveform.

2. The vertical scale for the waveform must be set so that the waveform does not exceed the vertical
range of the oscilloscope.

3. The sample rate must be set to capture sufficient waveform detail and avoid aliasing.

4. Longer record lengths increase measurement accuracy but the oscilloscope takes longer to measure
each waveform.

Period

If the Signal Type is Clock

The Period measurement calculates the duration of a cycle as defined by a start and a stop edge. Edges
are defined by polarity, threshold, and hysteresis. The application calculates clock period measurement
using the following equation:

Where:

PClock is the clock period.

T is the VRefMid crossing time for the selected polarity.

If the Signal Type is Data

The Period measurement calculates the duration of a Unit Interval. The application calculates this
measurement using the following equation:

Where:
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PData is the data period.

TData is the VRefMid crossing time in either direction.

Kn =Cn–Cn-1 is the estimated number of unit intervals between two successive edges. Cn is the calculated
data bit index of TnData.

Each measurement result Pn Data is repeated Kn times in the measurement result vector, so that the
measurement population is equal to the number of unit intervals in the qualified waveform, rather than the
number of edge pairs.

Positive and Negative Width

Amount of time the waveform remains above/below the mid reference voltage level.

The application calculates these measurements using the following equations:

Where:

W+ is the positive pulse width.

W— is the negative pulse width.

T— is the VRefMid crossing on the falling edge.

T+ is the VRefMid crossing on the rising edge.
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Frequency

Frequency measurement calculates the inverse of the data period for each cycle.

If the Signal Type is Clock

The application calculates clock frequency measurement using the following equation:

Where:

FClock is the clock frequency.

PClock is the clock period measurement.

If the Signal Type is Data

The application calculates data frequency measurement using the following equation:

Where:

FData is the data frequency.

PData is the data period measurement.
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N-Period

If the Signal Type is Clock

The N–Period measurement calculates the elapsed time for N consecutive crossings of the mid reference
voltage level in the direction specified.

The application calculates this measurement using the following equation:

Where:

NPClock is the accumulated period for N clock cycles.

TClock is the VRefMid crossing time for the selected edge polarity.

If the Signal Type is Data

The N–Period measurement calculates the elapsed time for N consecutive unit intervals.

The application calculates this measurement using the following equation:

Where:

NPData is the duration for N unit intervals.

TData is the VRefMid crossing time in either direction.

If Tn+NData does not exist for a given n, no measurement is recorded for that position.
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Positive and Negative Duty Cycle

The +Duty Cycle and –Duty Cycle measurements calculate the ratio of the positive (or negative) portion of
the cycle relative to the period.

The application calculates these measurements using the following equations:

Where:

D+ is the positive duty cycle.

D— is the negative duty cycle.

W+ is the positive pulse width.

W— is the negative pulse width.

PClock is the period.

Related Topics

Period (see page 243)

Positive and Negative Width (see page 244)

CC-Period

The CC–Period measurement calculates the difference in period measurements from one cycle to the next.

The application calculates CC–Period measurement using the following equation:

Where:

ΔP is the difference between adjacent periods.

P Clock is the clock period measurement.
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Positive and Negative CC Duty

The + CC–Duty and – CC–Duty measurements calculate the difference in positive (or negative) pulse
widths from one cycle to the next.

The application calculates these measurements using the following equations:

Where:

ΔW+ is the difference between positive pulse widths of adjacent clock cycles.

ΔW— is the difference between negative pulse widths of adjacent clock cycles.

W+ is the positive pulse width measurement.

W— is the negative pulse width measurement.

TIE

TIE (Time Interval Error) is the difference in time between an edge in the source waveform and the
corresponding edge in a reference clock. The reference clock is usually determined by a clock recovery
process performed on the source waveform. For Explicit-Clock clock recovery, the process is performed
on an explicitly identified source.

If the Signal Type is Clock

The application calculates Clock TIE measurement using the following equation:

Where:

TIEClock is the clock time interval error.

TClock is the VRefMid crossing time for the specified clock edge.

T'Clock is the corresponding edge time for the specified reference clock.
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If the Signal Type is Data

The application calculates Data TIE measurement using the following equation:

Where:

TIEData is the data time interval error.

TData is the VRefMid crossing time in either direction.

T'Data is the corresponding edge time for the specified reference clock.

The subscript k is used to indicate that there is one measurement per Unit Interval, rather than one
measurement per actual edge.

RJ

Random Jitter (RJ) is the rms magnitude of all timing errors not exhibiting deterministic behavior. A single
RJ value is determined for each acquisition, by means of RJ/DJ separation analysis.

Related Topics

Jitter Analysis Through RJDJ Separation (see page 313)

Dual Dirac Random Jitter

Dual Dirac Random Jitter (RJ–δδ) is the rms magnitude of all timing errors not exhibiting deterministic
behavior, calculated based on a simplifying assumption that the histogram of all deterministic jitter can
modeled as a pair of equal-magnitude dirac functions (impulses). A single RJ–δδ value is determined for
each acquisition, by means of RJ/DJ separation analysis.

Related Topics

Jitter Analysis Through RJDJ Separation (see page 313)

Jitter Estimation Using Dual-Dirac Models (see page 317)

DPOJET Jitter and Eye Diagram Analysis Tools 249



Algorithms Jitter Summary

Jitter Summary

The Jitter Summary is not a single measurement. The Jitter Summary button on the graphical user interface
simply creates one each of all the other jitter measurements, as a convenience. This convenience function
is not supported via the programmable interface.

TJ@BER

Total Jitter at a specified Bit Error Rate (BER). This extrapolated value predicts a peak-to-peak jitter that
will only be exceeded with a probability equal to the BER. It is generally not equal to the total jitter
actually observed in any given acquisition. A single TJ@BER value is determined for each acquisition, by
means of RJ/DJ separation analysis.

Related Topics

Jitter Analysis Through RJDJ Separation (see page 313)

Estimation of TJBER and Eye WidthBER (see page 316)

DJ

Deterministic Jitter (DJ) is the peak-to-peak amplitude for all timing errors that follow deterministic
behavior. A single DJ value is determined for each acquisition, by means of RJ/DJ separation analysis.

Related Topics

Jitter Analysis Through RJDJ Separation (see page 313)
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Dual Dirac Deterministic Jitter

Dual Dirac Deterministic Jitter (DJ–δδ) the peak-to-peak magnitude for all timing errors exhibiting
deterministic behavior, calculated based on a simplifying assumption that the histogram of all deterministic
jitter can modeled as a pair of equal magnitude dirac functions (impulses). A single DJ–δδ value is
determined for each acquisition, by means of RJ/DJseparation analysis.

Related Topics

Jitter Analysis Through RJDJ Separation (see page 313)

Jitter Estimation Using Dual-Dirac Models (see page 317)

Phase Noise

The Phase Noise measurement performs a jitter measurement, converts the result into the frequency
domain, and reports the rms jitter integrated between two specific frequencies selected by the user.

The phase noise measurement is defined only for clock signals. If the source waveform appears to be a
data signal, a warning message will be produced but the measurement will proceed.

A Phase Noise measurement is required in order to enable the Phase Noise plot.

PJ

Periodic Jitter (PJ) is the peak-to-peak amplitude for that portion of the deterministic jitter which is
periodic, but for which the period is not correlated with any data pattern in the waveform. A single PJ
value is determined for each acquisition, by means of RJ/DJ separation analysis.

Related Topics

Jitter Analysis Through RJDJ Separation (see page 313)
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NPJ

Non-Periodic Jitter (NPJ) is the dual-dirac magnitude of that portion of Bounded Uncorrelated Jitter (BUJ)
that is not periodic. Since it is not periodic and is not correlated with the data pattern, NPJ is frequently
difficult to distinguish from (Gaussian) RJ.

This component of jitter is not analyzed by default, but you can enable it by switching the jitter analysis
mode to Spectral + BUJ. Since it typically requires high populations to distinguish, you may need to
acquire multiple waveforms before jitter results are available when Spectral + BUJ mode is enabled.

Related Topics

Separation of Non-Periodic Jitter (NPJ) (see page 316)

Preferences Jitter Decomp (see page 73)

DDJ

Data-Dependent Jitter (DDJ) is the peak-to-peak amplitude for that portion of the deterministic jitter
directly correlated with the data pattern in the waveform. A single DDJ value is determined for each
acquisition, by means of RJ/DJ separation analysis.

Related Topics

Jitter Analysis Through RJDJ Separation (see page 313)

DCD

Duty Cycle Distortion (DCD) is the peak-to-peak amplitude for that portion of the deterministic jitter
directly correlated with signal polarity, that is the difference between the mean positive edge displacement
versus that on negative edges. A single DCD value is determined for each acquisition, by means of
RJ/DJ separation analysis.

Related Topics

Jitter Analysis Through RJDJ Separation (see page 313)
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Rise Time

The Rise Time measurement is the time difference between when the VRefHi reference level is crossed
and the VRefLo reference level is crossed on the rising edge of the waveform. The Rise Time algorithm
uses the VRef values as the reference voltage level. Each edge is defined by the slope, voltage reference
level (threshold), and hysteresis.

The application calculates this measurement using the following equation:

Where:

T Rise is the Rise Time.

T Hi+ is the VRefHi crossing on the rising edge.

T Lo+ is the VRefLo crossing on the rising edge.

Fall Time

The Fall Time measurement is the time difference between when the VRefLo reference level is crossed
and the VRefHi reference level is crossed on the falling edge of the waveform. The Fall Time algorithm
uses the VRef values as the reference voltage level. Each edge is defined by the slope, voltage reference
level (threshold), and hysteresis.

The application calculates this measurement using the following equation:

Where:

T Fall is the Fall Time.

T Lo- is the VRefLo crossing on the falling edge.

T Hi- is the VRefHi crossing on the falling edge.
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Skew

The Skew measurement calculates the difference in time between the designated edge on a principle
waveform to the designated edge on another waveform. The closest data edge to the clock edge that falls
within the range limits is used.

The application calculates this measurement using the following equation:

Where:

T Skew is the timing skew.

T Main is the Main input VRefMidMain crossing time in the specified direction.

T 2nd is the 2nd input VRefMid2nd crossing time in the specified direction.

High Time

The High Time Measurement is the amount of time that a waveform cycle is above the VRefHi voltage
reference level.

The application calculates the measurement using the following equation:

Where:

T High is the high time.

T Hi- is the VRefHi crossing on the falling edge.

T Hi+ is the VRefHi crossing on the rising edge.
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Low Time

The Low Time measurement is the amount of time that a waveform cycle is below the VRefLo voltage
reference level.

The application calculates this measurement using the following equation:

Where:

T Low is the low time.

T Lo+ is the VRefLo crossing on the rising edge.

T Lo- is the VRefLo crossing on the falling edge.

Setup

The Setup Time measurement is the elapsed time between the designated edge of a data waveform and
when the clock waveform crosses its own voltage reference level. The closest data edge to the clock edge
that falls within the range limits is used.

The application calculates this measurement using the following equation:

Where:

T Setup is the setup time.

T Main is the Main input (clock) VRefMidMain crossing time in the specified direction.

T 2nd is the 2nd input (data) VRefMid2nd crossing time in the specified direction.

NOTE. The order of the input sources for Setup and Hold measurements (Source1 = Clock, Source2 =
Data) differs from the order of input sources on the Setup/Hold Trigger menu in the oscilloscope.
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Rise Slew Rate

The Rise Slew Rate is defined as the rate of change of the voltage between the crossings of the specified
VREFHI and VREFLO reference voltage levels. The voltage difference is measured between the VREFHI reference
level crossing and the VREFLO reference level crossing on the rising edge of the waveform. The time
difference is measured as the difference between the low time, and the low time at which VREFLO and VREFHI
are crossed. The Rise Slew Rate algorithm uses the high and low rise reference voltage levels to configure
the values. Each edge is defined by the slope, voltage reference level (threshold), and the hysteresis.

The application calculates this measurement using the following equation:

Reference

High Mid and Low Reference Voltage Levels (see page 97)
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Fall Slew Rate

The Fall Slew Rate is defined as the rate of change of the voltage at the specified VREFLO and VREFHI
reference voltage levels. The voltage difference is measured between the VREFLO reference level crossing
and the VREFHI reference level crossing on the falling edge of the waveform. The time difference is
measured as the difference between the high time and low time at which VREFHI and VREFLO are crossed.
The Fall Slew Rate algorithm uses the low time and high fall reference voltage levels to configure the
values. Each edge is defined by the slope, voltage reference level (threshold), and the hysteresis.

The application calculates this measurement using the following equation:

Reference

High Mid and Low Reference Voltage Levels (see page 97)
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Hold

The Hold Time measurement is the elapsed time between when the clock waveform crosses its own
voltage reference level and the designated edge of a data waveform. The closest data edge to the clock
edge that falls within the range limits is used.

The application calculates this measurement using the following equation:

Where:

THold is the hold time.

TMain is the Main input (clock) VRefMidMain crossing time in the specified direction.

T2nd is the 2nd input (data) VRefMid2nd crossing time in the specified direction.

NOTE. The order of the input sources for Setup and Hold measurements (Source1 = Clock, Source2 =
Data) differs from the order of input sources on the Setup/Hold Trigger menu in the oscilloscope.

SSC PROFILE

SSC Profile shows the modulation profile of the Spread Spectrum Clocking (SSC). It is the time trend plot
of the SSC profile. All SSC measurements use the Period measurement with a second order low pass filter.
Using the profile you can analyze the SSC modulation rate by using the horizontal cursors. You can also
analyze the peak-to-peak frequency deviation by using the vertical cursors.

The following are the default configurations that are required:

Constant Clock Recovery (CCR) Mean set as the Clock Recovery method.

Low pass filter with 1.98 MHz cut off frequency set by default. This is the standard FiberChannel
cut off frequency.

Available plots are Time Trend, Data Array, Histogram and Spectrum plots.
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SSC MOD Rate

SSC Mod Rate measurement computes the SSC modulating frequency.

The following are the default configurations that are required:

Constant Clock Recovery (CCR) Mean set as the Clock Recovery method.

Low pass filter with 1.98 MHz cut off frequency set by default. This is the standard FiberChannel
cut off frequency.

Available plots are Time Trend, Data Array, Histogram and Spectrum plots.

SSC FREQ DEV MIN

The SSC FREQ DEV MIN is defined as the minimum frequency shift as a function of time. It represents
the frequency deviation in terms of ppm (parts per million).

Find the 50% edges on the SSC profile.

Calculate the LOW value between the n and n+1 edge.

Find the Minimum frequency deviation as LOW.

The application calculates the measurement using the equation:

Freq Dev Min(ppm)= ((Minimum Freq–Nominal Data Rate)/Nominal Data Rate)* 1e6

Available plots are Time Trend, Data Array, Histogram and Spectrum plots.
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SSC FREQ DEV MAX

SSC FREQ DEV MAX is defined as the maximum frequency shift as a function of time. It represents the
frequency deviation in terms of ppm (parts-per-million).

Find the 50% edges on the SSC profile

Calculate the HIGH value between the n and n+1 edge

Find the Maximum frequency deviation as HIGH

The application calculates the measurement using the equation:

Freq Dev Max(ppm)= ((Maximum Freq – Nominal Data Rate)/Nominal Data Rate)* 1e6

The difference between the SSC FREQ DEV MAX and SSC FREQ DEV MIN measurements are that
they compute the maximum frequency deviation and minimum frequency deviation separately. By doing
this the limits can be applied separately.

Available plots are Time Trend, Data Array, Histogram and Spectrum plots.

SSC FREQ DEV

SSC FREQ DEV is defined as the SSC frequency deviation in ppm (parts per million).

The low pass filter is turned on by default with 1.98 MHz as the cut off frequency. This is set to the
standard FiberChannel cut off frequency.

Time Trend, Data Array, Histogram, and Spectrum plots are allowed for this measurement.

The application calculates the measurement using the equation:

FREQ DEVIATION = HIGH–LOW

Related Topics

High (see page 268)

Low (see page 268)
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tCMD-CMD

tCMD-CMD measures the elapsed time between two bus states, for example CMD_1 and CMD_2. For
each state, the relevant timing point can be specified as the start of the state, the end of the state, or a rising
or falling edge on a separately-specified clock source. The timing resolution of this measurement is
dependent on the sample clock used. For example, if the bus is composed of digital channels sampled
as 12.5 Gsps, the resolution is 80 ps.
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Time Outside Level

Time Outside Level is defined as the time interval of overshoot or undershoot. The measurement is taken
on both the rising and falling slopes.
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Eye Width

The Eye Width measurement is the measured minimum horizontal eye opening at the zero reference level.

The application calculates this measurement using the following equation:

Where:

UIAVG is the average UI.

TIE pk-pk is the Peak-Peak TIE.

Width@BER

Width@BER is the Eye Width at a specified Bit Error Rate (BER). This extrapolated value predicts a
horizontal eye opening that will be violated with a probability equal to the BER. It is generally not equal to
the eye width actually observed in any given acquisition. A single Width@BER value is determined for
each acquisition, by means of RJ/DJ separation analysis.

Related Topics

Jitter Analysis Through RJDJ Separation (see page 313)

Estimation of TJ@BER and Eye Width@BER (see page 316)
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Eye Height

The Eye Height measurement is the measured minimum vertical eye opening at the UI center as shown in
the plot of the eye diagram. There are three types of Eye Height values.

The application calculates this measurement using the following equation:

Where:

VEYE-HI-MIN is the minimum of the High voltage at mid UI.

TIEEYE-LO-MAX is the maximum of the Low voltage at mid UI.

Eye Height-Transition

The application calculates this measurement using the following equation:

Where:

VEYE-HI-TRAN-MIN is the minimum of the High transition bit eye voltage at mid UI.

TIEEYE-LO-TRAN-MAX is the maximum of the Low transition bit eye voltage at mid UI.

Eye Height-Non-Transition

The application calculates this measurement using the following equation:

Where:

VEYE-HI-NTRAN-MIN is the minimum of the High non- transition bit eye voltage at mid UI.

TIEEYE-LO-NTRAN-MAX is the maximum of the Low non-transition bit eye voltage at mid UI.
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Height@BER

Height@BER is the Eye Height at a specified Bit Error Rate (BER). This extrapolated value predicts a
vertical eye opening that will be violated with a probability equal to the BER. It is generally not equal
to the eye height actually observed in any given acquisition. A single Height@BER value, in the given
interval, is determined for each acquisition by means of Q-scale extrapolation.

Eye High

Eye High calculates the voltage at a selected horizontal position across the unit interval, for all High bits
in the waveform. You specify the offset at which the measurement takes place from 0% to 100% of the
unit interval. Configure the measurement to include all bits, only transition bits, or only non-transition
bits. (Note that some of the waveform can be omitted from the measurement due to initialization of clock
recovery or filtering.) A histogram of the Eye High measurement corresponds to a vertical slice through
the upper half of a three-dimensional eye diagram.
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Eye Low

Eye Low calculates the voltage at the selected horizontal position across the unit interval, for all Low bits
in the waveform. A histogram of the Eye Low measurement corresponds to a vertical slice through the
lower half of a three-dimensional eye diagram.

Q-factor

Quality Factor is the ratio of eye size to noise. Eye and Q factor measurements can be run together
and displayed onto a single window.

The final measurement value would be computed according to the equation below:

Q-factor = [mean(EyeHigh) - mean(EyeLow)] / [stddev(EyeHigh) + stddev(EyeLow)]

Where:

Eye High: the sample values of positive UI at x%.

Eye Low: the sample values of negative UI at x%.

For more details refer Eye Height
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Mask Hits

The Mask Hits measurement reports the number of unit intervals in the acquisition for which mask hits
occurred, for a user-specified mask. In the Results Summary view, the Mask Hits measurement reports
the total number of unit intervals for which a mask hit occurred in at least one mask zone. In the Results
Details view, the number of hits in each of three segments is reported. The population field shows the
total number of unit intervals measured.

The Mask Hits measurement has several unique properties:

Unlike other measurements, it requires a Mask hits plot. Adding a Mask Hits measurement will cause
the corresponding plot to be created automatically. If you delete a Mask Hits plot, the application will
remove the corresponding Mask Hits measurement after verifying the action with you.

The Mask Hits measurement does not support the Worst-Case Waveforms logging feature.

The Mask Hits measurement does not support Measurement Range Limits.
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High

The High Amplitude measurement calculates the mean or mode of a selected portion of each unit interval
corresponding to a “1” bit.

The application calculates this measurement using the following equation:

Where:

VHI is the high amplitude measurement result.

OP[• ] is the selected Operation (either Mean or Mode).

vPERCENT is the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

n is the index of a high bit, a high transition bit, or a high non-transition bit.

Low

The Low Amplitude measurement calculates the mean or mode of a selected portion of each unit interval
corresponding to a “0” bit.

The application calculates this measurement using the following equation:

Where:

VLOW is the low amplitude measurement result.

OP[• ] is the selected Operation (either Mean or Mode).

vPERCENT is the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

n is the index of a low bit, a low transition bit, or a low non-transition bit.
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DC Common Mode

The Common Mode Voltage measurement (also called DC Common Mode) calculates the mean of the
Common Mode voltage waveform.

The application calculates this measurement using the following equation:

Where:

VCM is the common mode voltage measurement.

is the common mode voltage waveform.

i is the sample index of common mode waveform values.

AC Common Mode

The AC Common Mode Voltage measurement is the common mode voltage between two single-ended
signals. AC is defined as all the frequency components above the cutoff frequency (30 kHz).

The application calculates this measurement using the following equations (based on two single-ended
sources from the DUT):

CM_Voltage = (Source1 + Source2) ÷ 2

AC_CMMp-p = Peak-to-Peak(High Pass filter (CM_Voltage))

Where:

AV_CMVp-p is the peak-to-peak common mode voltage.

T/nT Ratio

The T/nT Ratio measurement reports the amplitude ratio between transition and non-transition bits.

The measurement calculates the ratios of all non-transition eye voltages (2nd and subsequent eye voltages
after one edge but before the next) to their nearest preceding transition eye voltage (1st eye voltage
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succeeding an edge). In the accompanying diagram, it is the ratio of the Black voltages to the Blue
voltages. The results are given in dB.

The application calculates the T/nT Ratio using the following equations:

following a rising edge.

following a falling edge.

Where:

vEYE–HI–TRAN is the High voltage at the interpolated midpoint of the first unit interval following a positive
transition.

vEYE–LO–TRAN is the Low voltage at the interpolated midpoint of the first unit interval following a negative
transition.

vEYE–HI–NTRAN is the High voltage at the interpolated midpoint of all unit intervals except the first following a
positive transition.

vEYE–LO–NTRAN is the Low voltage at the interpolated midpoint of all unit intervals except the first following
a negative transition.

m is the index for all non-transition UIs.

n is the index for the nearest transition UI preceding the UI specified by m.
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In a time trend plot of the measurement results, there is one measurement for each non-transition bit in the
waveform (that is the black arrows in the diagram).

High-Low

The High–Low measurement calculates the change in voltage level across a transition in the waveform.

The application calculates the High–Low using the following equation:

Where:

VHIGH-LOW is the high-low amplitude measurement result.

n is the index of a selected transition.

i is the index of the UI (bit) location preceding the transition.

i+1 is the index of the UI (bit) location following the transition.

VLEVEL = OP[vPERCENT(i)] is the state level of the unit interval (bit period).

OP[• ] is the selected Operation (either Mean or Mode).

vPERCENT is the set of voltage samples over the selected portion (percent) of the unit interval, ranging
from 1% to 100%.

NOTE. If there are no waveform samples that fall within the identified percentage of the unit interval, the
single nearest waveform sample preceding the center point of the unit interval will be used.
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V-Diff-Xovr

The Differential Crossover Voltage measurement (V–Diff–Xovr) calculates the voltage level at the
crossover voltage of a differential signal pair. If there is timing jitter on one of the pair of signal lines
relative to the other, the crossover point will be modulated by the jitter. The measurement is calculated
using the following equation:

Where:

VCrossover is the crossing voltage.

V Source1 is the voltage of the first source waveform.

TCrossover is the crossover time, when the Source1 and Source2 waveforms are equal in voltage.

Overshoot

Overshoot is the maximum peak amplitude above the reference voltage level (see page 97) (VREF).
Non-differential signals (Single Ended) are required for this measurement such as DQS (SE) and CK(SE).
For DQS signals, Search and Mark should be enabled.

Reference

High Mid and Low Reference Voltage Levels (see page 97)

272 DPOJET Jitter and Eye Diagram Analysis Tools



Algorithms Undershoot

Undershoot

Undershoot is the maximum peak amplitude below the reference voltage level (see page 97) (VREF).
Non-differential signals (Single Ended) are required for this measurement such as DQS(SE) and CK(SE).
For DQS signals, Search and Mark should be enabled.

Reference

High Mid and Low Reference Voltage Levels (see page 97)

Cycle Max

Cycle Max is a voltage measurement which measures positive peak voltage for all cycles. It is the
maximum voltage for each cycle from the mid level of rise to the fall slope.

The application calculates this measurement using the following equation:

VCycleMax = Max(f(RiseIndex(i) to FallIndex(i+1))

Where:

I =1 to the valid edge of the last cycle.

f is the function, which finds the maximum sample point in the defined region.
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Cycle Min

Cycle Min is a voltage measurement which measures negative peak voltage for all cycles. It is the
minimum voltage for each cycle from the mid level of Fall to the Rise slope.

The application calculates this measurement using the following equation:

VCycleMin = Min(f(FallIndex(i) to RiseIndex(i+1))

Where:

I =1 to the valid edge of the last cycle.

f is the function, which finds the minimum sample point in the defined region.

Cycle Pk-Pk

Cycle Pk-Pk is a voltage measurement which measures the absolute difference between the maximum and
minimum amplitude for every cycle of the waveform. It calculates the peak-to-peak value for all cycles
of the waveform. The peak value is measured from Fall slope to the next rise if the valid slope is a Fall.
The next peak would be from Rise to next fall slope. The peak-to-peak value is calculated on all the
pairs of minimum and maximum values available.

The application calculates the Cycle Pk-Pk using the following equation:

for consecutive cycles

Where:

VMax(n) is the maximum peak amplitude.

VMin(n) is the minimum peak amplitude.

n is the number of cycles from 1 to the last valid edge.

DDR Setup and Hold Measurements

The following four measurements are modified versions of the basic Setup and Hold measurements found
on the Time tab. In contrast to the basic measurements which always use the Mid voltage reference to
determine edge times, these measurements use the High and Low references as required to conform to
some DDR specifications. For all these measurements, the Strobe signal (DQS) is assigned to Source1 and
the Data signal is assigned to Source2.
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The measurements with names ending in “–Diff” are appropriate if you have a have a differential Data
Strobe (DQS) signal. Either connect to DQS+ and DQS– with a differential probe, or acquire these
signals with two single-ended probes and create a (pseudo-) differential signal using a Math expression
(for example: “Math1 = Ch1 – Ch2”). In this case, the data (DQ) signal uses thresholds other than the
mid threshold, but the DQS signal uses a mid threshold set to 0 V.

Check that the DPOJET reference levels for the data source are set to match the proper values of VIH(ac),
VIH(dc), VIL(ac) and VIL(dc) for the DDR technology that you are measuring. Depending on which
edges you choose to measure (Rising, Falling or Both), you may not need to set up all of these levels.
For more details on reference level setup, refer to DDR Setup/Hold Reference Levels: Differential DQS
(see page 275).

The measurements with names ending in “–SE” are appropriate if you have a single-ended data strobe
(DQS) signal. This is allowed in DDR2 but not in DDR3. In this case, both the clock (DQS) and data (DQ)
signals use thresholds other than the mid threshold.

Check that the DPOJET reference levels for the strobe and data sources are set to match the proper
values of VIH(ac), VIH(dc), VIL(ac), and VIL(dc) for the DDR technology that you are measuring.
Depending on which edges you choose to measure (Rising, Falling or Both), you may not need to set up
all of these levels. For more details on the reference level setup, refer to DDR Setup/Hold Reference
Levels: Single-ended DQS (see page 277).

DDR Setup/Hold Reference Levels: Differential DQS

For systems with a differential DQS signal, the waveform reference points for the Setup (tDS) and Hold
(tDH) measurements details are as shown:
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For the Strobe channel (Source1), the mid reference level should be set to 0 V and the High and Low
references are not used. The reference levels for the Data channel (Source2) are mapped to the source
configuration panel as follows:

Typical values for the reference levels for some current technologies can be found here:

DDR2-400, DDR2-533 Reference Levels (see page 278)

DDR2-667, DDR2800 Reference Levels (see page 278)

DDR3-800 through DDR3-1600 Reference Levels (see page 279)
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DDR Setup/Hold Reference Levels: Single-Ended DQS

For systems with a single-ended DQS signal, the waveform reference points for the Setup (tDS) and
Hold (tDH) measurements details are as shown:

For both the Strobe channel (Source1) and the Data channel (Source2), the reference levels are mapped to
the source configuration panel as follows:
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Typical values for the reference levels for some current technologies can be found here:

DDR2-400, DDR2-533 Reference Levels (see page 278)

DDR2-667, DDR2800 Reference Levels (see page 278)

DDR3-800 through DDR3-1600 Reference Levels (see page 279)

DDR2-400, DDR2-533 Reference Levels

The following reference levels are typical for single-ended signals in DDR2-400 and DDR2-533
technologies.

The best levels depend on many variables, including the supply voltage, probe point and any spec
amendments, so use this information only for general guidance.

DDR2-667, DDR2-800 Reference Levels

The following reference levels are typical for single-ended signals in DDR2-667 and DDR2-800
technologies.
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The best levels depend on many variables, including the supply voltage, probe point and any spec
amendments, so use this information only for general guidance.

DDR3-800 through DDR3-1600 Reference Levels

The following reference levels are typical for single-ended signals in DDR3-800 through DDR3-1600
technologies.

The best levels depend on many variables, including the supply voltage, probe point and any spec
amendments, so use this information only for general guidance.

DDR Setup-SE

The DDR Setup–SE measures the elapsed time between the designated edge of a data waveform and when
the single-ended strobe (DQS) waveform crosses its own voltage reference level. The closest data edge to
the clock edge that falls within the range limits is used. The strobe is placed on Source1 and the Data
is placed on Source2. This is the base Setup measurement, which does not include slew-rate derating.
Slew-rate derating tables can be found in the applicable JEDEC specification.

This measurement is identical to the basic Setup measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for both the
Data and Strobe (DQS). For more details on the reference voltage setup, refer to DDR Setup/Hold
Reference Levels: Single-ended DQS (see page 277).

The application calculates this measurement using the following equation:

Where:

T Setup is the setup time.
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T Main is the Main input (strobe or DQS) crossing time of VRefHighFall (for falling strobe edges) or
VRefLowRise (for rising strobe edges).

T 2nd is the 2nd input (data or DQ) crossing time of VRefLowFall (for falling data edges) or VRefHighRise
(for rising data edges).

DDR Setup-Diff

The DDR Setup–Diff measures the elapsed time between the designated edge of a data waveform and
when the differential strobe (DQS) waveform crosses its own voltage reference level. The closest data
edge to the clock edge that falls within the range limits is used. The strobe is placed on Source1 and the
Data is placed on Source2. This is the base Setup measurement, which does not include slew-rate derating.
Slew-rate derating tables can be found in the applicable JEDEC specification.

This measurement is identical to the basic Setup measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for the Data.
The Mid reference level is still used for the Strobe (DQS). For more details on the reference voltage setup,
refer to DDR Setup/Hold Reference Levels: Differential DQS (see page 275).

The application calculates this measurement using the following equation:

Where:

TSetup is the setup time.

TMain is the Main input (strobe or DQS) crossing time of VRefMid in the specified direction.

T2nd is the 2nd input (data or DQ) crossing time of VRefLowFall (for falling data edges) or VRefHighRise
(for rising data edges).
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DDR Hold-SE

The DDR Hold–SE measures the elapsed time between the designated edge of the single-ended strobe
(DQS) waveform and the designated edge of a data waveform. The closest data edge to the clock edge that
falls within the range limits is used. The strobe is placed on Source1 and the Data is placed on Source2.
This is the base Hold measurement, which does not include slew-rate derating. Slew-rate derating tables
can be found in the applicable JEDEC specification.

This measurement is identical to the basic Hold measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for both the data
and strobe (DQS). For more details on the reference voltage setup, refer to DDR Setup/Hold Reference
Levels: Single-ended DQS (see page 277).

The application calculates this measurement using the following equation:

Where:

THold is the hold time.

TMain is the Main input (strobe or DQS) crossing time of VRefLowFall (for falling strobe edges) or
VRefHighRise (for rising strobe edges).

T2nd is the 2nd input (data or DQ) crossing time of VRefHighFall (for falling data edges) or VRefLowRise
(for rising data edges).
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DDR Hold-Diff

The DDR Hold–Diff measures the elapsed time between the designated edge of the single-ended strobe
(DQS) waveform and the designated edge of a data waveform. The closest data edge to the clock edge that
falls within the range limits is used. The strobe is placed on Source1 and the Data is placed on Source2.
This is the base Hold measurement, which does not include slew-rate derating. Slew-rate derating tables
can be found in the applicable JEDEC specification.

This measurement is identical to the basic Hold measurement except that instead of using the Mid
reference voltage for determining edge times, it uses the High and Low reference voltages for the data.
The mid reference level is still used for the strobe (DQS). For more details on the reference voltage setup,
refer to DDR Setup/Hold Reference Levels: Differential DQS (see page 275).

The application calculates this measurement using the following equation:

Where:

THold is the hold time.

TMain is the Main input (strobe or DQS) crossing time of VRefMid in the specified direction.

T2nd is the 2nd input (data or DQ) crossing time of VRefHighFall (for falling data edges) or VRefLowRise
(for rising data edges).

DDR tCL(avg))

DDR tCL(avg) is defined as the average low pulse width calculated across 200-cycle window of
consecutive low pulses.

The application calculates this measurement using the following equation:

Where:

N=200, which is configurable.

Range: 200≤N≤1M

282 DPOJET Jitter and Eye Diagram Analysis Tools



Algorithms DDR tCK(avg)

DDR tCK(avg)

DDR tCK(avg) is calculated as the average clock period across 200-cycle window.

The application calculates this measurement using the following equation:

Where:

N=200, which is configurable.

Range: 200≤N≤1M

DDR2 tDQSCK

tDQSCK is the DQS output access time from CK or CK#. tDQSCK is measured between the rising edge
of clock before or after the DQS Preamble time.
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The application calculates this measurement using the following equation:

for mid level

Where:

Tn specifies the clock edges.

TDQS(n) specifies the DQS edges.

The edge locations are determined by the mid-reference voltage levels. This is a skew measurement
between the rising edge of DQS and the rising edge of clock.

NOTE. The JEDEC standard specifies that tDQSCK is the actual position of a rising strobe edge relative
to CK, CK#. Hence, DQS should be in phase with CK. When DQS and CK are not in phase, there could
be possibility of probe polarity interchange. You can overcome this by changing the edge direction to
“Opposite as From” under edges configure tab for Skew measurements.

For more details, refer to the topic “Configuring Edges for Skew Measurement” of the DPOJET help.
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DDR tDQSQ-Diff

tDQSQ-Diff is the DQS-DQ skew for DQS and associated DQ signals. Set JEDEC standard reference
levels for DQ.

tDQSQ-Diff uses the DPOJET measurement, Setup.

For more details, refer to the topic “Setup” of the DPOJET help.

DPOJET Jitter and Eye Diagram Analysis Tools 285



Algorithms DDR tDQSS

DDR tDQSS

tDQSS measures the time taken from WRITE event in DDR bus to the first DQS latching transition. This
measurement has two sources. One bus source (B1) and a DQS source (analog).

Measurement internally sets up Bus search to look for WRITE events. For every WRITE event in the bus
search output, the algorithm finds and associates the first rising edge of DQS within the DDR Write burst.

Prerequisites for this measurement are: DDR Parallel Bus source, Search and Mark to be setup for DDR
Write search and DPOJET Global tab Qualifier to be turned On and Qualifier source configured to DDR
Write. This measurement is available only on 64-bit MSO instruments. Measurement gets selected
only if there is a bus source configured.
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DDR tERR(n) and DDR tERR(m-n)

DDR tERR(n) is defined as the cumulative error across multiple consecutive cycles from tCK(avg). DDR
tERR(m-n) is defined as the cumulative error across multiple consecutive predefined cycles from tCK(avg).

The application calculates this measurement using the following equation:

Where:

n=2 for tERR(2 per)

n=3 for tERR(3 per)

n=4 for tERR(4 per)

n=5 for tERR(5 per)

6 ≤ n ≤ 10 for tERR(6–10 per)

11 ≤ n ≤ 50 for tERR(11–50 per)

DDR tHZDQ

DDR tHZDQ is a two source timing measurement defined as time duration from the extrapolated point
(at VDD – VDD (34/(50+34)) established by extending the slope between Vsw1 and Vsw2 to the nearest
rising edge of clock.
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DDR tJIT(duty)

DDR tJIT(duty) is defined as the cumulative set of the largest deviation of any single tCH from tCH(avg)
and the largest deviation of any single tCL from tCL(avg).

The application calculates this measurement using the following equation:

Where:

tJIT(CH) = {tCHi – tCH(avg)}

tJIT(CL) = {tCLi – tCL(avg)}

Where:

i=1 to 200

DDR tJIT(per)

DDR tJIT(per) is defined as the largest deviation of any single tCK from tCK(avg).

The application calculates this measurement using the following equation:

Where:

i =1 to 200
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DDR tLZDQ

DDR tLZDQ is a two source timing measurement defined as time duration from the extrapolated point (at
VDD = 1.2V) established by extending the slope between Vsw1 and Vsw2 to the nearest rising edge of clock.

DDR tCH(avg)

DDR tCH(avg) is defined as the average high pulse width and is calculated across 200-cycle window of
high pulses.

The application calculates this measurement using the following equation:
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DDR tRPRE

DDR tRPRE is defined as the width of the READ preamble from the exit of tristate to the first rising edge
on DQS. tRPRE in DDR3–Write bursts uses DDR tWPRE (see page 291).

The application calculates this measurement using the following equation:

Where:

n1 is the start time of the preamble.

n2 is the end time of the preamble.
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DDR tWPRE

DDR tWPRE is defined as the width of WRITE preamble from the exit of tristate to the first rising edge on
DQS. This measurement is applicable only for DDR3 generation.

The application calculates this measurement using the following equation:

Where:

n1 is the start time of the preamble.

n2 is the end time of the preamble.
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DDR tPST

DDR tPST is defined as the width of the postamble, from the last falling mid reference level crossing to the
start of an undriven state (as judged by a rising trend per JEDEC specs), for either a Read or Write burst.

Where:

n1 is the start time of the postamble.

n2 is the end time of the postamble.
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DDR Over Area

DDR Over Area is defined as the area of a triangle for which the base is defined by the crossings of the
configured reference level and the peak is the maximum voltage level attained between those crossings.

The area of focus is a triangular area in which the start and stop points are identified as closest to the
maximum point in the defined region.

The application calculates this measurement using the equation:

Over Area= 0.5*Base*Height

Where:

Base is the width of the triangle.

Height is the altitude of the triangle which specifies the maximum sample point from the triangular base.
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DDR Under Area

DDR Under Area is defined as the area of an inverted triangle for which the base is defined by the
crossings of the configured reference level and the (downward pointing) peak is the minimum voltage
level attained between those crossings.

The area of focus is an triangular area in which the start and stop points are identified as closest to the
maximum point in the defined region.

The application calculates this measurement using the equation:

Under Area= 0.5*Base*Height

Base is the width of the triangle

Height is the altitude of the triangle which specifies the maximum sample point from the triangular base.

DDR VID(ac)

DDR VID(ac) specifies the AC differential input voltage. This is measured on a differential voltage DQS
signal, which is equivalent to using two single-ended signals such as DQS and DQS# separately. For more
details, refer to High-Low (see page 271) measurement.

The application calculates this measurement using the following equation:

VID(ac)= Maximum (High,–Low)

Where:

High is the worst-case value from positive to zero.

Low is the worst-case value from negative to zero.
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DDR3 Vix(ac)

DDR3 Vix(ac) is defined as the differential input cross-point voltage measured between the actual
crossover voltage of DQS/DQS and VDD/2. It represents the differential input cross-point voltage relative
to VDD/2 for (CK/CK) or (DQS/DQS).

The application calculates this measurement using the following equation:

Where:

Vactualcrossover is the crossing between positive and compliment signals (DQS/DQS)

VRef= VDD/2
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PCIe T-Tx-Diff-PP

PCIe T-Tx-Diff-PP voltage swing calculates the change in voltage level across a transition in the
waveform. It is the peak-to-peak differential voltage swing.

The application calculates this measurement using the following equation:

Where:

VDiff-p-p is the differential peak-to-peak voltage.

VHigh is the maximum voltage calculated between i and i+1 points.

VLow is the minimum voltage calculated between i and i+1 points.

i is the index of the UI (bit) location preceding the transition.

i+1 is the index of the UI (bit) location after the transition.
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PCIe T-TX

PCIe T-TX is based on the DPOJET measurement, Eye width. For more details, refer to the Eye width
(see page 263).

PCIe T-Tx-Fall

PCIe T-Tx-Fall is the time difference between the VRefLo(20%) reference level crossing and the
VRefHi(80%) reference level crossing on the falling edge of the waveform. The VRefLo and VRefHi are
calculated based on the voltage level of the previous UI. There are two distinct thresholds corresponding to
de-emphasized transitions from high to low, and full swing transitions for VRefLo and VRefHi.

The application calculates this measurement using the following equation:

Where:

TFall is the fall time

TLo– is the VRefLo crossing on the falling edge

THi– is the VRefHi crossing on the falling edge
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PCIe Tmin-Pulse

PCIe Tmin-Pulse (minimum single pulse width TMin-Pulse) is measured from one transition center to the next.

The application calculates this measurement using the following equation:

Where:

TMin-Pulse is the minimum pulse width

T is the transition center

PCIe DeEmph

PCIe DeEmph is based on the DPOJET measurement, T/nT Ratio. For more details, refer to the TnT
Ratio (see page 269).

NOTE. PCIe DeEmph measurement uses Brick Wall filter.
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PCIe T-Tx-Rise

PCIe T-Tx-Rise is the time difference between the VRefHi(80%) reference level crossing and the
VRefLo(20%) reference level crossing on the rising edge of the waveform. The VRefHi and VRefLo are
calculated based on the voltage level of the previous UI. There are two distinct thresholds corresponding to
de-emphasized transitions from low to high, and full swing transitions for VRefHi and VRefLo.

The application calculates this measurement using the following equation:

Where:

TRise is the Rise time

THi+ is the VRefHi crossing on the rising edge

TLo+ is the VRefLo crossing on the rising edge

PCIe UI

PCIe UI is based on the DPOJET measurement, Period. For more details, refer to the Period (see page 243).

NOTE. PCIe UI uses a 3rd order LPF with the cut-off frequency of 198 kHz.
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PCIe Med-Mx-Jitter

PCIe Med-Mx-Jitter is the maximum time between the jitter median and the maximum deviation from
the median.

The application calculates this measurement using the following equation:

Where:

TMed-Max-Jitter is the median to max jitter

TJitter-Median is the jitter median

TIE is the Time interval error

PCIe T-RF-Mismch

PCIe T-RF-Mismch (Rise and Fall Time mismatch measurement) is the mismatch between Rise time
(TRise) and Fall time(TFall). Rise time and Fall time are calculated using the “PCIe T-Tx-Rise” and “PCIe
T-Tx-Fall” measurements.

The application calculates this measurement using the following equation:

Where:

TMismatch is the rise and fall time mismatch

TRise is the rise time

TFall is the fall time
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PCIe MAX-MIN Ratio

PCIe MAX-MIN Ratio (custom name is PCIe VRX-MAX-MIN Ratio) is defined as the voltage range
ratio over which a particular receiver must operate for the consecutive UI. Locate the mid edges crossover
points. On the rising edge of the waveform, find the VSWINGMIN. At the VSWINGMIN point, trace back two unit
intervals to find the VSWINGMAX.

The application calculates this measurement using the following equation:
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Where:

VSWINGMAX is the maximum voltage swing on the rising edge of the waveform.

VSWINGMIN is the minimum voltage swing on the rising edge of the waveform.

PCIe SSC PROFILE

PCIe SSC Profile measurement uses the Period (see page 243) measurement with a second order low pass
filter of 1.98 MHz. The PCIe SSC Profile shows the modulation profile of the Spread Spectrum Clocking.
Using the SSC profile, you can find the SSC modulation rate by using vertical bar cursors and peak-to-peak
frequency deviation by using horizontal bar cursors. The configurations required to be set are:

Constant Clock Mean as the Clock Recovery method

Low pass filter to get the SSC components

Time Trend Plot for the Period measurement

PCIe SSC FREQ DEV

PCIe SSC FREQ DEV is defined as the SSC frequency deviation in ppm (parts per million).

Use the PCIe SSC Profile measurement to locate the mid edge cross points.

Calculate the HIGH value between the n and n+1 edge and the LOW value between n+1 and n+2 edges.

The application calculates the measurement using the equation:

FREQ DEVIATION = HIGH–LOW

PCIe AC Common Mode

The AC Common Mode Voltage measurement is the common mode voltage between two single-ended
signals. AC is defined as all the frequency components above the cutoff frequency (30 kHz).

The application calculates this measurement using the following equations (based on two single-ended
sources from the DUT):

CM_Voltage = (Source1 + Source2) ÷ 2

AC_CMMp-p = Peak-to-Peak(High Pass filter (CM_Voltage))

Where:

AV_CMVp-p is the peak-to-peak common mode voltage.
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GDDR5 tBurst-CMD

GDDR5 tBurst-CMD (WCK, DQ, CMD_BUS) is defined as the elapsed time between the last data element
of a READ or WRITE burst to the next bus state. The next bus state depends on the command of interest
which is configured in the search. This measurement is available only on 64-bit MSO instruments.

This measurement requires that the Bus source and DPOJET Qualifiers should be turned on for DDR
read or DDR Write searches.

GDDR5 tCKSRE

The GDDR5 tCKSRE measurement is a Bus measurement for the GDDR5 standard. This measures valid
CK clocks required after the self refresh entry (SRE). This measurement is available only on 64-bit MSO
instruments. The measurement requires Clock source and Bus as inputs.

T0 = time at which clock stops toggling, after self refresh entry.
T1 = Rising edge of clock where SRE command gets registered.
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GDDR5 tCKSRX

The tCKSRX measurement is a Bus measurement for the GDDR5 standard. This is the time elapsed
between the SRX command to valid clock cycles. The clock cycles get into continuous 1s or CK (#) 0s
after the SRX. After the SRX command the algorithm searches forward on the CK source to lock onto the
clock cycles with continuous 1s. This measurement is only available on 64-bit MSO instruments.

Tb0 = time at which clock starts toggling, before self-refresh exit.
Tb2 = Rising edge of clock where SRX command gets registered.

T-TX-DDJ

T-TX-DDJ is defined as the time delta between the PDF’s mean for each zero crossing point and the
corresponding recovered clock edge.

Recover the clock to convert it to a bit stream.

Find the repeating patterns to locate Pattern Length and Pattern Repeat Count.

For k=0 to Pattern_Length, find the correlated jitter.

For i=0 to Pattern_Repeat_Count, find the edge jitter using:

EdgeJitteri = Edgei – Recovered Edgei

Correlated Jitterk = mean (EdgeJitter)

The application calculates the measurement using the equation:

Data dependent Jitter (T-TX-DDJ) = max (CorrelatedJitter) – min (CorrelatedJitter)
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T-TX-UTJ

T-TX-UTJ is referenced to a recovered data clock generated by means of a CDR tracking function.
Uncorrelated total jitter may be derived after removing the DDJ component from each PDF and combining
the PDFs for all edges in the pattern.

Recover the clock to convert it to a bit stream.

Find the repeating patterns to locate Pattern Length and Pattern Repeat Count.

For k=0 to Pattern_Length, find the correlated jitter.

For i=0 to Pattern_Repeat_Count, find the edge jitter using:

EdgeJitteri = Edgei – Recovered Edgei

Correlated Jitterk = mean (EdgeJitter)

Find uncorrelated jitter max and min values by removing the correlated jitter values using:

Max_Uncorrelated_Jitter= Max ( Max_Uncorrelated Jitter, ( EdgeJitter – Corrolated Jitterk))

Min_Uncorrelated_Jitter= Max ( Min_Uncorrelated Jitter, ( EdgeJitter – Corrolated Jitterk))

Find the absolute maximum uncorrelated jitter (max_abs_uj).

Use the absolute value to create a histogram plot with appropriate bin values (used for creating PDFs).

Create PDF and combine the PDFs of all edges.

Convert the PDF into Q scale and draw a gaussian line (Gaussian Fit) to calculate the vertical opening
on left and right side of the Q-scale curve.

The application calculates the measurement using the equation:

Uncorrelated Total Jitter (T-TX-UTJ) = Vertical left opening– Vertical right opening
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T-TX-UDJDD

T-TX-UDJDD is defined as the uncorrelated jitter at the zero crossing point and at the corresponding
recovered clock edge.

Recover the clock to convert it to a bit stream.

Find the repeating patterns to locate Pattern Length and Pattern Repeat Count.

For k=0 to Pattern_Length, find the correlated jitter.

For i=0 to Pattern_Repeat_Count, find the edge jitter using:

EdgeJitteri = Edgei – Recovered Edgei

Correlated Jitterk = mean (EdgeJitter)

Find uncorrelated jitter max and min values by removing the correlated jitter values using:

Max_Uncorrelated_Jitter= Max ( Max_Uncorrelated Jitter, ( EdgeJitter – Corrolated Jitterk))

Min_Uncorrelated_Jitter= Max ( Min_Uncorrelated Jitter, ( EdgeJitter – Corrolated Jitterk))

Find the absolute maximum uncorrelated jitter (max_abs_uj).

Use the absolute value to create a histogram plot with appropriate bin values (used for creating PDFs).

Create PDF and combine the PDFs of all edges.

Convert the PDF into Q scale and draw a gaussian line (Gaussian Fit) to calculate the vertical opening
on left and right side of the Q-scale curve.

Calculate the Uncorrelated Total Jitter (T-TX-UTJ) = Vertical left opening– Vertical right opening

Find where the gaussian line crosses the zero crossing and calculate T-TX-UDJ-DD.
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T-TX-UPW-TJ

T-TX-UPW-TJ is defined as an edge-to-edge phenomenon on consecutive edges.

Recover the clock to convert it to a bit stream.

Find the repeating patterns to locate Pattern Length and Pattern Repeat Count.

For k=0 to Pattern_Length, find the correlated jitter.

For i=0 to Pattern_Repeat_Count, find the edge jitter using:

EdgeJitteri = Edgei – Recovered Edgei

Correlated Jitterk = mean (EdgeJitter)

Replicate the correlated jitter for each of the repeated pattern.

Calculate the mean_pwj referencing to a fixed leading edge and having jitter contributions from
both edges appear at the trailing edge.

Use the mean_pwj value to find a histogram plot to accommodate all the PWJ values to create the PDF.

Calculate the Q-Scale extrapolation for this PWJ-PDF.

Calculate the vertical opening on left and right side of the Q-scale curve.

Calculate the Uncorrelated Total Power Jitter (T-TX-PWJ-TJ) = Vertical left opening– Vertical right
opening
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T-TX-UPW-DJDD

T-TX-UPW-DJDD is defined as the Uncorrelated Pulse Width Jitter (PWJ) at the zero crossing.

Recover the clock to convert it to a bit stream.

Find the repeating patterns to locate Pattern Length and Pattern Repeat Count.

For k=0 to Pattern_Length, find the correlated jitter.

For i=0 to Pattern_Repeat_Count, find the edge jitter using:

EdgeJitteri = Edgei – Recovered Edgei

Correlated Jitterk = mean (EdgeJitter)

Replicate the correlated jitter for each of the repeated pattern.

Calculate the PWJ referencing to a fixed leading edge and having jitter contributions from both edges
appear at the trailing edge and calculate the mean_pwj.

Use the absolute value to create a histogram plot with appropriate bin values (used for creating PDFs).

Create PDF and combine the PDFs of all edges.

Convert the PDF into Q scale and draw a gaussian line (Gaussian Fit) to calculate the vertical opening
on left and right side of the Q-scale curve.

The application calculates the measurement using the equation:

Uncorrelated Total Jitter (T-TX-UTJ) = Vertical left opening– Vertical right opening

V-TX-EQ-NO

V-TX-EQ-NO is defined by setting c-1 and c+1 to zero and measuring the peak-to-peak voltage on the
64-ones/64-zeroes segment of the compliance pattern.

Find the 64 zeros/64 ones between two consecutive edges.

Find the voltage between the 57th to 62nd UI of both positive and negative cycle.

Calculate the average voltage of both positive and negative cycle.

Find the voltage difference between positive and negative cycles.

308 DPOJET Jitter and Eye Diagram Analysis Tools



Algorithms V-TX-EIEOS

V-TX-EIEOS

V-TX-EIEOS is defined by setting c+1 coefficient value of –0.33 and a c-1 coefficient value of 0.0 and
measuring the peak-to-peak voltage on the 8-ones/8-zeroes segment of the compliance pattern, where the
pattern is repeated for a total of 128 UI.

Find the 8 zeros/8 ones between two consecutive edges.

Find the voltage between the 3rd to 7th UI of both positive and negative cycle.

Calculate the average voltage of both positive and negative cycle.

Find the voltage difference between positive and negative cycles.

ps21TX

Package loss (ps21TX) is measured by comparing the 64-zeroes/64-ones PP voltage (V111) against a
1010 pattern (V101)

Find the 1010 bit pattern (V101) for 64 UI in the compliance pattern.

Find 64 ones/64zeros bit pattern (V111) adjacent to 1010 pattern.

Find the 50,52 and 54th bits from the positive UIs and 49,51 and 53rd bits from the negative UIs of
the 1010 bit pattern.

Calculate the peak-to-peak voltage difference between positive and negative UIs.

Find the voltage between 57th UI to 62nd UI of both positive and negative cycle.

Calculate the average voltage of the positive and negative cycle.

Find the voltage difference between positive and negative cycles.

The application calculates this measurement using the following equation:

Package Loss Ratio = 20log10(V101/V111)
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USB VTx-Diff-PP

VTx-Diff-PP voltage swing calculates the change in voltage level across a transition in the waveform.
It is the peak-to-peak differential voltage swing.

The application calculates this measurement using the following equation:

Where:

VDiff-p-p is the differential peak-to-peak voltage.

VHigh is the maximum voltage calculated between i and i+1 points.

VLow is the minimum voltage calculated between i and i+1 points.

i is the index of the UI (bit) location preceding the transition.

i+1 is the index of the UI (bit) location after the transition.
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USB TCdr-Slew-Max

Slew rate measurement finds the peak-to-peak period jitter. Period jitter can be obtained by taking the
first difference of the filtered phase jitter. The application uses the Period measurement with an LPF of
1.98 MHz to find the period jitter. It calculates the phase jitter by taking the cumulative sum of the period
jitter. Filters the phase jitter with the CR transfer function using the following equation:

The filtered period jitter is obtained from the phase jitter to calculate peak-to-peak period jitter.

USB Tmin-Pulse-Tj

Tmin-Pulse-Tj (minimum single pulse width TMin-Pulse) is measured from one transition center to the
next including all jitter sources.

The application calculates this measurement using the following equation:

Where:

TMin-Pulse is the minimum pulse width

T is the transition center

USB Tmin-Pulse-Dj

USB Tmin-Pulse-Dj is defined as the minimum pulse width with only deterministic jitter components.

Plot the time trend for the TIE measurement.

Take the FFT of the TIE time trend to get the TIE spectrum. Then separate the RJ and DJ values
from the spectrum.

Take the IFFT of the TIE spectrum without the RJ components and reconstruct the clock based on the
TIE trend without the RJ components.

Find the minimum pulse width within the reconstructed clock.
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USB SSC MOD RATE

USB SSC MOD RATE is defined as the SSC modulation rate in terms of Hz. Use the SSC Profile
measurement to locate the mid edge crossover points. Determine the time difference between the
consecutive mid reference voltage levels as shown:

Δt= Tn+1–Tn

Where:

Tn is the VREFmid crossing time

Tn+1 is the n+1 VREFmid crossing time

The application calculates this measurement using the following equation:

Modulation Rate= 1/Δt

USB SSC FREQ-DEV-MAX

USB SSC FREQ DEV MAX is defined as the maximum frequency shift as a function of time. It represents
the frequency deviation in terms of ppm (parts per million).

Find the 50% edges on the SSC profile.

Calculate the HIGH value between the n and n+1 edge.

Find the Maximum frequency deviation as HIGH.

The application calculates the measurement using the equation:

Freq Dev Max(ppm)= ((Maximum Freq–Nominal Data Rate)/Nominal Data Rate)* 1e6

USB SSC FREQ-DEV-MIN

USB SSC FREQ DEV MIN is defined as the minimum frequency shift as a function of time. Represents
the frequency deviation in terms of ppm (parts per million).

Find the 50% edges on the SSC profile.

Calculate the LOW value between the n and n+1 edge.

Find the Maximum frequency deviation as LOW.

The application calculates the measurement using the equation:

Freq Dev Min(ppm)= ((Minimum Freq–Nominal Data Rate)/Nominal Data Rate)* 1e6
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USB SSC PROFILE

USB SSC Profile measurement uses the Period (see page 243) measurement with a second order low pass
filter of 1.98 MHz. The USB SSC Profile shows the modulation profile of the Spread Spectrum Clocking.
Using the SSC profile, you can find the SSC modulation rate by using horizontal cursors and peak-to-peak
frequency deviation by using vertical cursors. The configurations required to be set are:

Constant Clock Mean as the Clock Recovery method

Low pass filter to get the SSC components

Time Trend Plot for the Period measurement

USB UI

USB UI is based on the DPOJET measurement, Period. For more details, refer to the Period (see page 243).

NOTE. USB UI uses a 3rd order LPF with the cut-off frequency of 198 kHz.

USB AC Common Mode

The USB AC Common Mode Voltage measurement is the common mode voltage between two
single-ended signals. AC is defined as all the frequency components above the cutoff frequency (30 kHz).

The application calculates this measurement using the following equations (based on two single-ended
sources from the DUT):

CM_Voltage = (Source1 + Source2) ÷ 2

AC_CMMp-p = Peak-to-Peak(High Pass filter (CM_Voltage))

Where:

AV_CMVp-p is the peak-to-peak common mode voltage.

Jitter Analysis Through RJ/DJ Separation

Many of the jitter measurements are based on the concept of RJ/DJ separation. The application begins with
the measured jitter-versus-time (as represented by the TIE measurement array) and analytically determines
the random and deterministic components of the jitter. The deterministic part is further separated into
independent subcomponents with specific characteristics.
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The random jitter (RJ) is assumed to be zero-mean Gaussian, and is assumed to have a flat spectrum when
viewed in the frequency domain. The measured RJ is fitted to a Gaussian mathematical model, which is
parameterized by its standard deviation. Using the mathematical model for RJ, statistically probable jitter
extremes may be predicted for much greater populations than actually measured.

The deterministic jitter (DJ) is predictable and can be generated consistently given known circumstances.
The various DJ measurements each report the peak-to-peak value of the corresponding DJ subcomponent.

Once all the jitter components have been identified and the random jitter has been converted to a
mathematical model, the components can be reassembled such that performance may be extrapolated
to extremely low bit error rates. The probabilistic Total Jitter (TJ@BER) and probabilistic Eye Width
(Width@BER) are examples of such measurements. The reported values are predictions that correspond to
a user-specified Bit Error Rate, rather than observed values.

Two approaches are supported for performing jitter separation. The first method is based on spectrum
analysis. It is only possible when the data pattern is repetitive. A clock waveform is always repetitive.
Other repetitive testing data patterns are used, such as the K28.5 data pattern. Patterns may have rather long
repetition lengths; for example, the CJTPAT pattern is 2640 bits. When using this method, you must specify
the pattern length, and you will receive a warning if the pattern length appears to differ from that specified.

The second RJ/DJ separation method, known as arbitrary pattern analysis, may be used when the data
pattern is not necessarily repetitive. This method works by correlating deterministic jitter observed over
many repetitions with the bit pattern within a time-domain window surrounding each observation.

RJ/DJ Separation via Spectrum Analysis

When the source waveform represents a repeating data pattern, Deterministic Jitter (DJ) has a frequency
spectrum of impulses. The impulses due to the data pattern are equally spaced and occur at predictable
frequencies related to the pattern length and bit rate. Specifically, the pattern-related jitter impulse must
occur at multiples of fo/N, where fo is the data bit rate and N is the data pattern length. Other spectral
impulses may occur due to periodic jitter not correlated with the data pattern.

To obtain measurements of DJ and RJ, all the components of the jitter spectrum that exceed the noise floor
by a chosen margin are attributed to deterministic jitter. Those components that fall at the frequency
increment corresponding to the pattern length are identified as data-dependent jitter, and those occurring
at other frequencies are attributed to uncorrelated periodic jitter. The remaining spectral noise floor
(appropriately normalized to account for the removed deterministic jitter) is integrated to predict the
standard deviation of the underlying Gaussian random noise process.

Once the spectral components corresponding to each deterministic jitter type have been identified, each
component is inverse-transformed back to the time domain. From these waveforms, the peak-to-peak jitter
for each component is determined. For the random jitter, the RMS deviation is directly computable
from the standard deviation of the Gaussian model.
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RJ/DJ Separation for Arbitrary Patterns

When the data pattern borne by the source waveform is not cyclically repeating, any periodic jitter still has
a frequency spectrum consisting of impulses but this is not true of the data-dependent jitter.

In this case, analysis of the data-dependent jitter may proceed based on the assumption that any given
bit is affected by a finite (and relatively small) number of preceding bits. By averaging all events for
which a given bit is preceded by a particular bit sequence, the data-dependent jitter attributable to that
bit sequence is obtained. This is because PJ and RJ are not correlated to a particular data sequence and
thus are averaged out.

If each bit is assumed to be affected by N preceding bits, there are a total of 2N possible data sequences.
The sequence length N is a configurable parameter. To get statistically sound average values for the
data-dependent jitter, a minimum population of observations is required for each individual pattern that
occurs at least once. This population limit is also configurable by the user.

By the above means, the data-dependent jitter is characterized. Once characterized, the data-dependent
jitter, on a bit-by-bit basis, may be removed from the original jitter versus time record. The remaining
jitter is composed of periodic and random jitter. This jitter is transformed into the frequency domain,
and the spectral analysis approach is used to separate the impulsive periodic jitter from the broad noise
floor of random jitter.
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Separation of Non-Periodic Jitter (NPJ)

Bounded Uncorrelated Jitter (BUJ) refers to all bounded jitter that is not correlated to the data pattern
on the waveform. Thus, it excludes DDJ, DCD and RJ. It can be further subdivided into PJ (which is
deterministic, and easily recognized using a spectral approach) and Non-Period Jitter (NPJ).

Depending on its precise nature, NPJ is often difficult to distinguish from RJ. It typically cannnot be
isolated using frequency domain techniques, so a different domain is used. The important difference
between RJ and NPJ is that RJ has a Gaussian distribution (with unbounded tails) whereas NPJ is bounded
by definition. This fact is used as a basis for separation.

In DPOJET, the jitter separation algorithms are modified as follows when the Spectral + BUJ method
is selected:

1. Data-Dependent Jitter (DDJ) and Duty-Cycle jitter (DCD) are first removed using either a spectral
approach for repeating patterns or a correlation approach for arbitrary data patterns.

2. PJ is identified and removed using a spectral approach.

3. The remaining jitter is assumed to contain (Gaussian) RJ and possibly NPJ. (In the Spectral Only
method of jitter analysis, no further processing is done and this jitter is reported as RJ.)

4. When Spectral + BUJ processing is selected, the RJ + NPJ jitter is collected into a histogram that is
typically accumulated over multiple waveform acquisitions. When the (user-configurable) minimum
histogram population has been acquired, the histogram is converted to an estimate of the Cumulative
Density Function (CDF) and plotted using the Q-scale for the vertical axis. The Q-scale plot has
the property that a true Gaussian distribution appears as a straight line, with a slope equal to 1/σ
(where σ is the standard deviation of the Gaussian distribution). If the distribution is a mixture of a
true Gaussian plus some bounded distribution, the plotted curve has left and right extremes that
asymptotically approach straight lines with a slope of 1/σ. The horizontal offset between the two
asymptotes represents the dual-dirac magnitude of the NPJ.

Estimation of TJ@BER and Eye Width@BER

One of the outcomes of the RJ/DJ separation was a mathematical model for random jitter’s probability
density function (PDF) and measured values for the PDFs of the deterministic jitter components. Since
all of these components are assumed to be statistically independent, the PDF of the total jitter can be
calculated by convolution.

Integration of the PDF yields the cumulative distribution function (CDF), which can then be used to create
the bit error rate curve (bathtub curve). Based on the bathtub curve, the eye opening (Width@BER) and
eye closure (TJ@BER) can be estimated for a given bit error rate.

The application calculates the eye opening at the specified BER using the following equation:

Eye opening = 1–TJ@BER when TJ@BER is less than one Unit Interval

Eye opening = 0 when TJ@BER exceeds one Unit Interval
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Jitter Estimation Using Dual-Dirac Models

Jitter estimation based on RJ/DJ separation depends in part on the specific jitter components modeled.
For the purposes of analyzing jitter and identifying root cause, it is very useful to identify components
as specifically as possible. But for the purposes of determining compliance, it has been found that a
simplified jitter model yields results that are more consistent across different measurement instruments
and different vendors.

A simplified model that has found acceptance in several industry standards is known as the Dual-Dirac
model. This is because the probability density function (PDF) of all the deterministic jitter is replaced
with a PDF consisting of two Dirac functions such that the total jitter and eye opening at very low bit
error rates is unchanged. The Random Jitter and Deterministic Jitter values derived from this model
are identified as RJ–δδ and DJ–δδ, respectively.

Two slightly different Dual-Dirac models have been defined. Both models begin with a jitter versus
BER (bathtub) curve, either created from a full jitter analysis based on RJ/DJ separation, or from direct
measurement of error rate versus sample point offset. The two models differ in how the RJ–δδ and DJ–δδ
values are extracted from the curve.

For the Fibre-Channel standard, values for RJ–δδ and DJ–δδ are chosen such that the Dual-Dirac bathtub
curve exactly matches the measured curve at the BER = 10-5 and BER=10-9 points.

For the PCI Express and FB-DIMM standards, the bathtub curve is re-plotted using a different y-axis.
Instead of directly plotting against the log of the BER, the y-axis is converted to the Q-scale. The BER to
Q-scale transformation was designed such that Gaussian distributions are converted to straight lines, with a
slope that is directly related to the standard deviation of the Gaussian.

When using the Dual-Dirac jitter measurements, it is critical that you select the model that matches
the applicable standard. This may be configured in the DPOJET preferences, which are found under
Analyze > Jitter and Eye Analysis (DPOJET) > Preferences, on the Measurement tab.

Results

The application calculates statistics for all selected measurements. The application displays the following
statistics in the Results menu:

Mean

Std Dev (Standard Deviation)

Max (Maximum Value)

Min (Minimum Value)

p-p (Peak-to-Peak)

Population
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Max-cc (Maximum positive cycle-to-cycle variation)

Min-cc (Maximum negative cycle-to-cycle variation)

Mean

The application calculates the mean value using the following equation:

Standard Deviation

The application calculates the standard deviation using the following equation:

It may seem odd that the equation for the estimate of the Standard Deviation contains a 1/(N-1) scaling
factor. If you knew the true mean of X and used it in place of the estimated mean then you would, in fact,
scale by 1/N. But, is an estimate and is likely to be in error (or bias), causing the estimate of the Standard
Deviation to be too small if scaled by 1/N. This is the reason for the scaling shown in the equation. (Refer to
Chapter 9.2 in A. Papoulis, Probability, Random Variables, and Stochastic Processes, McGraw Hill, 1991.)

NOTE. RMS value can be calculated using the relation (rms)2= (mean value)2+ (stddev)2.

Maximum Value

The application calculates maximum value using the following equation:

Max(X) = Most Positive Value of X

Minimum Value

The application calculates minimum value using the following equation:

Min(X) = Most Negative Value of X

p-p

The application calculates peak-to-peak using the following equation:

p-p(X) = Max(X )– Min(X)
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Population

Population is the total number of events or observations over which the other statistics were calculated.

Population (X) = N

Max-cc

The application calculates Max-cc using the following equation:

Max-cc(X) = Max(XCC )

Where:

XCC is the first difference of X.

Min-cc

The application calculates Min-cc using the following equation:

Min-cc(X) = Min(XCC )

Where:

XCC is the first difference of X.
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About the GPIB Program

You can use remote GPIB commands to communicate with the DPOJET application. An example
of a GPIB program that can execute the DPOJET application is included with the application in
C:\Users\Public\Tektronix\TekApplications\DPOJET\Examples.

The example shows how a GPIB program executes the application to do the following tasks:

1. Start the application.

2. Recall a setup.

3. Take a measurement.

4. View measurement results and plots.

5. Exit the application.

NOTE. Commands are not case and space sensitive. Your program will operate correctly even if you do
not follow the capitalization and spacing precisely.

GPIB Reference Materials

To use GPIB commands with your oscilloscope, you can refer to the following materials:

The GPIB Program Example in C:\Users\Public\Tektronix\TekApplications\DPOJET\Ex-
amples for guidelines to use while designing a GPIB program.

The Parameters topics for range of values, minimum units and default values of parameters.

The programmer information in the online help of your oscilloscope.
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Argument Types

The syntax shows the format that the instrument returns in response to a query. This is also the preferred
format when sending the command to the instrument though any of the formats will be accepted. This
documentation represents these arguments as follows:

Table 78: Argument types

Symbol Meaning

<NR1> Signed integer value.

<NR2> Floating point value without an exponent.

<NR3> Floating point value with an exponent.

double Double precision floating point with exponent.

xxx
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DPOJET: ADDMeas

This set-only command adds the specified measurement to the bottom of the current DPOJET list of
measurements and will appear in the results summary page.

Syntax

DPOJET:ADDmeas {PERIod | CCPeriod | FREQuency | NPERiod | PWIdth | NWIdth |

PDUTy | NDUTy | PCCDuty | NCCDuty | TIE | RJ | RJDirac | TJber | DJ | DJDirac

| PHASENoise | DCD | DDJ | PJ | RISEtime | SETup | HIGHTime | FALLtime |

HOLD | LOWTime | SKEW | HEIght | WIDth | MASKHits | WIDTHBer | HEIGHTBer

| COMmonmode | HIGH | TNTratio | HIGHLOW | LOW | VDIFFxovr | DDRSETUPSe

| DDRSETUPDiff | DDRHOLDSe | DDRHOLDDiff | DDRTCLaverage | DDRTJITDuty |

DDRTCKaverage | DDRTDQSS | DDRTERrn | DDRTJITper | DDRTCHaverage | DDRTERRMN |

RISESLEWrate | FALLSLEWrate | OVERShoot | UNDERShoot | CYCLEPktopk | DDRTRpre

| DDRTPst | CYCLEMIn | CYCLEMAx | ACCommonmode | DDROverarea | DDRTWpre |

DDRVIDac | DDR3VIXac | JITTERSummary | PCIETTXDiffpp | PCIEDEemph | PCIETTx

| PCIETTXRise | PCIETTXFall | PCIEUI | PCIETMinpulse | PCIEMEdmxjitter |

PCIETRfmismch | PCIESSCFReqdev | PCIEMAXMINratio | PCIESSCPROFile | PCIEVEye

| PCIETTXUTJ | PCIETTXUDJDD | PCIETTXUPWTJ | PCIETTXUPWDJDD | PCIETTXDDJ |

PCIEVTXNOEQ | PCIEVTXEIEOS | PCIEPS21TX | PCIEACCommonmode | |VTXDiffpp |

TMINPULSETJ | TCDRslewmax | USBUI | USBACCommonmode | TMINPULSEDJ | DDR2TDQSCK

| GDDR5TBursttocmd| GDDR5TCKSRX | GDDR5TCKSRE | QFACTOR | EYELOW | EYEHIGH

| TCMDTOCMD | TIMEOUTSIDELEVEL | SSCFREQDEVMAX | SSCFREQDEVMIN | SSCFREQDEV

|SSCMODrate | SSCPROfile | USBSSCFREQDEVMAX | USBSSCFREQDEVMIN | USBSSCMODrate

| USBSSCPROFile}

Inputs

Same as syntax for measurement options.

Outputs

None
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DPOJET:BURSTConfig:BUS

This command sets or queries the required Bus source.

Syntax

DPOJET:BURSTConfig:BUS <string>

DPOJET:BURSTConfig:BUS?

Inputs

<string>

Outputs

<string>

DPOJET:BURSTConfig:CSACTIve

This command sets or queries the Active selection for the Chip select source.

Syntax

DPOJET:BURSTConfig:CSACTIve {L | H}

DPOJET:BURSTConfig:CSACTIve?

Inputs

{L | H}

Outputs

{L | H}
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DPOJET:BURSTConfig:CSSource

This command sets or queries the required source for Chip select.

Syntax

DPOJET:BURSTConfig:CSSource {CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}

DPOJET:BURSTConfig:CSSource?

Inputs

{CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}

Outputs

{CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}

DPOJET:BURSTConfig:CUSTOMRate

This command sets or queries the custom data rate values for a particular DDR generation.

Syntax

DPOJET:BURSTConfig:CUSTOMRate <NR3>

DPOJET:BURSTConfig:CUSTOMRate?

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:BURSTConfig:DATA

This command sets or queries the required source for Data.

Syntax

DPOJET:BURSTConfig:DATA {CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}

DPOJET:BURSTConfig:DATA?

Inputs

{CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}

Outputs

{CH1 — CH4 | MATH1 — MATH4 | REF1 — REF4}

DPOJET:BURSTConfig:DATARate

This command sets or queries the standard data rate values for a particular DDR generation.

Syntax

DPOJET:BURSTConfig:DATARate <string>

DPOJET:BURSTConfig:DATARate?

Inputs

<string>

Outputs

<string>
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DPOJET:BURSTConfig:DETECTMethod

This command sets or queries the burst detection method used for burst identification.

Syntax

DPOJET:BURSTConfig:DETECTMethod {DQDQS | CHIPSelect | LOGICState}

DPOJET:BURSTConfig:DETECTMethod?

Inputs

{DQDQS | CHIPSelect | LOGICState}

Outputs

{DQDQS | CHIPSelect | LOGICState}

DPOJET:BURSTConfig:GENERation

This command sets or queries the required DDR generation.

Syntax

DPOJET:BURSTConfig:GENERation {DDR | DDR2 | DDR3 | LPDDR | LPDDR2 | GDDR3 |

GDDR5}

DPOJET:BURSTConfig:GENERation?

Inputs

{DDR | DDR2 | DDR3 | LPDDR | LPDDR2 | GDDR3 | GDDR5}

Outputs

{DDR | DDR2 | DDR3 | LPDDR | LPDDR2 | GDDR3 | GDDR5}
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DPOJET:BURSTConfig:LATEncy

This command sets or queries the required burst latency.

Syntax

DPOJET:BURSTConfig:LATEncy <NR3>

DPOJET:BURSTConfig:LATEncy?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:BURSTConfig:LENGth

This command sets or queries the required burst length.

Syntax

DPOJET:BURSTConfig:LENGth <NR3>

DPOJET:BURSTConfig:LENGth?

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:BURSTConfig:SEARch

This command sets or queries the type of search required.

Syntax

DPOJET:BURSTConfig:SEARch {DDRRead | DDRWrite | DDRREADWRITE}

DPOJET:BURSTConfig:SEARch?

Inputs

{DDRRead | DDRWrite | DDRREADWRITE}

Outputs

{DDRRead | DDRWrite | DDRREADWRITE}

DPOJET:BURSTConfig:STRObe

This command sets or queries the required source for the strobe.

Syntax

DPOJET:BURSTConfig:STRObe {CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4}

DPOJET:BURSTConfig:STRObe?

Inputs

{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4}

Outputs

{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4}
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DPOJET:BURSTConfig:TOLERance

This command sets or queries the required burst tolerance.

Syntax

DPOJET:BURSTConfig:TOLERance

DPOJET:BURSTConfig:TOLERance?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:CLEARALLMeas

This set-only command clears the entire current list of defined measurements in DPOJET.

Syntax

DPOJET:CLEARALLMeas

Outputs

None
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DPOJET:DESKEW

This command performs a DPOJET deskew operation with the settings specified in DPOJET:DESKEW.

Syntax

DPOJET:DESKEW {EXEcute}

Inputs

{EXEcute}

DPOJET:DESKEW:DESKEWchannel

This command sets or queries the channel to be deskewed.

Syntax

DPOJET:DESKEW:DESKEWchannel {CH1-CH4}

DPOJET:DESKEW:DESKEWchannel?

Inputs

{CH1 - CH4}

Outputs

{CH1 - CH4}
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DPOJET:DESKEW:DESKEWHysteresis

This command sets or queries the deskew channel hysteresis value.

Syntax

DPOJET:DESKEW:DESKEWHysteresis <NR3>

DPOJET:DESKEW:DESKEWHysteresis?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:DESKEW:DESKEWMidlevel

This command sets or queries the deskew channel midlevel value.

Syntax

DPOJET:DESKEW:DESKEWMidlevel <NR3>

DPOJET:DESKEW:DESKEWMidlevel?

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:DESKEW:EDGE

This command sets or queries the edge types used when calculating deskew.

Syntax

DPOJET:DESKEW:EDGE {RISE | FALL | BOTH}

DPOJET:DESKEW:EDGE?

Inputs

{RISE | FALL | BOTH}

Outputs

{RISE | FALL | BOTH}

DPOJET:DESKEW:MAXimum

This command sets or queries the maximum deskew value possible.

Syntax

DPOJET:DESKEW:MAXimum <NR3>

DPOJET:DESKEW:MAXimum?

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:DESKEW:MINimum

This command sets or queries the minimum deskew value possible.

Syntax

DPOJET:DESKEW:MINimum <NR3>

DPOJET:DESKEW:MINimum?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:DESKEW:REFChannel

This command sets or queries the reference channel used for deskew operation.

Syntax

DPOJET:DESKEW:REFChannel {CH1 - CH4}

DPOJET:DESKEW:REFChannel?

Inputs

{CH1 - CH4}

Outputs

{CH1 - CH4}
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DPOJET:DESKEW:REFHysteresis

This command sets or queries the reference channel hysteresis value.

Syntax

DPOJET:DESKEW:REFHysteresis <NR3>

DPOJET:DESKEW:REFHysteresis?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:DESKEW:REFMidlevel

This command sets or queries the reference channel midlevel value.

Syntax

DPOJET:DESKEW:REFMidlevel <NR3>

DPOJET:DESKEW:REFMidlevel?

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:DIRacmodel

This command sets or queries the current dirac model.

Syntax

DPOJET:DIRacmodel {FIBREchannel | PCIExpress}

DPOJET:DIRacmodel?

Inputs

{FIBREchannel | PCIExpress}

Outputs

{FIBREchannel | PCIExpress}

DPOJET:EXPORT

This set-only command saves the specified DPOJET plot to the specified file path. The Format is
determined through the filename extension, with a default of png if no extension is specified.

Supported extensions include jpeg, jpg, tif, tiff, bmp, emf, and png. For example: DPOJET:EXPORT
PLOT1, “savedimage.tif”.

Syntax

DPOJET:EXPORT {PLOT1-PLOT4, <file string>}

Inputs

{PLOT1-PLOT4, <file string>}
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DPOJET:GATING

This command sets or queries the gating state.

Syntax

DPOJET:GATING {OFF | ZOOM | CURSOR | MARKS}

DPOJET:GATING?

Inputs

{OFF | ZOOM | CURSOR | MARKS}

Outputs

{OFF | ZOOM | CURSOR | MARKS}

DPOJET:HALTFreerunonlimfail

This command sets or queries the halt free-run on limit failure (On or Off).

Syntax

DPOJET:HALTFreerunonlimfail {1 | 0}

DPOJET:HALTFreerunonlimfail?

Inputs

{1 | 0}

Outputs

{1 | 0}
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DPOJET:HIGHPerfrendering

This command sets or queries the current high-performance eye rendering setting.

Syntax

DPOJET:HIGHPerfrendering <NR1>

DPOJET:HIGHPerfrendering?

Inputs

<NR1>

Outputs

<NR1>

DPOJET:INTERp

This command sets or queries the current interpolation model.

Syntax

DPOJET:INTERp {LINear | SINX}

DPOJET:INTERp?

Inputs

{LINear | SINX}

Outputs

{LINear | SINX}
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DPOJET:LASTError?

This query-only command returns the contents of the last pop-up warning dialog box. If no errors have
occurred since startup, or since the last call to DPOJET:LASTError?, this command returns an empty string.

Syntax

DPOJET:LASTError?

Outputs

<string>

DPOJET:LIMITRise

This command turns on or off the ability to limit Rise/Fall measurements to transition bits only.

Syntax

DPOJET:LIMITRise {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}
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DPOJET:MINBUJUI

This command sets or queries the minimum number of UI for BUJ analysis.

Syntax

DPOJET:MINBUJUI <NR3>

DPOJET:MINBUJUI?

Inputs

<NR3>

Outputs

<NR3>
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DPOJET:LIMits:FILEName

This command sets or queries the current limits filename.

Syntax

DPOJET:LIMits:FILEName <string>

DPOJET:LIMits:FILEName?

Inputs

<string>

Outputs

<string>

DPOJET:LIMits:STATE

This command turns on or off the pass-fail limit system. Pass-fail status can be queried using the
DPOJET:MEAS <x>:RESULTS node.

Syntax

DPOJET:LIMits:STATE {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}
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DPOJET:LOGging:MEASurements:FOLDer

This command sets or queries the current folder used for measurement logging.

Syntax

DPOJET:LOGging:MEASurements:FOLDer <string>

DPOJET:LOGging:MEASurements:FOLDer?

Inputs

<string>

Outputs

<string>

DPOJET:LOGging:MEASurements:STATE

This command turns on or off the future logging of measurements. Individual measurements included in
the logging are selected using the DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the
entire set of included measurements.

Syntax

DPOJET:LOGging:MEASurements: {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}
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DPOJET:LOGging:SNAPshot

This command performs a DPOJET export of the specified type, either for statistics or measurements.

Syntax

DPOJET:LOGging:SNAPshot {STATistics | MEASurements}

Inputs

{STATistics | MEASurements}

Outputs

{STATistics | MEASurements}

DPOJET:LOGging:STATistics:FILEName

This command sets or queries the current file used for statistics logging.

Syntax

DPOJET:LOGging:STATistics:FILEName <string>

DPOJET:LOGging:STATistics:FILEName?

Inputs

<string>

Outputs

<string>
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DPOJET:LOGging:STATistics:STATE

This command turns on or off the future logging of statistics. Individual measurements included in the
logging are selected using the DPOJET:MEAS<x>:LOGging node. This parameter turns on or off the
entire set of included measurements.

Syntax

DPOJET:LOGging:STATistics:STATE {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:LOGging:WORSTcase:FOLDer

This command sets or queries the current folder used for worst case logging.

NOTE. Waveform filenames generated while worst case logging is on will follow the syntax of
“Measurement Name”-“Source”_Min1.wfm and “Measurement Name”-“Source”_Max1.wfm, For
example: Period1-Ch1_Max1.wfm, Period1-Ch1_Min1.wfm, Rise Time1-Ch1_Max1.wfm, Rise
Time1-Ch1_Min1.wfm.

Syntax

DPOJET:LOGging:WORSTcase:FOLDer <string>

DPOJET:LOGging:WORSTcase:FOLDer?

Inputs

<string>

Outputs

<string>
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DPOJET:LOGging:WORSTcase:STATE

This command turns on or off the future logging of worst case waveforms. Individual measurements
included in the logging are selected using the DPOJET:MEAS<x>:LOGging node. This parameter turns
on or off the entire set of included measurements.

Syntax

DPOJET:LOGging:WORSTcase:STATE {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:MEAS<x>

This command returns the branch query for the application measurement slot with index <x>. This will
always match the measurement defined at the associated index <x> displayed on the DPOJET screen,
where index 1 is the first, or top, of the measurement list.

Branch queries will only contain the measurement branches for those branches that have measurements
defined. This means queries to branches that do not exist will time out. This is required because the
number of measurements that can be defined in DPOJET, is 99.

Syntax

DPOJET:MEAS<x>

DPOJET:MEAS<x>?
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DPOJET:MEAS<x>:BER:TARGETBER

This command sets or queries the current TargetBER value.

Syntax

DPOJET:MEAS<x>:BER:TARGETBER <NR3>

DPOJET:MEAS<x>:BER:TARGETBER?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:BITCfgmethod

This command sets or queries the measurement bit configure method.

Syntax

DPOJET:MEAS<x>:BITCfgmethod {MEAN | MODE}

DPOJET:MEAS<x>:BITCfgmethod?

Inputs

{MEAN | MODE}

Outputs

{MEAN | MODE}
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DPOJET:MEAS<x>:BITPcnt

This command sets or queries the percentage value to be measured for the Bit type selected.

Syntax

DPOJET:MEAS<x>:BITPcnt <NR3>

DPOJET:MEAS<x>:BITPcnt?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:BITConfig:STARTPercent

This command sets or queries the starting percentage of the bit to measure.

Syntax

DPOJET:MEAS<x>:BITConfig:STARTPercent <NR3>

DPOJET:MEAS<x>:BITConfig:STARTPercent?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:BITConfig:ENDPercent

DPOJET:MEAS<x>:BITConfig:ENDPercent

This command sets or queries the ending percentage of the bit to measure.

Syntax

DPOJET:MEAS<x>:BITConfig:ENDPercent <NR3>

DPOJET:MEAS<x>:BITConfig:ENDPercent?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:BITConfig:NUMBins

This command sets or queries the number of bins per window.

Syntax

DPOJET:MEAS<x>:BITConfig:NUMBins <NR3>

DPOJET:MEAS<x>:BITConfig:NUMBins?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:BITType

DPOJET:MEAS<x>:BITType

This command sets or queries the measurement bit type setting.

Syntax

DPOJET:MEAS<x>:BITType {ALLBits | NONTRANsition | TRANsition}

DPOJET:MEAS<x>:BITType?

Inputs

{ALLBits | NONTRANsition | TRANsition}

Outputs

{ALLBits | NONTRANsition | TRANsition}

DPOJET:MEAS<x>:BUSState:CLOCKPolarity

This command sets or queries the clock polarity for the clock edge.

Syntax

DPOJET:MEAS<x>:BUSState:CLOCKPolarity {RISING | FALLING}

DPOJET:MEAS<x>:BUSState:CLOCKPolarity?

Inputs

{RISING | FALLING}

Outputs

{RISing | FALLing}
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GPIB Commands DPOJET:MEAS<x>:BUSState:FROMPattern

DPOJET:MEAS<x>:BUSState:FROMPattern

This command sets or queries the Pattern from which the Bus state is configured.

Syntax

DPOJET:MEAS<x>:BUSState:FROMPattern <string>

DPOJET:MEAS<x>:BUSState:FROMPattern?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:BUSState:FROMSymbol

This command sets or queries the symbol from which the Bus state is configured.

Syntax

DPOJET:MEAS<x>:BUSState:FROMSymbol <string>

DPOJET:MEAS<x>:BUSState:FROMSymbol?

Inputs

<string>

Outputs

<string>
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GPIB Commands DPOJET:MEAS<x>:BUSState:MEASUREType

DPOJET:MEAS<x>:BUSState:MEASUREType

This command sets or queries the type for which the bus state is configured.

Syntax

DPOJET:MEAS<x>:BUSState:MEASBUSType {SYMbol | PATTern}

DPOJET:MEAS<x>:BUSState:MEASBUSType?

Inputs

{SYMbol | PATTern}

Outputs

{SYMbol | PATTern}

DPOJET:MEAS<x>:BUSState:MEASUREFrom

This command sets or queries where the bus is measured from.

Syntax

DPOJET:MEAS<x>:BUSState:MEASUREFROM {CLOCKEdge | START | STOP}

DPOJET:MEAS<x>:BUSState:MEASUREFROM?

Inputs

{CLOCKEdge | START | STOP}

Outputs

{CLOCKEdge | START | STOP}
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GPIB Commands DPOJET:MEAS<x>:BUSState:MEASURETO

DPOJET:MEAS<x>:BUSState:MEASURETO

This command sets or queries from where the bus is measured to.

Syntax

DPOJET:MEAS<x>:BUSState:MEASURETO {START | STOP | CLOCKEdge}

DPOJET:MEAS<x>:BUSState:MEASURETO?

Inputs

{CLOCKEdge | START | STOP}

Outputs

{CLOCKEdge | START | STOP}

DPOJET:MEAS<x>:BUSState:TOPattern

This command sets or queries the Pattern to which the Bus state is configured.

Syntax

DPOJET:MEAS<x>:BUSState: TOPattern <string>

DPOJET:MEAS<x>:BUSState: TOPattern?

Inputs

<string>

Outputs

<string>

352 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:MEAS<x>:BUSState:TOSymbol

DPOJET:MEAS<x>:BUSState:TOSymbol

This command sets or queries the symbol to which the Bus state is configured.

Syntax

DPOJET:MEAS<x>:BUSState: TOSymbol <string>

DPOJET:MEAS<x>:BUSState: TOSymbol?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKBitrate

This command sets or queries the clock bit rate. Used if DATARate is 1.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKBitrate <NR3>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKBitrate?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency

This command sets or queries the clock frequency. Used with Constant Clock - Fixed clock recovery
method.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency <NR3>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKFrequency?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier

This command sets or queries the clock multiplier.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier <NR3>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKMultiplier?

Inputs

<NR3>

Outputs

<NR3>

354 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath

This command sets or queries the current known clock pattern path.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath <string>

DPOJET:MEAS<x>:CLOCKRecovery:CLOCKPath?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:CLOCKRecovery:DAMPing

This command sets or queries the clock recovery damping value.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:DAMPing <NR3>

DPOJET:MEAS<x>:CLOCKRecovery:DAMPing?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:DATARate

DPOJET:MEAS<x>:CLOCKRecovery:DATARate

This command turns on or off DATArate usage.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:DATARate {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:MEAS<x>:CLOCKRecovery:BWType

This command sets or queries the clock recovery bandwidth type.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:BWType {LOOPBW | JTFBW}

DPOJET:MEAS<x>:CLOCKRecovery:BWType?

Inputs

{LOOPBW | JTFBW}

Outputs

{LOOPBW | JTFBW}
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GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth

DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth

This command sets or queries the clock recovery loop bandwidth.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth <NR3>

DPOJET:MEAS<x>:CLOCKRecovery:LOOPBandwidth?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate

This command sets or queries how often the clock is calculated, either FIRST, or on EVERY acquisition.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate {FIRST | EVERY}

DPOJET:MEAS<x>:CLOCKRecovery:MEANAUTOCalculate?

Inputs

{FIRST | EVERY}

Outputs

{FIRST | EVERY}
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GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:METHod

DPOJET:MEAS<x>:CLOCKRecovery:METHod

This command sets or queries the current Clock recovery method.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:METHod {STANDARD | CUSTOM | CONSTMEAN |

CONSTFIXED | EXPEDGE | EXPPLL | CONSTMEDIAN}

DPOJET:MEAS<x>:CLOCKRecovery:METHod?

Inputs

{STANDARD | CUSTOM | CONSTMEAN | CONSTFIXED | EXPEDGE | EXPPLL | CONSTMEDIAN}

Outputs

{STANDARD | CUSTOM | CONSTMEAN | CONSTFIXED | EXPEDGE | EXPPLL | CONSTMEDIAN}

DPOJET:MEAS<x>:CLOCKRecovery:MODel

This command sets or queries the current clock recovery model.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:MODel {ONE | TWO}

DPOJET:MEAS<x>:CLOCKRecovery:MODel?

Inputs

{ONE | TWO}

Outputs

{ONE | TWO}
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GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset

This command sets or queries the clock offset.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset <NR3>

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:AUTO?

This query-only command returns the value in the Auto text box for the Nominal Clock Offset controls. If
the nominal clock offset method selection type is set to Auto and an acquisition cycle has been completed,
this field shows the clock-to-data offset that was automatically determined. A positive value means that the
clock leads the data (precedes it in time). If the offset has not been determined, the returned string is TBD.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:AUTO?

Outputs

<string>
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GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:MANual

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:MANual

This command sets or queries the value for Manual text box.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:MANual <NR3>

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:MANual?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:Recalctype

This command sets or queries the recalculation list box.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:Recalctype {FIRST | EVERY}

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:Recalctype?

Inputs

{FIRST | EVERY}

Outputs

{FIRST | EVERY}
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GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:SELECTIONtype

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:SELECTIONtype

This command sets or queries the selection type.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:SELECTIONtype {AUTO | MANUAL}

DPOJET:MEAS<x>:CLOCKRecovery:NOMINALOFFset:SELECTIONtype?

Inputs

{AUTO | MANUAL}

Outputs

{AUTO | MANUAL}

DPOJET:MEAS<x>:CLOCKRecovery:PATTern

This command turns on or off the usage of CLOCKPath to a specific known data pattern.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:PATTern {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}
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GPIB Commands DPOJET:MEAS<x>:CLOCKRecovery:STAndard

DPOJET:MEAS<x>:CLOCKRecovery:STAndard

This command sets or queries the current clock recovery standard, as specified in the user interface.

Syntax

DPOJET:MEAS<x>:CLOCKRecovery:STAndard <string>

DPOJET:MEAS<x>:CLOCKRecovery:STAndard?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:COMMONMode:FILTers:STATE

This command sets or queries the state of the common mode filter frequency.

Syntax

DPOJET:MEAS<x>:COMMONMode:FILTers:STATE {ON | OFF}

DPOJET:MEAS<x>:COMMONMode:FILTers:STATE?

Inputs

{ON | OFF}

Outputs

{1 | 0}
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GPIB Commands DPOJET:MEAS<x>:CUSTomname

DPOJET:MEAS<x>:CUSTomname

This command sets or queries the custom measurement name for the measurement in slot x.

Syntax

DPOJET:MEAS<x>:CUSTomname <string>

DPOJET:MEAS<x>:CUSTomname?

Inputs

<string>

Outputs

<string>

DPOJET:MEAS<x>:DATA?

This query-only command returns the measurement data. This is similar to the curve query, where the
output is in the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For Example: If <yyy>=500, <x>=3

NOTE. <x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax

DPOJET:MEAS<x>:DATA?

Outputs

The measurement values as a stream of doubles.
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GPIB Commands DPOJET:MEAS<x>:DDR:MPERCycle

DPOJET:MEAS<x>:DDR:MPERCycle

This command sets or queries the MPercycle value used in various DDR measurements.

Syntax

DPOJET:MEAS<x>:DDR:MPERCycle <NR3>

DPOJET:MEAS34:DDR:MPERCycle?

Inputs

<NR3>

Outputs

<NR1>

DPOJET:MEAS<x>:DDR:NPERCycle

This command sets or queries the NPercycle value used in various DDR measurements.

Syntax

DPOJET:MEAS<x>:DDR:NPERCycle <NR3>

DPOJET:MEAS34:DDR:NPERCycle?

Inputs

<NR3>

Outputs

<NR1>
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GPIB Commands DPOJET:MEAS<x>:DDR:WINDowsize

DPOJET:MEAS<x>:DDR:WINDowsize

This command sets or queries the window size used in various DDR measurements.

Syntax

DPOJET:MEAS<x>:DDR:WINDowsize <NR3>

DPOJET:MEAS34:DDR:WINDowsize?

Inputs

<NR3>

Outputs

<NR1>

DPOJET:MEAS<x>:EDGE1

This command sets or queries the Source1 edge type.

Syntax

DPOJET:MEAS<x>:EDGE1 {RISe | FALL | BOTH}

DPOJET:MEAS<x>:EDGE1?

Inputs

{RISe | FALL | BOTH}

Outputs

{RISe | FALL | BOTH}
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GPIB Commands DPOJET:MEAS<x>:EDGE2

DPOJET:MEAS<x>:EDGE2

This command sets or queries the Source2 edge type.

Syntax

DPOJET:MEAS<x>:EDGE2 {RISe | FALL | BOTH}

DPOJET:MEAS<x>:EDGE2?

Inputs

{RISe | FALL | BOTH}

Outputs

{RISe | FALL | BOTH}

DPOJET:MEAS<x>:EDGEIncre

This command sets or queries the measurement edge increment value.

Syntax

DPOJET:MEAS<x>:EDGEIncre <NR3>

DPOJET:MEAS<x>:EDGEIncre?

Inputs

<NR3>

Outputs

<NR1>
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GPIB Commands DPOJET:MEAS<x>:EDGES:FROMLevel

DPOJET:MEAS<x>:EDGES:FROMLevel

This command sets or queries the FromLevel edge for the measurement.

Syntax

DPOJET:MEAS<x>:EDGES:FROMLevel {HIGH | MID | LOW}

DPOJET:MEAS<x>:EDGES:FROMLevel?

Inputs

{HIGH | MID | LOW}

Outputs

{HIGH | MID | LOW}

DPOJET:MEAS<x>:EDGES:LEVel

This command sets or queries the level used for the edges configuration.

Syntax

DPOJET:MEAS<x>:EDGES:LEVel

DPOJET:MEAS<x>:EDGES:LEVel?

Inputs

{HIGH | MID | LOW}

Outputs

{HIGH | MID | LOW}
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GPIB Commands DPOJET:MEAS<x>:EDGES:SLEWRATETechnique

DPOJET:MEAS<x>:EDGES:SLEWRATETechnique

This command sets or queries the slew rate technique for the measurement.

Syntax

DPOJET:MEAS<x>:EDGES:SLEWRATETechnique {NOMinalmethod | DDRmethod}

DPOJET:MEAS<x>:EDGES:SLEWRATETechnique?

Inputs

{NOMinalmethod | DDRmethod}

Outputs

{NOMinalmethod | DDRmethod}

DPOJET:MEAS<x>:EDGES:TOLevel

This command sets or queries the ToLevel edge for the measurement.

Syntax

DPOJET:MEAS<x>:EDGES:TOLevel {HIGH | MID | LOW}

DPOJET:MEAS<x>:EDGES:TOLevel?

Inputs

{HIGH | MID | LOW}

Outputs

{HIGH | MID | LOW}
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GPIB Commands DPOJET:MEAS<x>:FILTers:BLANKingtime

DPOJET:MEAS<x>:FILTers:BLANKingtime

This command sets or queries the current filter blanking time.

Syntax

DPOJET:MEAS<x>:FILTers:BLANKingtime <NR3>

DPOJET:MEAS<x>:FILTers:BLANKingtime?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ

DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ

This command sets or queries the current high pass filter frequency.

Syntax

DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ <NR3>

DPOJET:MEAS<x>:FILTers:HIGHPass:FREQ?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC

This command sets or queries the current high pass filter specification.

Syntax

DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC {NONE | FIRST | SECOND | THIRD}

DPOJET:MEAS<x>:FILTers:HIGHPass:SPEC?

Inputs

{NONE | FIRST | SECOND | THIRD}

Outputs

{NONE | FIRST | SECOND | THIRD}
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GPIB Commands DPOJET:MEAS<x>:FILTers:LOWPass:FREQ

DPOJET:MEAS<x>:FILTers:LOWPass:FREQ

This command sets or queries the current low pass filter frequency.

Syntax

DPOJET:MEAS<x>:FILTers:LOWPass:FREQ <NR3>

DPOJET:MEAS<x>:FILTers:LOWPass:FREQ?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:FILTers:LOWPass:SPEC

This command sets or queries the current low pass filter specification.

Syntax

DPOJET:MEAS<x>:FILTers:LOWPass:SPEC {NONE | FIRST | SECOND | THIRD}

DPOJET:MEAS<x>:FILTers:LOWPass:SPEC?

Inputs

{NONE | FIRST | SECOND | THIRD}

Outputs

{NONE | FIRST | SECOND | THIRD}
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GPIB Commands DPOJET:MEAS<x>:REFVoltage

DPOJET:MEAS<x>:REFVoltage

This command sets or queries the reference voltage for the measurement.

Syntax

DPOJET:MEAS<x>:REFVoltage {100 | -100}

DPOJET:MEAS<x>:REFVoltage?

Inputs

{100 | -100}

Outputs

{100 | -100}

DPOJET:MEAS<x>:FILTers:RAMPtime

This command sets or queries the current filter ramp time.

Syntax

DPOJET:MEAS<x>:FILTers:RAMPtime <NR3>

DPOJET:MEAS<x>:FILTers:RAMPtime?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:FILTers:STATE

DPOJET:MEAS<x>:FILTers:STATE

This command sets or queries the measurement filter setting.

Syntax

DPOJET:MEAS<x>:FILTers:STATE {1 | 0}

DPOJET:MEAS<x>:FILTers:STATE?

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:MEAS<x>:FROMedge

This command sets the FROMedge value for the measurement.

Syntax

DPOJET:MEAS<x>:FROMedge {RISe | FALL | BOTH}

Inputs

{RISe | FALL | BOTH}

Outputs

{RISe | FALL | BOTH}
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GPIB Commands DPOJET:MEAS<x>:HIGHREFVoltage

DPOJET:MEAS<x>:HIGHREFVoltage

This command sets or queries the high reference voltage value for the selected configuration.

Syntax

DPOJET:MEAS<x>:HIGHREFVoltage <NR3>

DPOJET:MEAS<x>:HIGHREFVoltage?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:LOWREFVoltage

This command sets or queries the low reference voltage value for the selected configuration.

Syntax

DPOJET:MEAS<x>:LOWREFVoltage <NR3>

DPOJET:MEAS<x>:LOWREFVoltage?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:LOGging:MEASurements:FILEname?

DPOJET:MEAS<x>:LOGging:MEASurements:FILEname?

This command queries the current file name that will be used for the measurement when measurement
logging is turned on.

Syntax

DPOJET:MEAS<x>:LOGging:MEASurements:FILEname?

Outputs

<string>

DPOJET:MEAS<x>:LOGging:MEASurements:SELect

This command sets or queries the given measurement to be included in any measurement logging. Statistic
logging is turned on or off as a whole, using the DPOJET:LOGging branch.

Syntax

DPOJET:MEAS<x>:LOGging:MEASurements:SELect {1 | 0}

DPOJET:MEAS<x>:LOGging:MEASurements:SELect?

Inputs

{1 | 0}

Outputs

{1 | 0}
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GPIB Commands DPOJET:MEAS<x>:LOGging:STATistics:SELect

DPOJET:MEAS<x>:LOGging:STATistics:SELect

This command sets or queries the given measurement for inclusion in any statistic logging. Statistic
logging is turned on or off as a whole, using the DPOJET:LOGging branch.

Syntax

DPOJET:MEAS<x>:LOGging:STATistics:SELect {1 | 0}

DPOJET:MEAS<x>:LOGging:STATistics:SELect?

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:MEAS<x>:LOGging:WORSTcase:SELect

This command sets or queries the given measurement for inclusion in any worst-case logging. Statistic
logging is turned on or off as a whole, using the DPOJET:LOGging branch.

Syntax

DPOJET:MEAS<x>:LOGging:WORSTcase:SELect {1 | 0}

Inputs

DPOJET:MEAS<x>:LOGging:WORSTcase:SELect?

{1 | 0}

Outputs

{1 | 0}
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GPIB Commands DPOJET:MEAS<x>:MASKfile

DPOJET:MEAS<x>:MASKfile

This command sets or queries the current mask file name.

Syntax

DPOJET:MEAS<x>:MASKfile <string>

DPOJET:MEAS<x>:MASKfile?

Inputs

<string>

Outputs

<string>
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GPIB Commands DPOJET:MEAS<x>:MEASRange:MAX

DPOJET:MEAS<x>:MEASRange:MAX

This command sets or queries the maximum measurement range limit value.

Syntax

DPOJET:MEAS<x>:MEASRange:MAX <NR3>

DPOJET:MEAS<x>:MEASRange:MAX?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:MEASRange:MIN

This command sets or queries the minimum measurement range limit value.

Syntax

DPOJET:MEAS<x>:MEASRange:MIN <NR3>

DPOJET:MEAS<x>:MEASRange:MIN?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:MEASRange:STATE

DPOJET:MEAS<x>:MEASRange:STATE

This command turns on or off the measurement range limits.

Syntax

DPOJET:MEAS<x>:MEASRange:STATE {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:MEAS<x>:MEASStart

This command sets or queries the measurement start value.

Syntax

DPOJET:MEAS<x>:MEASStart <NR3>

DPOJET:MEAS<x>:MEASStart?

Inputs

<NR3>

Outputs

<NR1>

DPOJET Jitter and Eye Diagram Analysis Tools 379



GPIB Commands DPOJET:MEAS<x>:N

DPOJET:MEAS<x>:N

This command sets or queries the measurement N value.

Syntax

DPOJET:MEAS<x>:N <NR3>

DPOJET:MEAS<x>:N?

Inputs

<NR3>

Outputs

<NR1>

DPOJET:MEAS<x>:NAME?

This query-only command returns the measurement name for the measurement in slot x. For measurements
that include 16-bit characters in their UI names, such as DJDirac, the string returned will contain question
marks where the UI contains nontext characters.

Syntax

DPOJET:MEAS<x>:NAME?

Outputs

<string>
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GPIB Commands DPOJET:MEAS<x>:PHASENoise:HIGHLimit

DPOJET:MEAS<x>:PHASENoise:HIGHLimit

This command sets or queries the upper phase noise integration limit.

Syntax

DPOJET:MEAS<x>:PHASENoise:HIGHLimit <NR3>

DPOJET:MEAS<x>:PHASENoise:HIGHLimit?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:PHASENoise:LOWLimit

This command sets or queries the lower phase noise integration limit.

Syntax

DPOJET:MEAS<x>:PHASENoise:LOWLimit <NR3>

DPOJET:MEAS<x>:PHASENoise:LOWLimit?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:REFVoltage

DPOJET:MEAS<x>:REFVoltage

This command sets or queries the reference voltage for the measurement.

Syntax

DPOJET:MEAS<x>:REFVoltage {100 | —100}

DPOJET:MEAS<x>:REFVoltage?

Inputs

{100 | —100}

Outputs

{100 | —100}
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GPIB Commands DPOJET:MEAS<x>:RESULts?

DPOJET:MEAS<x>:RESULts?

This query-only command returns the measurement branch for the currently selected measurement for
measurement slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts?

Outputs

The measurement branch for the selected measurement for measurement slot x.

DPOJET:MEAS<x>:RESULts:ALLAcqs?

This query-only command returns the measurement results from all acquisitions.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:HITPopulation?

This query-only command returns the mask hit population.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:HITPopulation?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:HITS?

DPOJET:MEAS<x>:RESULts:ALLAcqs:HITS?

This query-only command returns the mask hits measurement for all segments.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:HITS?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:STATus?

This query-only command returns the pass/fail status per measurement. If any of the statistics fails, the
cumulative result is fail, otherwise pass.

Syntax

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:HIgh:STATus?

This query-only command returns the pass/fail status for high limit.

Syntax

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:HIgh:STATus?

Outputs

{PASS | FAIL}
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:LOw:STATus?

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:LOw:STATus?

This query-only command returns the pass/fail status for low limit.

Syntax

DPOJET:MEAS<x>:RESULts:ALLacqs:LIMits:LOw:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX?

This query-only command returns the maximum value for all accumulated measurement acquisitions
for slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC?

This query-only command returns the maximum positive cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC:STATus?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXCC:STATus?

This query-only command returns the pass/fail status for the maximum positive cycle-to-cycle delta of the
selected measurement (set via :DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:ALLacqs:MAXCC:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits?

This query-only command returns the maximum mask hits measurement for all segments.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAXHits?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MAX:STATus?

This query-only command returns the pass/fail status for the max measurement for the currently loaded
limit file (set via :DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:ALLacqs:MAX:STATus?

Outputs

{PASS | FAIL}
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN?

This query-only command returns the mean value for all accumulated measurement acquisitions for
slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN:STATus?

This query-only command returns the pass/fail status for the mean measurement for the currently loaded
limit file (set via :DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:MEAN:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN?

This query-only command returns the minimum value for all accumulated measurement acquisitions
for slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC?

This query-only command returns the maximum negative cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC:STATus?

This query-only command returns the pass/fail status for the negative cycle-to-cycle delta of the selected
measurement.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINCC:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINHits?

This query-only command returns the minimum mask hits measurement for all segments.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:MINHits?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN:STATus?

DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN:STATus?

This query-only command returns the pass/fail status for the minimum measurement for the currently
loaded limit file (set via :DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:MIN:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK?

This query-only command returns the peak-to-peak value for all accumulated measurement acquisitions
for slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK:STATus?

This query-only command returns the pass/fail status for the peak-to-peak measurement for the currently
loaded limit file (set via :DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:ALLacqs:PK2PK:STATus?

Outputs

{PASS | FAIL}
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation?

DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation?

This query-only command returns the mean measurement value for the currently selected measurement for
measurement slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:POPUlation?

Outputs

<NR1>

DPOJET:MEAS<x>:RESULts:ALLacqs:POPUlation:STATus?

This query-only command returns the pass/fail status for the population measurement for the currently
loaded limit file (set via :DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:ALLacqs:POPUlation:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:Hits?

This query-only command returns the mask hits measurement for the given segment, either SEG1,
SEG2 or SEG3.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:Hits?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MAXHits?

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MAXHits?

This query-only command returnseturns the maximum mask hits measurement for the given segment,
either SEG1, SEG2 or SEG3.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MAXHits?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MINHits?

This query-only command returns the minimum mask hits measurement for the given segment, either
SEG1, SEG2 or SEG3.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:SEG<x>:MINHits?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:ALLAcqs:STDDev?

This query-only command returns the standard deviation for all accumulated measurement acquisitions
for slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:ALLAcqs:STDDev?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:ALLacqs:STDDEV:STATus?

DPOJET:MEAS<x>:RESULts:ALLacqs:STDDEV:STATus?

This query-only command returns the pass/fail status for the standard deviation measurement for the
currently loaded limit file (set via :DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:ALLacqs:STDDEV:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX?

This query-only command returns the maximum value of the measurement value for the currently selected
measurement for measurement slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC?

This query-only command returns the maximum positive cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus?

This query-only command returns the pass/fail status for the Max cycle-to-cycle measurement for the
currently loaded limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:MAXCC:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus?

This query-only command returns the pass/fail status for the max measurement for the currently loaded
limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:MAX:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN?

This query-only command returns the mean measurement for the currently loaded limit file.

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus?

This query-only command returns the pass/fail status for the mean measurement for the currently loaded
limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:MEAN:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN?

This query-only command returns the minimum value for the currently selected measurement for
measurement slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC?

This query-only command returns the maximum negative cycle-to-cycle delta of the selected measurement.

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?

This query-only command returns the pass/fail status for the min cycle-to-cycle measurement for the
currently loaded limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:MINCC:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus?

This query-only command returns the pass/fail status for the minimum measurement for the currently
loaded limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:MIN:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK?

This query-only command returns the peak-to-peak value for the currently selected measurement for
measurement slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK?

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus?

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus?

This query-only command returns the pass/fail status for the peak-to-peak measurement for the currently
loaded limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:PK2PK:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation?

This query-only command returns the population measurement value for the currently selected
measurement for measurement slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation?

Outputs

<NR1>

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?

This query-only command returns the pass/fail status for the population measurement for the currently
loaded limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:POPUlation:STATus?

Outputs

{PASS | FAIL}
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GPIB Commands DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev?

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev?

This query-only command returns the standard deviation of the measurement value for the currently
selected measurement for measurement slot <x>.

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:StdDev?

Outputs

<NR3>

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev:STATus?

This query-only command returns the pass/fail status for the standard deviation measurement for the
currently loaded limit file. (Set using DPOJET:LIMits:FILEName).

Syntax

DPOJET:MEAS<x>:RESULts:CURRentacq:STDDev:STATus?

Outputs

{PASS | FAIL}

DPOJET:MEAS<x>:RESULTS:STATus?

This query-only command returns the status of the given measurement values in slot MEAS<x>. Valid for
currently valid measurements, or the error status such as “Not enough edges”.

Syntax

DPOJET:MEAS<x>:RESULTS:STATus?

Outputs

<string>
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GPIB Commands DPOJET:MEAS<x>:RESULts:VIew?

DPOJET:MEAS<x>:RESULts:VIew?

This query-only command returns the results view type.

Syntax

DPOJET:MEAS<x>:RESULts:VIew?

Outputs

{SUMmary | DETails}

DPOJET:MEAS<x>:RJDJ:BER

This command sets or queries the current RJDJ BER value.

Syntax

DPOJET:MEAS<x>:RJDJ:BER <NR3>

DPOJET:MEAS<x>:RJDJ:BER?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RJDJ:PATLen

DPOJET:MEAS<x>:RJDJ:PATLen

This command sets or queries the current RJDJ pattern length.

Syntax

DPOJET:MEAS<x>:RJDJ:PATLen <NR3>

DPOJET:MEAS<x>:RJDJ:PATLen?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:RJDJ:POPUlation

This command sets or queries the current RJDJ population.

Syntax

DPOJET:MEAS<x>:RJDJ:POPUlation <NR3>

DPOJET:MEAS<x>:RJDJ:POPUlation?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:RJDJ:TYPe

DPOJET:MEAS<x>:RJDJ:TYPe

This command sets or queries the current RJDJ measurement type.

Syntax

DPOJET:MEAS<x>:RJDJ:TYPe {ARBITrary | REPEating}

DPOJET:MEAS<x>:RJDJ:TYPe?

Inputs

{ARBitrary | REPEating}

Outputs

{ARBitrary | REPEating}

DPOJET:MEAS<x>:RJDJ:WINDOwlength

This command sets or queries the current RJDJ window length.

Syntax

DPOJET:MEAS<x>:RJDJ:WINDOwlength <NR3>

DPOJET:MEAS<x>:RJDJ:WINDOwlength?

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:MEAS<x>:SIGNALType

DPOJET:MEAS<x>:SIGNALType

This command sets the signal type for various measurements.

Syntax

DPOJET:MEAS<x>:SIGNALType {CLOCK | DATA | AUTO}

Inputs

{CLOCK | DATA | AUTO}

Outputs

{CLOCK | DATA | AUTO}

DPOJET:MEAS<x>:SOUrce1

This command sets or queries the Source1 value.

Syntax

DPOJET:MEAS<x>:SOUrce1 {CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}

DPOJET:MEAS<x>:SOUrce1?

Inputs

{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}

Outputs

{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}
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GPIB Commands DPOJET:MEAS<x>:SOUrce2

DPOJET:MEAS<x>:SOUrce2

This command sets or queries the Source2 value. May return NONE for single-source measurement.
Source2 may be the second source used in dual-source measurements, or the clock source in others. In
either case, it is always the same as the rightmost displayed source on the UI.

Syntax

DPOJET:MEAS<x>:SOUrce2 {CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}

DPOJET:MEAS<x>:SOUrce2?

Inputs

{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}

Outputs

{CH1 - CH4 | MATH1 - MATH4 | REF1 - REF4 | D0 — D15}

DPOJET:MEAS<x>:SSC:NOMinalfreq:AUTO?

This query-only command returns the automatically-calculated nominal frequency value for SSC
configurations.

Syntax

DPOJET:MEAS<x>:SSC:NOMinalfreq:AUTO?

Outputs

<string>
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GPIB Commands DPOJET:MEAS<x>:SSC:NOMinalfreq:MANual

DPOJET:MEAS<x>:SSC:NOMinalfreq:MANual

This command sets or queries the user-defined nominal frequency value for SSC configurations.

Syntax

DPOJET:MEAS<x>:SSC:NOMinalfreq:MANual <NR3>

DPOJET:MEAS<x>:SSC:NOMinalfreq:MANual?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:MEAS<x>:SSC:NOMinalfreq:SELECTIONtype

This command sets or queries the Nominal frequency selection type for the SSC configurations.

Syntax

DPOJET:MEAS<x>:SSC:NOMinalfreq:SELECTIONtype

DPOJET:MEAS<x>:SSC:NOMinalfreq:SELECTIONtype?

Inputs

{AUTO | MANUAL}

Outputs

{AUTO | MANUAL}
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GPIB Commands DPOJET:MEAS<x>:TIMEDATa?

DPOJET:MEAS<x>:TIMEDATa?

This query-only command returns the measurement time data. It is similar to the curve query, where the
output is in the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For Example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax

DPOJET:MEAS<x>:TIMEDATa?

Outputs

After parsing the query results, the data is a stream of doubles.

NOTE. Time data is not available for all measurements. For Example: Scalar measurements.

DPOJET:MEAS<x>:TOEdge

This command sets the TOEdge value for the measurement.

Syntax

DPOJET:MEAS<x>:TOEdge {SAMEas | OPPositeas}

Inputs

{SAMEas | OPPositeas}

Outputs

{SAMEas | OPPositeas}
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GPIB Commands DPOJET:NUMMeas?

DPOJET:NUMMeas?

This query-only command returns the current number of defined measurements.

Syntax

DPOJET:NUMMeas?

Outputs

<NR1>

DPOJET:ADDPlot

This set-only command creates a plot of the specified type on the specified DPOJET measurement. Up
to four plots can be created.

Syntax

DPOJET:ADDPlot {TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer |

PHASEnoise | EYE | WAVEform | BATHtub | QBathtub | QPulsewidth}, MEAS<x>}

Inputs

{TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer | PHASEnoise | EYE |

WAVEform | BATHtub | QBathtub | QPulsewidth}, MEAS<x>}

For example: DPOJET:ADDPlot HISTOgram, MEAS2

DPOJET:CLEARALLPlots

This set-only command clears the entire current list of defined plots in DPOJET.

Syntax

DPOJET:CLEARALLPlots
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GPIB Commands DPOJET:PLOT<x>:DATA:XDATa?

DPOJET:PLOT<x>:DATA:XDATa?

This command returns the plot X data values. This command is similar to the curve query, where the
output is in the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax

DPOJET:PLOT<x>:DATA:XDATa?

Outputs

After parsing the query results, the data is a stream of doubles.

NOTE. This command does not support plots such as the Eye Diagram Height plot, Waveform Plot and
Eye diagram with mask hits.
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GPIB Commands DPOJET:PLOT<x>:DATA:YDATa?

DPOJET:PLOT<x>:DATA:YDATa?

This command returns the plot Y data values. This command is similar to the curve query, where the
output is in the format #<x><yyy><data><newline>, where <x> is the number of <y> bytes.

For example: If <yyy>=500, <x>=3

<x> is hexadecimal format. The letters A-F denote the number of y bytes between 10 and 15 digits.

<yyy> is the number of bytes to transfer.

<data> is curve data.

<newline> is a single-byte new line character at the end of the data.

Syntax

DPOJET:PLOT<x>:DATA:XDATa?

Outputs

After parsing the query results, the data is a stream of doubles.

NOTE. This command does not support plots such as the Eye Diagram Height plot, Waveform Plot and
Eye diagram with mask hits.

DPOJET:PLOT<x>:XUnits?

This query-only command returns X units of the plot as a string.

Syntax

DPOJET:PLOT<x>:XUnits?

Outputs

<string>

NOTE. Plot units depends on the measurement type.

Click here to see the possible Measurement Units (see page 241)
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GPIB Commands DPOJET:PLOT<x>:YUnits?

DPOJET:PLOT<x>:YUnits?

This query-only command returns Y units of the plot as a string.

Syntax

DPOJET:PLOT<x>:YUnits?

Outputs

<string>

NOTE. Plot units depends on the measurement type.

Click here to see the possible Measurement Units (see page 241)

DPOJET:PLOT<x>:SOUrce?

This query-only command returns the source measurement for the selected plot.

Syntax

DPOJET:PLOT<x>:SOUrce?

Outputs

{MEAS1 - MEAS99}
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GPIB Commands DPOJET:PLOT<x>:TREND:TYPe

DPOJET:PLOT<x>:TREND:TYPe

This command sets or queries the trend type setting for Trend plots.

Syntax

DPOJET:PLOT<x>:TREND:TYPe {VECTOR | BAR}

DPOJET:PLOT<x>:TREND:TYPe?

Inputs

{VECTOR | BAR}

Outputs

{VECTOR | BAR}

DPOJET:PLOT<x>:TYPe?

This query-only command returns the current plot type for the selected plot.

Syntax

DPOJET:PLOT<x>:TYPe?

Outputs

{TIMEtrend | DATAarray | HISTOgram | SPECtrum | TRANSfer | PHASEnoise | EYE |

WAVEform | BATHtub | QBathtub | QPulsewidth }
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GPIB Commands DPOJET:PLOT<x>:BATHtub:BER

DPOJET:PLOT<x>:BATHtub:BER

This command sets or queries the bathtub BER value.

Syntax

DPOJET:PLOT<x>:BATHtub:BER <NR3>

DPOJET:PLOT<x>:BATHtub:BER?

Inputs

<NR3>

Outputs

<NR1>

NOTE. Undefined for nonbathtub plots.

DPOJET:PLOT<x>:BATHtub:VERTical:SCALE

This command sets or queries the vertical scale setting for applicable plots, either Linear or Log.

Syntax

DPOJET:PLOT<x>:BATHtub:VERTical:SCALE {LINEAR | LOG}

DPOJET:PLOT<x>:BATHtub:VERTical:SCALE?

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}

NOTE. Undefined for nonbathtub plots.
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GPIB Commands DPOJET:PLOT<x>:EYE:ALIGNment

DPOJET:PLOT<x>:EYE:ALIGNment

This command sets or queries eye alignment state for eye plots.

Syntax

DPOJET:PLOT<x>:EYE:ALIGNment {AUTO | LEFT | CENter}

DPOJET:PLOT<x>:EYE:ALIGNment?

Inputs

{AUTO | LEFT | CENter}

Outputs

{AUTO | LEFT | CENter}

NOTE. Undefined for noneye plots.

DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale

This command sets or queries the horizontal auto scale setting.

Syntax

DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale {1 | 0}

DPOJET:PLOT<x>:EYE:HORizontal:AUTOscale?

Inputs

{1 | 0}

Outputs

{1 | 0}

NOTE. Undefined for noneye plots.
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GPIB Commands DPOJET:PLOT<x>:EYE:HORizontal:RESolution

DPOJET:PLOT<x>:EYE:HORizontal:RESolution

This command sets or queries the Horizontal Eye resolution.

Syntax

DPOJET:PLOT<x>:EYE:HORizontal:RESolution <NR3>

DPOJET:PLOT<x>:EYE:HORizontal:RESolution?

Inputs

<NR3>

Outputs

<NR1>

NOTE. Undefined for noneye plots.

DPOJET:PLOT<x>:EYE:MASKfile

This command sets or queries the mask file.

Syntax

DPOJET:PLOT<x>:EYE:MASKfile <string>

DPOJET:PLOT<x>:EYE:MASKfile?

Inputs

<string>

Outputs

<string>

NOTE. Undefined for noneye plots.
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GPIB Commands DPOJET:PLOT<x>:EYE:STATE

DPOJET:PLOT<x>:EYE:STATE

This command sets or queries the eye state, either on or off.

Syntax

DPOJET:PLOT<x>:EYE:STATE {1 | 0}

DPOJET:PLOT<x>:EYE:STATE?

Inputs

{1 | 0}

Outputs

{1 | 0}

NOTE. Undefined for noneye plots.

DPOJET:PLOT<x>:EYE:SUPERImpose

This command sets or queries whether superimposed eyes are generated in eye diagrams.

Syntax

DPOJET:PLOT<x>:EYE:SUPERImpose {1 | 0}

DPOJET:PLOT<x>:EYE:SUPERImpose?

Inputs

{1 | 0}

Outputs

{1 | 0}

NOTE. Undefined for noneye plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:AUTOset

DPOJET:PLOT<x>:HISTOgram:AUTOset

This command runs a histogram autoset for the specified slot.

Syntax

DPOJET:PLOT<x>:HISTOgram:AUTOset {EXECute}

Inputs

{EXECute}

NOTE. Undefined for nonhistogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale

This command sets or queries the horizontal auto scale settings.

Syntax

DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale {1 | 0}

DPOJET:PLOT<x>:HISTOgram:HORizontal:AUTOscale?

Inputs

{1 | 0}

Outputs

{1 | 0}

NOTE. Undefined for nonhistogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter

DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter

This command sets or queries the histogram center.

Syntax

DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter <NR3>

DPOJET:PLOT<x>:HISTOgram:HORizontal:CENter?

Inputs

<NR3>

Outputs

<NR3>

NOTE. Undefined for nonhistogram plots.

DPOJET:PLOT<x>:HISTOgram:HORizontal:RESolution

This command sets or queries the horizontal resolution used in Eye Diagram plots.

Syntax

DPOJET:PLOT<x>:HISTOgram:HORizontal:RESolution <NR3>

DPOJET:PLOT<x>:HISTOgram:HORizontal:RESolution?

Inputs

<NR3>

Outputs

<NR3>

NOTE. Undefined for nonhistogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN

DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN

This command sets or queries the histogram span.

Syntax

DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN <NR3>

DPOJET:PLOT<x>:HISTOgram:HORizontal:SPAN?

Inputs

<NR3>

Outputs

<NR3>

NOTE. Undefined for nonhistogram plots.

DPOJET:PLOT<x>:HISTOgram:NUMBins

This command sets or queries the current histogram resolution.

Syntax

DPOJET:PLOT<x>:HISTOgram:NUMBins {TWENtyfive | FIFTY | HUNdred | TWOFifty |

FIVEHundred}

DPOJET:PLOT<x>:HISTOgram:NUMBins?

Inputs

{TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred}

Outputs

{TWENtyfive | FIFTY | HUNdred | TWOFifty | FIVEHundred}

NOTE. Undefined for nonhistogram plots.
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GPIB Commands DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE

DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE

This command sets or queries the vertical scale setting for applicable plots, either Linear or Log.

Syntax

DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE {LINEAR | LOG}

DPOJET:PLOT<x>:HISTOgram:VERTical:SCALE?

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}

NOTE. Undefined for nonhistogram plots.

DPOJET:PLOT<x>:PHASEnoise:BASEline

This command sets or queries the phase noise baseline.

Syntax

DPOJET:PLOT<x>:PHASEnoise:BASEline <NR3>

DPOJET:PLOT<x>:PHASEnoise:BASEline?

Inputs

<NR3>

Outputs

<NR1>

NOTE. Undefined for nonphase-noise plots.
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GPIB Commands DPOJET:PLOT<x>:SPECtrum:BASE

DPOJET:PLOT<x>:SPECtrum:BASE

This command sets or queries the spectrum base. Undefined for non-spectrum plots.

Syntax

DPOJET:PLOT<x>:SPECtrum:BASE <NR3>

DPOJET:PLOT<x>:SPECtrum:BASE?

Inputs

<NR3>

Outputs

<NR1>

DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE

This command sets or queries the horizontal scale setting for applicable plots, either Linear or Log.

Syntax

DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE {LINEAR | LOG}

DPOJET:PLOT<x>:SPECtrum:HORizontal:SCALE?

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}

NOTE. Undefined for nonspectrum plots.
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GPIB Commands DPOJET:PLOT<x>:SPECtrum:MODE

DPOJET:PLOT<x>:SPECtrum:MODE

This command sets or queries the spectrum mode.

Syntax

DPOJET:PLOT<x>:SPECtrum:MODE {NORMal | AVErage | PEAKhold}

DPOJET:PLOT<x>:SPECtrum:MODE?

Inputs

{NORMal | AVErage | PEAKhold}

Outputs

{NORMal | AVErage | PEAKhold}

DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE

This command sets or queries the vertical scale setting for applicable plots, either Linear or Log.

Syntax

DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE {LINEAR | LOG}

DPOJET:PLOT<x>:SPECtrum:VERTical:SCALE?

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}

NOTE. Undefined for nonspectrum plots.
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GPIB Commands DPOJET:PLOT<x>:TRANSfer:DENominator

DPOJET:PLOT<x>:TRANSfer:DENominator

This command sets or queries the transfer plot denominator.

Syntax

DPOJET:PLOT<x>:TRANSfer:DENominator {MEAS1 - MEAS99}

DPOJET:PLOT<x>:TRANSfer:DENominator?

Inputs

{MEAS1 - MEAS99}

Outputs

{MEAS1 - MEAS99}

NOTE. Undefined for non-transfer plots.

DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE

This command sets or queries the horizontal scale setting for applicable plots, either Linear or Log.
Undefined for nontransfer plots.

Syntax

DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE {LINEAR | LOG}

DPOJET:PLOT<x>:TRANSfer:HORizontal:SCALE?

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}
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GPIB Commands DPOJET:PLOT<x>:TRANSfer:MODE

DPOJET:PLOT<x>:TRANSfer:MODE

This command sets or queries the transfer plot mode.

Syntax

DPOJET:PLOT<x>:TRANSfer:MODE {NORMal | AVErage}

DPOJET:PLOT<x>:TRANSfer:MODE?

Inputs

{NORMal | AVErage}

Outputs

{NORMal | AVErage}

DPOJET:PLOT<x>:TRANSfer:NUMerator

This command sets or queries the transfer plot numerator.

Syntax

DPOJET:PLOT<x>:TRANSfer:NUMerator {MEAS1 - MEAS99}

DPOJET:PLOT<x>:TRANSfer:NUMerator?

Inputs

{MEAS1 - MEAS99}

Outputs

{MEAS1 - MEAS99}

NOTE. Undefined for nontransfer plots.
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GPIB Commands DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE

DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE

This command sets or queries the vertical scale setting for applicable plots, either Linear or Log.
Undefined for non-transfer plots.

Syntax

DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE {LINEAR | LOG}

DPOJET:PLOT<x>:TRANSfer:VERTical:SCALE?

Inputs

{LINEAR | LOG}

Outputs

{LINEAR | LOG}

DPOJET:POPULATION:CONDition

This command sets or queries the current population limit condition.

Syntax

DPOJET:POPULATION:CONDition {EACHmeas | LASTmeas}

DPOJET:POPULATION:CONDition?

Inputs

{EACHmeas | LASTmeas}

Outputs

{EACHmeas | LASTmeas}
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GPIB Commands DPOJET:POPULATION:LIMIT

DPOJET:POPULATION:LIMIT

This command sets or queries the current limit value.

Syntax

DPOJET:POPULATION:LIMIT <NR3>

DPOJET:POPULATION:LIMIT?

Inputs

<NR3>

Outputs

<NR1>

DPOJET:POPULATION:LIMITBY

This command sets or queries the mechanism by limits, either acquisition or population.

Syntax

DPOJET:POPULATION:LIMITBY {ACQuisitions | POPUlation}

DPOJET:POPULATION:LIMITBY?

Inputs

{ACQuisitions | POPUlation}

Outputs

{ACQuisitions | POPUlation}
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GPIB Commands DPOJET:POPULATION:STATE

DPOJET:POPULATION:STATE

This command turns on or off population limits.

Syntax

DPOJET:POPULATION:STATE {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}
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GPIB Commands DPOJET:QUALify:ACTIVE

DPOJET:QUALify:ACTIVE

This command sets the active state for the qualifier source, either HIGH or LOW.

Syntax

DPOJET:QUALify:ACTIVE {HIGH | LOW}

Inputs

{HIGH | LOW}

Outputs

{HIGH | LOW}

DPOJET:QUALify:SOUrce

This command sets the qualifier source.

Syntax

DPOJET:QUALify:SOUrce {CH1 – CH4 | MATH1 - MATH4 | REF1 - REF4 | SEARCH1 –

SEARCH8}

Inputs

{CH1 – CH4 | MATH1 - MATH4 | REF1 - REF4 | SEARCH1 – SEARCH8}

Outputs

{CH1 – CH4 | MATH1 - MATH4 | REF1 - REF4 | SEARCH1 – SEARCH8}
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GPIB Commands DPOJET:QUALify:STATE

DPOJET:QUALify:STATE

This command turns on or off measurement qualification.

Syntax

DPOJET:QUALify:STATE {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:REFLevel:CH<x>:MIDZero

This command turns on or off the mid reference level voltage setting.

Syntax

DPOJET:REFLevel:CH<x>:MIDZero {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}
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GPIB Commands DPOJET:REFLevels:AUTOSet

DPOJET:REFLevels:AUTOSet

This command performs a DPOJET ref level autoset on any sources selected using
DPOJET:REFLevels:CH<x>:AUTOSet.

Syntax

DPOJET:REFLevels:AUTOSet {EXECute}

Inputs

{EXECute}

NOTE. All pieces of the reflevel branch have the ability to set ref levels for CH1-CH4, MATH1-MATH4,
and REF1-Ref4. Only the CH<x> portion is shown in this OLH, but it exists and matches exactly for
MATH (DPOJET:REFLevels:MATH<x> and REF (DPOJET:REFLevels:REF<x>).

DPOJET:REFLevels:CH<x>:AUTOSet

This command sets or clears the reflevel autoset state of the given source. When set to 1, the given source
will have a ref level autoset acted on it during the next acquisition.

Syntax

DPOJET:REFLevels:CH<x>:AUTOSet {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

NOTE. The Ref Level Autoset state is shown only for Ch1-Ch4 sources. It is the same for MATH and Ref
waveforms. For example: DPOJET:REFLevels: MATH<x>, DPOJET:REFLevels:REF<x>.
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GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute

DPOJET:REFLevels:CH<x>:ABsolute

The ABSolute branch specifies the ref levels in cases where a user chooses not to run a ref level autoset on
a given source. If a user does run a ref level autoset, the percentage values of Rise, Fall and Hysteresis are
used.

DPOJET:REFLevels:CH<x>:ABsolute:RISEHigh

This command sets the ref level voltage relative to base top for autoset. The default is 1.0.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:RISEHigh <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:RISELow

This command sets the ref level voltage relative to base top for autoset. The default is -1.0.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:RISELow <NR3>

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute:RISEMid

DPOJET:REFLevels:CH<x>:ABsolute:RISEMid

This command sets the ref level voltage relative to base top for autoset. The default is 0.0.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:RISEMid <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:FALLHigh

This command sets the ref level voltage relative to base top for autoset. The default is 1.0.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:FALLHigh <NR3>

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute:FALLLow

DPOJET:REFLevels:CH<x>:ABsolute:FALLLow

This command sets the ref level voltage relative to base top for autoset. The default is -1.1.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:FALLLow <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:ABsolute:FALLMid

This command sets the ref level voltage relative to base top for autoset. The default is 0.0.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:FALLMid <NR3>

Inputs

<NR3>

Outputs

<NR3>

430 DPOJET Jitter and Eye Diagram Analysis Tools



GPIB Commands DPOJET:REFLevels:CH<x>:ABsolute:HYSTeresis

DPOJET:REFLevels:CH<x>:ABsolute:HYSTeresis

This command sets the hysteresis value used for autoset. The default is 0.03.

Syntax

DPOJET:REFLevels:CH<x>:ABsolute:HYSTeresis <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:BASETop

This command sets the base-top method for autoset.

Syntax

DPOJET:REFLevels:CH<x>:BASETop {MINMax | FULLhistogram | EYEhistogram | AUTO}

Inputs

{MINMax | FULLhistogram | EYEhistogram | AUTO}

Outputs

{MINMax | FULLhistogram | EYEhistogram | AUTO}
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GPIB Commands DPOJET:REFLevels:CH<x>:PERcent

DPOJET:REFLevels:CH<x>:PERcent

The ref level commands that follow set percent ref level parameters in the same way that the absolute
parameters do, except that these commands set the various percentage levels used by the autoset.

DPOJET:REFLevels:CH<x>:PERcent:FALLHigh

This command sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:FALLHigh <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:PERcent:FALLLow

This command sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:FALLLow <NR3>

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLevels:CH<x>:PERcent:FALLMid

DPOJET:REFLevels:CH<x>:PERcent:FALLMid

This command sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:FALLMid <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis

This command sets the hysteresis value used for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:HYSTeresis <NR3>

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLevels:CH<x>:PERcent:RISEHigh

DPOJET:REFLevels:CH<x>:PERcent:RISEHigh

This command sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:RISEHigh <NR3>

Inputs

<NR3>

Outputs

<NR3>

DPOJET:REFLevels:CH<x>:PERcent:RISELow

This command sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:RISELow <NR3>

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REFLevels:CH<x>:PERcent:RISEMid

DPOJET:REFLevels:CH<x>:PERcent:RISEMid

This command sets the ref level voltage relative to base top for autoset.

Syntax

DPOJET:REFLevels:CH<x>:PERcent:RISEMid <NR3>

Inputs

<NR3>

Outputs

<NR3>
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GPIB Commands DPOJET:REPORT

DPOJET:REPORT

These are set-only commands. EXECute executes a DPOJET report save operation for the currently
defined report configuration. APPEnd appends new data to the selected report.

Syntax

DPOJET:REPORT {EXECute | APPEnd}

Inputs

{EXECute | APPEnd}

DPOJET:REPORT:APPlicationconfig

This command turns on or off including complete application configuration in reports.

Syntax

DPOJET:REPORT:APPlicationconfig {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}
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GPIB Commands DPOJET:REPORT:AUTOincrement

DPOJET:REPORT:AUTOincrement

This command turns on or off auto increment of report file names.

Syntax

DPOJET:REPORT:AUTOincrement {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:REPORT:COMments

This command sets or queries the comments.

Syntax

DPOJET:REPORT:COMments <string>

DPOJET:REPORT:COMments?

Inputs

<string>

Outputs

<string>
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GPIB Commands DPOJET:REPORT:DETailedresults

DPOJET:REPORT:DETailedresults

This command turns on or off including detailed results in reports.

Syntax

DPOJET:REPORT:DETailedresults {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:REPORT:ENABlecomments

This command sets or queries the comments enable or disable settings.

Syntax

DPOJET:REPORT:ENABlecomments {1 | 0}

DPOJET:REPORT:ENABlecomments?

Inputs

{1 | 0}

Outputs

{1 | 0}
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DPOJET:REPORT:PASSFailresults

This command turns on or off including pass/fail results in reports.

Syntax

DPOJET:REPORT:PASSFailresults {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:REPORT:PLOTimages

This command turns on or off including detailed plot images in reports.

Syntax

DPOJET:REPORT:PLOTimages {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}
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DPOJET:REPORT:REPORTName

This command sets the current report file name.

Syntax

DPOJET:REPORT:REPORTName <string>

Inputs

<string>

Outputs

<string>

DPOJET:REPORT:SETupconfig

This command turns on or off including setup configuration in reports.

Syntax

DPOJET:REPORT:SETupconfig {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}
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DPOJET:REPORT:SAVEWaveforms

This command turns on or off saving waveforms when a report save/append is invoked.

Syntax

DPOJET:REPORT:SAVEWaveforms {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:REPORT:STATE?

This query-only command provides the report status.

Syntax

DPOJET:REPORT:STATE?

Outputs

INPROGRESS | DONE
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DPOJET:REPORT:VIEWreport

This command turns on or off viewing report after generation.

Syntax

DPOJET:REPORT:VIEWreport {1 | 0}

Inputs

{1 | 0}

Outputs

{1 | 0}

DPOJET:RESULts:STATus?

This query-only command returns the overall pass/fail status.

Syntax

DPOJET:RESULts:STATus?

Outputs

{PASS | FAIL}
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DPOJET:RESULts:VIew

This command sets or queries the results view type.

Syntax

DPOJET:RESULts:VIew {SUMmary | DETails}

DPOJET:RESULts:VIew?

Inputs

{SUMmary | DETails}

Outputs

{SUMmary | DETails}

DPOJET:SAVE

This set-only command saves the specified DPOJET measurement result to the specified ref. For Example:
DPOJET:SAVE MEAS4, REF2.

Syntax

DPOJET:SAVE {MEAS1-MEAS99 | REF1-REF4}

Inputs

{MEAS1-MEAS99 | REF1-REF4}
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DPOJET:SOURCEAutoset

This command performs a DPOJET horizontal, vertical, or autoset on both horizontal and vertical for any
sources used in current measurements.

Syntax

DPOJET:SOURCEAutoset {HORIzontal | VERTical | BOTH}

Inputs

{HORIzontal | VERTical | BOTH}

DPOJET:SOURCEAutoset:HORizontal:UICount

This command sets or queries the UICount for horizontal autoset.

Syntax

DPOJET:SOURCEAutoset:HORizontal:UICount <NR3>

DPOJET:SOURCEAutoset:HORizontal:UICount?

Inputs

<NR3>. Default is 10000.

Outputs

<NR3>
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DPOJET:SOURCEAutoset:HORizontal:UIValue

This command sets or queries the UI value for horizontal autoset.

Syntax

DPOJET:SOURCEAutoset:HORizontal:UIValue <NR3>

DPOJET:SOURCEAutoset:HORizontal:UIValue?

Inputs

<NR3>

Outputs

<NR3>

DPOJET:STATE

This command returns the current measurement state of DPOJET.

Syntax

DPOJET:STATE {RUN | SINGLE | RECALC | CLEAR | STOP}

Inputs

{RUN | SINGLE | RECALC | CLEAR | STOP}

Outputs

The current state of the DPOJET measurement sequencer, including any of the possible inputs.
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DPOJET:UNITType

This command sets or queries the current unit-type setting for DPOJET, either Unit Interval, or seconds.

Syntax

DPOJET:UNITType {UNITinterval | SEConds}

DPOJET:UNITType?

Inputs

{UNITinterval | SEConds}

Outputs

{UNITinterval | SEConds}

DPOJET:VERsion?

This query-only command returns the current DPOJET version string.

Syntax

DPOJET:VERsion?

Outputs

<string>
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